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Welcome to Sprint

print built the largest all-PCS nationwide network with advanced 
multimedia services and clear calls, reaching more than 230 million 

people for clarity you can see and hear. We built our network to give you 
what we believe you really want from a wireless phone: clear sound, private 
conversations and time-saving features.

But with Sprint, you can do something even more far-reaching – simplify 
your life. Our advanced technology is designed to grow with your 
communications needs so that one day you’ll be able to rely entirely on 
your PCS Phone to stay connected.

This guide will familiarize you with our technology and with your new 
PCS Phone through simple, easy-to-follow instructions. If you have already 
reviewed the Start Here Guide, which was packaged with your new device, 
then you’re ready to explore the advanced features outlined in this guide. 

If you have not read your Start Here Guide, go to Section One – Getting 
Started. This section provides all the information you need to quickly 
activate your phone, set up your voicemail, and much more. It also 
contains information on how to contact Sprint should you have questions 
about service, want to purchase additional products or services, or just to 
check your account balance.

Thank you for choosing Sprint.

S
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Introduction to This 
Online User’s Guide

his online User’s Guide introduces you to PCS Service and all the 
features of your new device. It’s divided into four sections:

� Section 1: Getting Started

� Section 2: Understanding Your Device

� Section 3: Using PCS Service Features

� Section 4: Safety Guidelines and Warranty Information

Throughout the guide, you’ll find tips that highlight special shortcuts and 
timely reminders to help you make the most of your new device and service. 
The Table of Contents and Index will help you locate specific information 
quickly.

You’ll get the most out of your device if you read each section. However, if 
you’d like to get right to a specific feature, simply turn to that page. Follow 
the instructions in that section and you’ll be ready to use your device in 
no time.

Tip: You can print out this guide to keep on hand or view it online.

T
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Getting Started
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Section 1A

Setting Up Service

In This Section

� Getting Started With PCS Service

� Setting Up Your Voicemail

� Getting Help

his section walks you through the basics of setting up service for the 
phone on your device, including unlocking and activating your phone, 

setting up your voicemail, and how to contact Sprint for assistance with 
your PCS Service.

T

Section 1: Getting Started
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Getting Started With PCS Service

Determine if Your Phone is Already Activated

If you received your device in the mail or purchased it at a Sprint Store, 
the phone probably has been activated. If your phone is not activated, 
please refer to the Start Here Guide included with your device.

Activating Your Phone

To activate your phone, follow the directions in the Start Here Guide that 
was included with your device. Or visit http://activate.sprintpcs.com and 
activate your phone online.

Setting Up Your Voicemail

All unanswered calls to your PCS Phone are automatically transferred to 
voicemail, even if your phone is in use or turned off. Therefore, you will 
want to set up your voicemail and personal greeting as soon as your 
PCS Phone is activated.

To set up voicemail:

1. Make sure the phone is on. See “Turning the Phone ON and OFF” on 
page 72 for details.

2. If the dialer screen is not displayed, activate the dialer screen by 
pressing T on the device.

3. From the dialer screen, tap and hold 1 for two seconds.

4. Follow the system prompts to create your pass code, record your 
greeting, record your name announcement, and choose whether to 
activate One-Touch Message Access (a feature that lets you press one key to 
access messages and bypasses the need for you to enter your pass code).

Note: The voicemail setup process may vary in certain Affiliate areas.
Section 1: Getting Started
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Getting Help

Visit Our Website

Stop by www.sprintpcs.com and log on to get up-to-date information on 
PCS Service, options, and more. 

You can also:
� Review coverage maps

� Learn how to use voicemail

� Access your account information

� Purchase accessories

� Add additional options to your service plan

� Check out frequently asked questions

� And more
Section 1: Getting Started
91A: Setting Up Service
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PCS Customer Solutions

PCS Customer Solutions is available to assist you 24 hours a day, seven 
days a week. Visit us at www.sprintpcs.com by signing on and clicking 
on Help Center.

Receiving Automated Invoicing Information

For your convenience, your phone gives you access to invoicing 
information on your PCS Account. This information includes balance 
due, payment received, invoicing cycle, and the amount of minutes and/
or data used since your last invoicing cycle. (A nominal fee and/or 
airtime charges may apply.)

To access this information:

� Tap S 4 T.

Note: This service may not be available in all Affiliate markets.

PCS Directory Assistance

PCS Directory Assistance provides a variety of services, including 
residential, business and government listings; assistance with local or 
long-distance calls; movie listings; and hotel, restaurant, shopping, and 
major local event information. There is a per-call charge and you will be 
billed for airtime.

� Tap 4 1 1 T.

PCS Operator Services

PCS Operator Services can provide assistance in placing collect calls or 
calls billed to a local telephone calling card or a third party.

� Tap 0 T.

For more information or to see the latest in products and services, visit us 
online at www.sprintpcs.com.

Note: PCS Operator Services may not be available in all Affiliate 
Section 1: Getting Started
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Section 2A

Your PCS Phone – The Basics

In This Section
� Your PCS Phone’s Features
� Using the Batteries
� Resetting
� Initialization
� Turning Your Device ON and 

OFF
� LEDs
� USB Cradle
� Using the USB Port
� Using the Infrared 

Communications Port
� Using SD Card / 

MultiMediaCard
� Using the Optional Headset
� Camera
� Jog Wheel
� Talk Button
� End Button
� Speaker Phone Button
� Voice Button

� Volume Button
� Key Guard Switch
� Environment Switch
� Using the Keyboard
� Adjusting the Screen 

Brightness
� Using the Stylus
� Initial Setup
� Provisioning
� Today Screen
� Navigation Bar and Command 

Bar
� Programs
� Pop-up Menus
� Notifications
� Entering Information on Your 

Device
� Entering Text Using the Input 

Panel
� Finding and Organizing 

Information
Section 2: Understanding Your Device
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his section will guide you through the basics of your device, and you’ll 
be on your way to using it in no time.T
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Your PCS Phone’s Features

Antenna

Cradle Connector

LED for Reminder

LED for Phone
Power

Camera

Touch Screen

Keyboard

Microphone

Speaker Phone
Button

Headset
Jack

SD Card Slot

Jog Wheel

Voice Button

Environment Switch

Key Guard Switch

AC Adapter Jack

Receiver

Stylus Pen

USB
Function Port

LED for Charging

Talk Button

Volume Button

Battery Cover

Battery Cover Knob

IrDA Port

Power Button

Speaker

Reset Button

Full Reset
Switch

End Button
Section 2: Understanding Your Device
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Connector

USB Cable

AC Adapter Jack

USB Cradle
Section 2: Understanding Your Device
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Using the Batteries

This device uses two types of batteries; one is the main Lithium Ion 
(LiIon) battery and the other is the backup battery that holds data when 
the main battery is replaced. Because the device is shipped with neither of 
the batteries charged, make sure to charge the batteries before starting to 
use the device. The backup battery, which has been built into the device, 
is automatically charged through the main battery or the AC adapter.

The main battery will be referred to in this guide as just the battery.

Installing the Main Battery

Use the following procedure to install the supplied main battery:

1. While holding down the battery cover (A), slide it forward while 
pressing the release button (B).

2. Slide the battery cover until the cover comes out of the guides, and 
then lift and remove the cover.

AA

B

Section 2: Understanding Your Device
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3. Hold the main battery with the label surface facing upward, and then 
install the battery so that the grooves at both sides mate.

4. Using the stylus, shift the Full Reset switch upward to unlock it. (The 
switch is locked before the device is shipped.)

5. Replace the battery cover on the device.

Release

Full Reset switchFull Reset switchFull Reset Switch
Section 2: Understanding Your Device
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Removing the Main Battery

Use the following procedure to remove the main battery:

1. Confirm that the following backup battery power warning has not 
been displayed on the Power screen under Settings. If the warning has 
been displayed, charge the backup battery until the warning 
disappears.

2. Press the Power button to turn the device off.

3. While holding down the battery cover (A), slide it forward while 
pressing the release button (B).

4. Slide the battery cover until the cover comes out of the guides, and 
then lift and remove the cover.

B

AA
Section 2: Understanding Your Device
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5. Hold both sides of the battery, and then lift and remove the battery. 

Note: If the battery is removed with the device on, data will be lost.

Note: If the main battery is removed when the backup battery is empty, 
data on the device will be lost.

Note: If the device is left with the main battery removed for more than 
five minutes, data on the device can be lost.

Tip: When the battery cover is removed from the device, the phone 
function is turned off.
To turn the phone function back on, ensure the battery cover is firmly slid 
into place and please do the following: 

1. Press and hold the Power button for at least 2 seconds.
2. Tap phone antenna icon located at the top of the screen. A window 

will popup.
3. Tap Turn phone on.

Phone function is now turned on.
Section 2: Understanding Your Device
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Charging the Battery

Use one of the following two methods for charging the battery:

� Connect the supplied AC adapter and cradle as shown below, and then 
attach the device onto the cradle. For information on using the cradle, 
see “USB Cradle” on page 30.

- or -

� Connect the supplied AC adapter to the device as shown below.

The LED for Charging lights amber while charging is being performed. 
The LED turns green when charging is completed. For more information 
about the LED for Charging, see “LEDs” on page 29.

LED for charging
Section 2: Understanding Your Device
2A: Your PCS Phone – The Basics

It takes approximately three hours to finish charging a battery that has 
only enough power for data backup, but not enough for operation.



Note: Charge the battery at an ambient temperature in the range from 
0°C to 35°C (32°F to 95°F). Depending on the operating conditions of the 
device, charging may be interrupted even when the ambient temperature 
is lower than 35°C (95°F).

Note: If the ambient temperature becomes too high during charging, the 
Charging LED lights red and charging is interrupted. Charging is 
automatically restarted when the ambient temperature becomes 
appropriate. 

Note: The battery may not be properly charged at low temperatures 
(less than 0°C/32°F) in winter. If this is the case, charge the battery in a 
warm room. 

Note: If the device is used as it is just after purchase or after the device 
is left without being charged for an extended period of time, the 
remaining battery power may not be correctly indicated. Before using 
the device, be sure to charge the battery until the LED for Charging turns 
green. 

Note: When the device has been connected with the AC adapter or 
placed on the cradle, incoming calls do not cause vibration, even with 
vibration on.

Note: As the battery nears a full charge, the LED for charging may turn 
green and orange alternately.
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Battery Life

The main battery has a limited service life. Repeated charging and 
discharging of the battery will result in a gradual decrease in the 
charging capacity of the battery. If a fully recharged battery operates the 
device for a much shorter period than before, this indicates the end of 
battery life. When battery life is over, replace the battery with a new one.

The life of the main battery can vary, depending on how the device is used 
and ambient temperatures.

Tip: Unlike NiCad and Nickel Metal Hydride batteries, charging the main 
LiIon battery with some amount of power remaining hardly reduces the 
maximum allowable operating time.

Note: Do not use the device at too high a temperature. The battery life 
will become shorter than when used at normal temperatures.

Note: For safe disposal options of your Lithium Ion batteries, contact 
your nearest Sprint-authorized service center.

Note: Be sure to dispose of your battery properly. In some areas, the 
disposal of batteries in household or business trash may be prohibited.

Battery Operating Time

The main battery allows approximately 2.5 hours of continuous talk 
time, approximately seven days of continuous standby time, or 
approximately 12 hours of continuous PDA operation time.

Note: The maximum continuous talk time, standby time, and PDA 
operation time are affected by backlight settings, service searching, 
vibrate mode, game use, and browser use.

Note: The maximum battery operating time varies, depending on how the 
device is stored and on ambient temperatures. Charging or using the 
battery at low temperatures (less than 0°C/32°F) can cause a significant 
reduction in the maximum operating time because of the characteristics 
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Extending the Maximum Battery Operating Time

You can use the following methods to extend the maximum operating 
time of the main battery:
� Decrease the screen brightness. For the setting method, see “Adjusting 

the Screen Brightness” on page 44.

� Set the device so that screen brightness is automatically lowered when 
the main battery is consumed. For the setting method, see “Selecting 
Backlight Settings” on page 97.

� Place the device into the power saving (low speed) mode. For the 
setting method, see “Adjusting Power Settings” on page 100.

� Set the device so that the LED does not blink when the alarm is set. For 
the setting method, see “Selecting Sounds & Notifications Settings” on 
page 96.

� Switch off the sound function that produces various sounds, including 
beeps generated at the time of key entry and tapping. For the setting 
method, see “Selecting Sounds & Notifications Settings” on page 96.

Tip: When connecting to a personal computer, use the AC adapter to 
conserve LiIon battery strength.
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Data Backup Time

When both the main battery and the backup battery are completely 
discharged, data stored in the device will be lost. Immediately after the 
battery icon indicates the low level or a warning message appears, 
connect the AC adapter to charge the battery.
� Data will be kept for approximately five days after the main battery is 

discharged to such an extent that the device cannot be switched on.

� The main battery and the backup battery discharge slowly even when 
they are not used. The batteries will be completely discharged when 
they are not used for an extended period of time.

� It is strongly recommended that you save the device’s data on a 
personal computer or a memory card. For the method of backing up 
data, see “Backing Up Data” on page 179.

Note: When the device is left with a USB cable or a card connected, the 
backup time may be reduced. When not using the device, remove 
peripheral equipment from the device.

Note: If the device is left with the battery discharged for an extended 
period of time, the battery life may be shortened. Recharge the battery 
every three months, even not when using the device for a long period 
of time.
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Resetting

Use the stylus to push the Reset button when the device freezes during 
operations or when the device prompts you to do so at the time of 
software installation.

Note: Resetting the device causes data not yet saved to be lost. Data 
that has been saved will not be lost through this operation.

Tip: If resetting the device does not allow it to restore the normal status, 
perform initialization. Note, however, that initialization will cause all data 
saved in the device’s memory to be erased. For details, see 
“Initialization” on page 26.

Note: When the screen freezes do not remove the battery. Press the 
Reset button. Removing the battery may cause data to be lost.

Reset Button
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Initialization

Perform initialization only when pushing the Reset button does not allow 
the device to be restarted.

Note: Initialization will cause all data saved in the device’s memory to be 
erased. The programs preinstalled before shipment will not be erased.

Before performing initialization, back up important data using a 
personal computer or a memory card. For details about data backup, see 
“Backing Up Data” on page 179.

Note: Remove a memory card before starting initialization.

1. Remove the AC adapter and peripheral equipment from the device. 
Executing initialization with equipment connected may result in 
initialization failure.

2. Remove the main battery. To remove, see “Removing the Main 
Battery” on page 18.

3. Using a non-conductive fine tool, shift the Full Reset switch downward 
(lock position). The power is switched off.

4. Wait for approximately two minutes.

5. Install the main battery. To install, see “Installing the Main Battery” 
on page 16.

LockLockLock

Full Reset switchFull Reset switch

Full Reset
Switch
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6. Using the stylus, shift the Full Reset switch upward (unlock position). 
The memory will be initialized, and the device is restarted.

7. Replace the battery cover on the device.

8. Connect the AC adapter to the device.

9. Set up the device. See “Initial Setup” on page 45.

Release

Full Reset switchFull Reset switchFull Reset Switch
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Turning Your Device ON and OFF

Turning the Device On and Off

Each time you press the Power button, the device is switched on and off.

Tip: You cannot operate the Power button when:
� The main battery has no power left.
� The Key Guard switch is on.
� The Full Reset switch has been locked.

Turning the Phone On and Off

Each time you press and hold the Power button or the End button for 
two seconds, the phone is switched on and off.

When the phone is on, the LED for Phone Power blinks. For more 
information about LED for Phone Power, see“LEDs” on page 29.

Power Button

End Button
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LEDs

This device is equipped with three status LEDs.

1. LED For Charging

� Steady amber: Charging in progress

� Steady green: Charging completed

� Steady red: Charging stopped (because of high ambient temperature)

2. LED For Reminder

� Flashes orange: Alarm for the programmed plan and job

3. LED For Phone power

Flashes green at various intervals as below when the phone is on.
� In Service: Blinks at intervals of five seconds (with a shorter On time 

period)

Flashes at this interval when service is available; this is not true of 
active MIP data connections mentioned below. The statuses where this 
happens include idle, voice call, and inactive data connections.

� Active Data Service: Blinks at intervals of 0.5 second

Flashes at this interval when an active MIP data connection is 
established. The flashing status for in-service is restored when data 

1. For Charging

3. For Phone Power

2. For Reminder
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� No Service: Blinks at intervals of five seconds (with a longer On time 
period).

Flashes at this interval when the phone is out of any service range.

� Deep Sleep: Blinks at intervals of three minutes.

Flashes at this interval when the phone is out of any service range for 
15 minutes.

USB Cradle

Your PCS Phone comes with a USB cradle.

Use the supplied USB cradle to charge the battery or to exchange data 
with a connected personal computer.

Mounting the Device onto the USB Cradle

1. Insert the bottom of the device onto the mating connector and pin on 
the USB cradle.

Knob

Connector AC Adapter Jack USB CablePin
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2. Tilt the device in the direction of the arrow so that its tab hole is 
aligned with the tab on the cradle.

Removing the Device from the USB Cradle

� Pull the device forward, and then remove it from the USB cradle.

Note: After the device has been mounted onto the USB cradle, the 
vibrating device (if switched on) does not function when a call is 
received.
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Using the USB Port

Using the USB allows you to easily connect the device to a personal 
computer in order to exchange data. Use one of the following two 
connecting methods:

� Connect one appropriate end of a USB cable to the device, and the 
other appropriate end to the USB port on the personal computer.

- or -

� Connect the cable of the supplied USB cradle to the USB port on the 
personal computer, and then mount the device onto the USB cradle. To 
use the USB cradle, see “USB Cradle” on page 30.

USB Function Port

USB (A)

Personal Computer

USB (Mini-B) To the USB Connector

Personal Computer

To the USB Connector
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Using the Infrared Communications Port 

This device also has an IrDA port for communicating with another 
compatible device. When using the IrDA port, position the two devices so 
that the respective IrDA ports face each other. In addition, there should be 
no obstacles between the two devices. 

Be careful that the IrDA ports line up within 15 degrees in the horizontal 
and vertical directions and that the distance between the two devices is 
less than 70 cm (27.5 inches).

IrDA Port

15 degrees left

15 degrees up

15 degrees down
15 degrees right
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Using SD Card / MultiMediaCard

This device can be used with a commercially available SD card or 
MultiMediaCard.

1. Remove the card slot protector from the SD card slot.

� Push the card slot protector until it clicks, and then release your finger 
to cause the protector to be ejected. Slowly pull the ejected protector 
out of the slot.

SD Card Slot
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2. Hold the card so that its top surface and the touch screen face the same 
direction, and then insert the card into the SD card slot. Push the card 
until it clicks.

To remove the card, follow the instructions in step 1.

Note: This device does not support the SD card security function.

Note: If you insert a card incorrectly and push it with a strong force, both 
the card and the card slot can be damaged.

Note: When releasing your finger after pushing the card, the card may 
jump out of the slot. Do not place your face close to the slot. 

Note: Do not try to force the card out of the card slot with your fingernails.

Note: When not using a card, make sure to replace the card slot protector.

Tip: This device supports a Secure MultiMediaCard.

Top Surface
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Using the Optional Headset
� To connect an optional headset to this device, insert the plug on the 

headset into the headset jack on the device.

Note: Insert the headset plug into the jack as far as it goes. Incomplete 
connection of the headset plug can result in abnormal sounds.

Note: When using headphones with a 3.5 mm (1/8 inches) stereo phone 
plug, use the supplied stereo mini plug adapter. You must not use an 
adapter other than the supplied one. 

Note: When using the headset or headphones, be careful not to increase 
the volume too much.

Note: Audio volume differs depending on data to be played back. If the 
volume control has been set to the maximum level, unexpected 
excessive volume may damage your ears. Before playing back data, set 
the volume control to the minimum level, and then gradually increase the 
volume to the appropriate level.

Headset Jack
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Camera

This device incorporates a VGA camera to capture still images.

You can rotate the camera forward and backward 180 degrees. When the 
camera is fully rotated forward, captured images are displayed upside 
down. For details about operations, see “Camera” on page 153.

Note: If the lens is dirtied with fingerprints, oil, or grease, clean it with a 
soft cloth before taking pictures. 

Note: Even though the camera is produced with very high precision 
technologies, some pixels may always appear bright and some pixels 
may always appear dark. This is not a malfunction.

Note: If pictures are taken after the device has been in a warm location 
for an extended period of time, image quality may be lowered.

Note: Do not expose the lens to direct sunlight for a long period of time. 
This may cause the internal color filter to be discolored.

180 degrees rotation

Camera
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Note: Make sure to hold the device firmly so that captured images will 
not be blurred. 

Jog Wheel

Use the jog wheel to select and execute an application or a pull-down 
menu item.

� Upward turn: Moves the cursor upward

� Downward turn: Moves the cursor downward

� Push: Executes the item selected using the cursor

Talk Button

Use the Talk button to make a phone call or answer an incoming call. 
You can also use it to activate the phone application.

For details about operations, see “Keypad Operation List” on page 68.

Jog Wheel

Turn downward

Turn upward

Push

End Button

Speaker Phone Button

Talk Button
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End Button

Use the End button to switch off the ringer volume or to finish a 
conversation.

For details about operations, see “Keypad Operation List” on page 68.

Speaker Phone Button

Use the Speaker Phone button to enable the speaker phone or to activate 
the voice dial function (for details, see “Using Voice-Activated Dialing” 
on page 126). 

The Speaker Phone button provides different functions, depending on the 
current status. 

The following functions are available when the phone function is on:

Note: When the conversation is ended, the speaker phone will 
automatically be switched off.

Status Press to

The dialer is being executed 
without a phone number entered

Activate the voice dial function and 
switch the speaker phone on

The dialer is being executed with 
a phone number entered

Call the entered telephone number 
and switch the speaker phone on

A function other than the dialer 
is being executed

Activate the voice dial function and 
switch the speaker phone on

A call is being received Answer the incoming call and switch 
the speaker phone on

During conversation Switch to speaker phone
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Voice Button

Use the Voice button to activate the voice dial and voice memo functions. 
For details about the voice dial function, see “Making a Call From Voice 
Dial” on page 76. For details about the voice memo function, see 
“Recording a Message” on page 62.

The Voice button provides the different functions, depending on the 
current status.

Volume Button

Use the Volume button to adjust the device’s sound volume.

� Upward press: Increases the volume

Status Press to Press and hold to

Waiting for a call 
(with the device 
switched on)

Activate Voice Dial Activate Voice Memo

During conversation – Activate Voice Memo

Voice Button

Press downward

Press upward

Volume Button
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� Downward press: Decreases the volume



Note: When the Environment switch is set for “Silent,” the volume will be 
switched off regardless of the operation of the Volume button. For details 
about the Environment switch, see “Environment Switch” on page 42.

Key Guard Switch

Use the Key Guard switch to prevent unintentional operations. This 
button is also convenient when using functions (such as music 
playback) that do not need the screen.

Turning on the Key Guard switch (up position) places the device into the 
following status:
� Screen: Off

� The Power button, touch panel, keyboard, jog wheel, and Voice button 
will be disabled.

Note: Even when the Key Guard switch is on, the LEDs, Talk button, End 
button, Speaker Phone button, Environment switch, Volume button, Reset 
button, and Full Reset switch are still available.

ON

OFF

Key Guard Switch
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Environment Switch

Use the Environment switch to change the volume and type of 
ringer tones.

You can set the mode simply by putting the switch in the top, middle, or 
bottom positions, providing a quick and easy way to select modes suited 
to various places and situations.

� The mode names for the three switch positions are Silent All (top), 
Environment (middle), and Normal (bottom).

� Slide the switch up or down to switch modes. Silent All or names of the 
Environment modes appear on the Today Screen (See “Today Screen” 
on page 47).

� You can select Meeting, Outdoor, Office, and Private within the 
Environment mode. See “Changing the Environment Mode and 
Volume and Ring Type/Tone Settings for Individual Modes” on 
page 82.

� When in the Environment mode, the ringer tone volume and type 
selected under “Environment” (page 82) will be used.

� If the volume or ring type setting is changed when in the Environment 
mode, the new setting is valid until another mode is selected.

� When in the Silent All mode, “Off” is always selected for the volume. 
This is true no matter if the volume is changed through “Sound & 
Notification” under “Settings” (page 96), or if the ringer type/tone is 

Environment Switch

Silent All (top)

Environment (middle)

Normal (bottom)
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Using the Keyboard

The keyboard allows you to enter text. This section describes the basic 
operations for entering text using the keyboard.

� To enter characters (small letters) or codes printed on the keys in 
black, simply press the corresponding keys. 

� To enter characters (capital letters) or codes printed on the keys in 
black, press and hold the Shift key, and then press the corresponding 
keys.

� To switch Caps Lock on and off, press and hold the Shift key, and then 
press the Fn (Caps) key. 

� To switch Num Lock on and off, press and hold the Shift key, and then 
press the Num key.

Note: With Caps Lock on, pressing a key with an alphabetic character 
causes the corresponding capital letter to be entered. With Caps Lock 
on, pressing a key with an alphabetic character while pressing the Shift 
key causes the corresponding small letter to be entered.

� To enter numeric characters and codes printed on the keys in purple, 
press and hold the Num key, and then press the corresponding keys. 

� To enter A1 to A8 or   printed in bluish green, press and 
hold the Fn key, and then press the corresponding keys. When A1 to A8 
are entered, the applications registered under these keys are started. 
For the registration method, see “Setting Buttons” on page 94. For 

 , see “Adjusting the Screen Brightness” on page 44.

Keyboard
Section 2: Understanding Your Device
432A: Your PCS Phone – The Basics



44
� The Shift, Fn, and Num keys also function as sticky keys. When one of 
these keys is pressed, this function causes the key to remain active until 
another key is pressed. This function is useful when pressing two keys 
at the same time is difficult.

Note: You can also enter text using the Input panel. For the method of 
using the Input panel, see “Entering Text Using the Input Panel” on 
page 54.

Adjusting the Screen Brightness

You can adjust the screen brightness, depending on the ambient 
brightness and other ambient conditions.

� To adjust the screen brightness, press and hold the Fn key, and then 
press  (brighter) or  (dimmer).

Note: You can select the screen brightness from five levels. You can also 
set the screen brightness to automatically decrease when no entry is 
made through the screen or keyboard for a certain period of time. For 
more information, see “Selecting Backlight Settings” on page 97.

Using the Stylus

Use the stylus to select menu items or enter data on the touch screen.

The methods for using the stylus are as follows:
� Tap: Touch the screen once with the stylus to select items such as 

menus, icons, and buttons on the screen.

� Tap and hold: Keep touching the screen with the stylus. When an icon 
or item is tapped and held, a red circular mark appears, followed by a 
pop-up menu.

� Drag: Hold the stylus on the screen and move it to shift icons or other 
items on the screen, to enter text by handwriting, or to draw pictures. 

Note: Use only the supplied stylus to operate the touch screen. When 
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Initial Setup

When the device is switched on for the first time after purchase or after 
the device is initialized, the following screen appears. Perform initial 
setup procedures according to the on-screen instructions.

1. Tap anywhere on the screen.

2. The Align screen appears for touch screen alignment.
� Tap the center of the cross marker. Each time you tap the center of the 

marker, the marker moves. When the center of the marker is tapped 
five times, the alignment is completed and the Stylus screen appears. 

3. Read the descriptions of the methods for using the stylus, then tap 
Next. The screen for practicing pop-up menu operations appears.

4. Following the instructions, open a pop-up menu and perform 
cut-and-paste operations. After finishing the paste operation, tap Next. 
The Location screen appears.

5. Specify a location on the Location screen.
� Tapping  (shown to the right of the Time zone box) causes a list to be 

displayed. As necessary, change the time zone where the device is to be 
used and then tap Next. The Complete screen appears.

6. Tap the Complete screen. The Today screen appears and the device is 
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7. If the phone of the device has not been activated, switch the phone on 
to start the Activation Wizard.

8. Following the Activation Wizard, enter your activation code (also 
known as OTKSL), phone number (also known as MDN), and the 
MSID assigned to you by your PCS Customer Solutions Specialist.

Provisioning

In order to perform data communications, you need to perform the 
following operations first:

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Data tab on the bottom.

2. Tap Update Data Profile, then Yes.
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Today Screen

You can display the Today screen by tapping  and then Today. On the 
Today screen, you can see at a glance important information for the day.

� Environment switch status

The current Environment switch mode is indicated with text. Mode types: 
“Silent All,” “Meeting,” “Outdoor,” “Office,” “Private.”

Note: No Environment indication is given with Normal mode selected.

For the Environment switch, see page 42.
� Short-cut buttons

Call Log button: Launches the Dialer Log screen

Speed Dial button: Launches the Dialer Speed Dial screen

Voice Mail button: Launches Voice Mail

Pictures button: Launches the picture-related program start screen

Tools button: Launches the tool-related program start screen

Tap to select a program.

Tap to change date and time.

Your day at a glance

Tap to view connection status.Tap to create a new item.

Status icon: Battery, Location, Roaming
Tap to change volume or mute all sounds.

Environment switch status

Short-cut Buttons (Phone related).

Short-cut Buttons (Program related).
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Tip: To customize the programs registered on the tool-related program 
start screen, select the Items tab on Settings under Today, and then 
select Options under Prglaunch to start a screen for customization.

Running button: Launches the running program start screen
� Status icon

Following are some of the status icons you may see:

Status Icon Meaning

Main batteries are full

Main batteries are low (26–50%)

Main batteries are low

Main batteries are very low

Location ON

Location OFF

Roaming ON
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Navigation Bar and Command Bar

The navigation bar is located at the top of the screen. It displays the active 
program and current time, and allows you to switch to programs and 
close screens. 

Use the command bar at the bottom of the screen to perform tasks in 
programs. The command bar includes menu names, buttons, and the 
Input Panel button. To create a new item in the current program, tap 
New. To see the name of a button, tap and hold the stylus on the button. 
Drag the stylus off the button if you do not wish to carry out the 
command.

The following icons will appear on the navigation bar:

Phone is on, but is out of range of any signal.

Phone is on, and is receiving a signal.

Tap to change volume or mute the device.

Tap to quickly select a program
you have recently used.

Tap to select a program.

Tap to see additional programs.
Tap to customize the device.

Input Panel ButtonNew Button

Menu
Names

Buttons

Navigation Bar

Command Bar
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Phone call is in progress. To quickly switch back to 
Phone from any other program, tap this icon.
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Note: If more notification icons need to be displayed than there is room 
to display them, the Notification icon (  ) will display. Tap the icon to 
view all active notification icons.

Phone is off. (Airplane mode)

Sound ON

Sound OFF

Vibrate ON

Battery power remaining Low status

Battery power remaining Very Low status

More than one status icon is in display

Data connection is in progress

Signing in with MSN Messenger is being executed

Start and end processings of synchronization with a 
personal computer through ActiveSync

Voice Message

email/SMS

Speaker Phone ON

Emergency callback mode

Missed call
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Programs

You can switch from one program to another by selecting it from 
the  menu. You can customize which programs you see on this menu 
(see “To add a program to the Start menu:” on page 93). To access some 
programs, you’ll need to tap , Programs, and then the program 
name. 

You can also start programs using the launcher function on the Today 
screen. See “Today Screen” on page 47.

The following table contains a partial list of programs that are installed 
on your device:

Icon Program Description

ActiveSync Synchronize information between your 
device and computer

Calendar Keep track of your appointments and 
create meeting requests

Contacts Keep track of your friends and 
colleagues

Inbox Send and receive email/SMS messages

Pocket Internet 
Explorer

Browse Web and WAP sites and 
download new programs and files from 
the Internet

Notes Create handwritten or typed notes, 
drawings, and recordings

Tasks Keep track of your tasks

Pocket Excel Create new workbooks or view and edit 
Excel workbooks created on your 
computer

MSN Messenger Send and receive instant messages with 
your MSN Messenger contacts

Pocket Word Create new documents or view and edit 
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Phone Make and receive calls

Microsoft Reader Read e-books

Windows Media 
Player

Play back Windows Media Audio 
(.wma) files, MP3 (.mp3) files, and 
Windows Media Video (.wmv) files

Solitaire Play a card game

File Explorer Manage files

Camera Take pictures using the built-in camera

Review/Share Display and edit JPEG images

Data Backup Back up your device files to an SD card

Calculator Perform calculations

ClearVue 
Document

Display Microsoft Word files created on 
your computer

ClearVue 
Worksheet

Display Microsoft Excel files created on 
your computer

ClearVue 
Presentation

Display Microsoft PowerPoint files 
created on your computer

ClearVue PDF Display Adobe Portable Document 
Format (PDF) files created on your 
computer

Icon Program Description
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Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For 
example, you can use the pop-up menu in the contact list to quickly 
delete a contact, make a copy of a contact, or send an email message to a 
contact. The actions in the pop-up menus vary from program to 
program. To access a pop-up menu, tap and hold the stylus on the item 
name that you want to perform the action on. When the menu appears, 
lift the stylus and tap the action you want to perform. Tap anywhere 
outside the menu to close the menu without performing an action.

Notifications

Your device reminds you in a variety of ways when you have something to 
do. For example, if you’ve set up an appointment in Calendar, a task with 
a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the 
following ways:
� A message box appears on the screen. 

� A sound (which you can specify) is played.

� A light flashes on your device. 

Tap and hold to display
the pop-up menu.
Lift the stylus and tap
the action you want.

Tap outside the menu
to close it without performing
an action.
Section 2: Understanding Your Device
532A: Your PCS Phone – The Basics

� The device vibrates. 



54
� To choose reminder types and sounds for your device, tap  and then 
Settings. In the Personal tab, tap Sounds & Notifications. The 
options you choose here apply throughout the device.

Entering Information on Your Device

You have several options for entering new information:
� Use the input panel to enter typed text, either by using the soft 

keyboard or other input method.

� Write directly on the screen.

� Draw pictures on the screen.

� Speak into your device microphone to record a message.

� Use Microsoft® ActiveSync® to synchronize or copy information from 
your computer to your device. For more information on ActiveSync, see 
ActiveSync Help on your computer.

Entering Text Using the Input Panel

Use the input panel to enter information in any program on your device. 
You can either type using the soft keyboard or write using Letter 
Recognizer, Block Recognizer, or Transcriber. In each case, the characters 
appear as typed text on the screen. 

� To show or hide the input panel, tap the Input Panel button. Tap the 
arrow next to the Input Panel button to see your choices.

Select an input method.

Tap to see your choices.

Input Panel Button
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Note: You can also enter text using the keyboard. To use the keyboard, 
see “Using the Keyboard” on page 43.



When you use the input panel, your device anticipates the word you are 
typing or writing and displays it above the input panel. When you tap the 
displayed word, it is inserted into your text at the insertion point. The 
more you use your device, the more words it learns to anticipate.

Note: To change word suggestion options, such as the number of words 
suggested at one time, tap , Settings, Personal tab, Input, and then 
the Word Completion tab.

To Type with the Keyboard:

� Tap the arrow next to the Input Panel button and then tap
Hardware Keyboard. For more information, see “Using the 
Keyboard” on page 43.

To Type with the Soft Keyboard:

1. Tap the arrow next to the Input Panel button and then tap Keyboard.

2. On the soft keyboard that is displayed, tap the keys with your stylus to 
enter text.

Tap here if this
is the right word.

Soft Keyboard
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To use Letter Recognizer:

With Letter Recognizer you can use the stylus to write letters just as you 
would write on paper.

1. Tap the arrow next to the Input Panel button and then tap
Letter Recognizer.

2. Use the stylus to write a letter in the box.

When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Letter Recognizer, open Letter 
Recognizer and tap the question mark next to the writing area.

To use Block Recognizer:

With Block Recognizer you can use the stylus to input character strokes 
that are similar to those used on other devices.

1. Tap the arrow next to the Input Panel button and then 
Block Recognizer.

2. Use the stylus to write a letter in the box.

When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Block Recognizer, open Block 
Recognizer and tap the question mark next to the writing area.

To use Transcriber:

With Transcriber you can use the stylus to write anywhere on the screen 
just as you would on paper. Unlike Letter Recognizer and Block 
Recognizer, you can write a sentence or more with Transcriber. Then, 
pause and let Transcriber change the written characters to typed 
characters.

1. Tap the arrow next to the Input Panel button and then Transcriber.

2. Use the stylus to write anywhere on the screen.

For specific instructions on using Transcriber, open Transcriber and tap 
the question mark in the lower right hand corner of the screen.
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To select typed text:

1. Drag the stylus across the text you want to select.

2. Format or edit text by tapping the command on the Edit menu or by 
tapping and holding the selected words until the pop-up menu 
appears.

Writing on the Screen

In any program that accepts writing, such as the Notes program, and in 
the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to 
write directly on the screen. Write the way you do on paper. You can edit 
and format what you’ve written and convert the information to text at a 
later time.

To write on the screen:

� Tap the Pen button to switch to writing mode. This action displays 
lines on the screen to help you write.

Note: Some programs that accept writing may not have the Pen button. 
See the documentation for that program to find out how to switch to 

Tap the Pen button and use
your stylus like a pen.
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To select writing:

If you want to edit or format writing, you must first select it.

1. Tap and hold the stylus next to the text you want to select until the 
insertion point appears.

2. Without lifting, drag the stylus across the text you want to select.

� If you accidentally write on the screen, tap Edit, then Undo and try 
again. You can also select text by tapping the Pen button to deselect it 
and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with 
typed text: tap and hold the selected words and then tap an editing 
command on the pop-up menu, or tap the command on the Edit menu.

To convert writing to text:

� Tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping 
Recognize on the Tools menu (or tap and hold the selected words and 
then tap Recognize on the pop-up menu). If a word is not recognized, it 
is left as writing.

Select the text you want The writing is
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to convert and tap Recognize on the
Tools pop-up menu.

converted into text.



If the conversion is incorrect, you can select different words from a list of 
alternates or return to the original writing. To do so, tap and hold the 
incorrect word (tap one word at a time). On the pop-up menu, tap 
Alternates. A menu with a list of alternate words appears. Tap the word 
you want to use or tap the writing at the top of the menu to return to the 
original writing.

Tips for getting good recognition:
� Write neatly.

� Write on the lines and draw descenders (e.g., the lower part of “g”) 
below the line. Write the cross of the “t,” the dots of the “i” and “j,” 
and apostrophes below the top line so that they are not confused with 
the word above. Write periods and commas above the line.

� For better recognition, try increasing the zoom level to 300% using the 
Tools menu.

� Write the letters of a word closely and leave large gaps between words 
so that the device can easily tell where words begin and end.

Note: Hyphenated words, foreign words that use special characters 
such as accents, and some punctuation cannot be converted.

Tap to return to your
original writing.
Or, tap the word you want
to use.
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Note: If you add writing to a word to change it (such as changing a “3” to 
an “8”) after you attempt to recognize the word, the writing you add will 
not be included if you attempt to recognize the writing again.

Drawing on the Screen

You can use the stylus to draw on the screen in the same way that you 
write on the screen. The difference between writing and drawing on the 
screen is how you select items and how they can be edited. For example, 
selected drawings can be resized, while writing cannot.
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To create a drawing:

� Cross three ruled lines on your first stroke. A drawing box appears. 
Subsequent strokes in or touching the drawing box become part of the 
drawing. Drawings that do not cross three ruled lines will be treated as 
writing.

Note: You may want to change the zoom level so that you can more 
easily work on or view your drawing. Tap Tools and then tap a zoom level.

The drawing box indicates
the boundaries of the drawing.

Pen Button
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To select a drawing:

If you want to edit or format a drawing, you must first select it.

� Tap and hold the stylus on the drawing until the selection handle 
appears. To select multiple drawings, deselect the Pen button and then 
drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding 
the selected drawing and tapping an editing command on the pop-up 
menu, or by tapping a command on the Edit menu. To resize a drawing, 
make sure the Pen button is not selected, and drag a selection handle.

Recording a Message

In any program where you can write or draw on the screen, you can also 
quickly capture thoughts, reminders, and phone numbers by recording a 
message. In Calendar, Tasks, and Contacts, you can include a recording 
in the Notes tab. In the Notes program, you can either create a stand-
alone recording or include a recording in a written note. If you want to 
include the recording in a note, open the note first. In the Inbox 
program, you can add a recording to an email message.

To create a recording: 

1. Hold your device’s microphone near your mouth (or other audio 
source).

2. Press and hold the Voice button on the right side of the device. The 
recording toolbar appears.

3. Tap the Record button (  ) on the toolbar to start recording.

4. To stop recording, tap the Stop button (  ) on the toolbar.
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� To play a recording, tap it in the list or tap its icon in the note.

Indicates an embedded
recording.

Tap to begin recording.

Tap to show or hide
the Recording toolbar.
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Using My Text

When using Inbox or MSN Messenger, use My Text to quickly insert preset 
or frequently used messages into the text entry area. To insert a message, 
tap My Text and tap a message.

Note: After inserting a My Text message, you can add text before 
sending the message.

� To edit a My Text message, open the Tools menu, tap 
Edit My Text Messages. Select the message you wish to edit and 
make desired changes.

Tap to select a prewritten message.
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Finding and Organizing Information

The Find feature on your device helps you quickly locate information.

� On the  menu, tap Find. Enter the text you want to find, select a 
data type, and then tap Go to start the search.

Note: To quickly find information that is taking up storage space on your 
device, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your device and to 
organize these files into folders. On the  menu, tap Programs, and 
then tap File Explorer.

Note: You can move files in File Explorer by tapping and holding the item 
you want to move, and then tapping Cut or Copy and Paste on the pop-
up menu.

Tap to change folders.

Select the sort order
for the list.
Tap the folder name
to open it.

Tap and hold to create
a new folder.
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Section 2B

Using Your Phone

In This Section

� Viewing the Display Screen

� Turning the Phone ON and OFF

� Displaying Your Phone Number

� Making and Answering Calls

our device is packed with features that simplify your life and expand 
your ability to stay connected to the people and information that are 

important to you. This section will guide you through the basics of your 
device’s phone function. Follow these instructions and you’ll be on your way 
to using your phone in no time.

Y
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Viewing the Display Screen

Dialer Screen

Keypad Operation List

Regardless of the program in use, pressing the T button while the 
phone is turned on displays the dialer screen.

When the phone function’s screen is displayed, the T/E buttons 
on the device perform the same functions as the T/E buttons on 
the screen. Button functions include:

Button Idle Incoming Call During a Voice Call

T Call phone number 
displayed on the 
screen. If a phone 
number is not 
displayed, the last 
number dialed is 
called.

Answer a call. Answer Incoming 
call; Switch to 
Three-Way calling.

“Memo” Shortcut “Contacts” Shortcut

Backspace in Digit Entry

Status Icon

Speed Dial Button

Call Log Button

End Button

Talk Button

Keypad
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Speed Dial button: Tap to view the Speed Dial.

Call Log button: Tap to view the Call Log.

“Memo” Shortcut: Tap to create a note.

“Contacts” Shortcut: Tap to create a contact.

Edit Menu: 

Clear: Delete all entered numbers at once.

Paste: Paste.

E Delete all entered 
numbers at once.

Silence the 
ringer or stop 
vibration. If 
E is pressed 
again, it will 
reject a call.

End all calls.

B Delete entered 
digits one by one. 
Tap and hold 
B to delete the 
entire number.

— Delete entered digits 
one by one. Tap and 
hold B to delete 
the entire number.

0...
9

S

s

Enter the number 
you wish to call. 
Tap and hold the 
Speed Dial location 
number for one-
touch dialing of 
that number.

— The number entered 
is displayed on 
screen.

Button Idle Incoming Call During a Voice Call
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set of numbers are not dialed until you press T .
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Time Pause: “p” is entered into the number entry field. Your 
phone automatically sends the next set of numbers after three 
seconds.

Tools Menu: 

Mute: Tap to mute your phone’s microphone during 
conversations.

Options: Tap to change phone settings.

Voice Mail: Tap to call your voicemail.

Tip: You can also call voicemail by pressing and holding 1.

Signal Indicator and Icon

You may also see the following icons while the dialer screen is in display:

Signal Indicator Description

Phone is on, but is out of range of any signal.

Phone is on and is receiving a signal.

Phone call is in progress. To quickly switch back to 
Phone from any other program, tap this icon.

Phone is off. (Airplane mode)

Icon Description

Phone is in roaming mode.

Location ON

Location OFF

Mute
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Status Icon

The following icons appear at the bottom right of the screen:

The following text messages may also appear to the left of the Battery 
status:

Note: If more than one of the above conditions is present, text messages 
in upper rows of the table are given higher priority for display.

Tip: For the icons on the navigation bar, see “Navigation Bar and 
Command Bar” on page 49.

Icon Description

Battery status
Full:  (51–100%),  (26–50%),  (11–25%), 
Empty:  (0–10%), Charging:  Flash

Text message Description

No Service Outside of phone service area

Phone OFF Phone OFF (Airplane mode)

Key Guard Key guard switch is ON

Silent All, Meeting, Outdoor, 
Office, Private

Environment status
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Turning the Phone ON and OFF

1. Press the Power button to turn the device on, and then press and hold 
the Power button to turn the phone on. To turn the phone off, press 
and hold the Power button again. To turn the device off, press the 
Power button again. 

Tip: You may also press and hold the End key to turn the phone on and off.

Tip: You can also turn the phone on by tapping the Signal indicator, 
instead of pressing and holding the Power button. If you want to make 
absolutely sure you do not receive calls, such as when you are on an 
airplane, tap the Signal Indicator again and then tap Turn phone off. 
(The Signal Indicator, located in the navigation bar, indicates whether 
your phone is on, receiving a signal while on, turned off, and so on.)

2. Press the Talk button. The dialer screen appears and the device is ready 
to make a phone call.

� When the phone is on, the LED for Phone Power blinks at intervals of 
approximately five seconds.

Displaying Your Phone Number

In case you forget your phone number, your PCS Phone can remind you.

To display your phone number:

� Tap Tools, Options, then the Phone tab on the bottom.

Tip: You may use the following procedure instead: Tap , then Settings. 
On the Personal tab, tap Phone, then the Phone tab on the bottom.
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Making and Answering Calls

Making Calls

Your PCS Phone offers many different ways to make calls, including 
PCS Voice CommandSM (page 203), using Contacts (page 74), Speed 
Dialing (page 75), and using Call History (page 109).

To make a call using your keypad:

1. Make sure the phone is on. See page 72 for details.

2. Press T to access the dialer screen.

3. Enter a phone number. If you make a mistake while dialing, tap 
B to erase one digit at a time. To erase the entire number, tap 
E, tap and hold B, or tap Edit and Clear.

4. Tap T to dial the number.

5. When you’re finished, tap E to disconnect the call.

Tip: To redial your last outgoing call, tap T.

Tip: When making calls off the Sprint Nationwide PCS Network, always 
dial using 11 digits (1 + area code + phone number).

Answering Calls

1. Make sure the phone is on.

2. When a call comes in, tap Answer.

Depending on your settings, your PCS Phone notifies you of incoming 
calls in the following ways:
� The device rings or vibrates.

� The screen displays an incoming bubble message.

� If available, the phone number of the caller is displayed.

� If the phone number is in the Pocket Outlook® Contacts list, the list 
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� To reject an incoming call, tap Ignore. (If you reject the call, the busy 
tone will be sent out or the call will go to voicemail.)

� To silence the ringer and stop vibration, press E. Press E 
again to reject the call.

Note: If the phone is off, incoming calls go to voicemail.

About Caller ID:

If a call is received from a number stored in the Pocket Outlook® Contacts 
list, the name and number will be displayed. For callers not found in the 
Contact list, only numbers will be shown.

Calling Emergency Numbers

� You can place calls to 911 (dial 9 1 1 and tap T ).

Note: If an emergency number is stored in Speed Dial, you will be able to 
dial it by tapping a single key. However, speed dial will not work if Key 
Guard is enabled.

Making a Call From the Internal Phone Book

Phone numbers entered in Contacts can be used to quickly locate phone 
numbers and make calls.

1. In the contact list, tap and hold the contact.

2. On the pop-up menu, tap Call and the type of phone number 
displayed, such as Work tel.

Another way to make calls:

1. In the contact list, tap the contact.

2. Tap Tools and Call and the type of phone number displayed, such as 
Work tel.

Tip: For details about Contacts, see page 112.
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Making a Call From Speed Dial

Speed dialing enables you to quickly place a call simply by tapping a 
contact or by tapping and holding a Speed Dial location number. 

To add a contact to Speed Dial:

1. From the Dialer screen, tap Speed Dial and then tap New.

2. Tap the contact name and number you want to add.

3. Select an available Speed Dial location number using the arrow keys.

� Phone numbers are stored in Speed Dial based on the location number 
you choose when adding the phone number, rather than by the contact 
name, and cannot be reorganized. You can store up to 99 numbers in 
Speed Dial.

To dial a phone number using Speed Dial:

� Tap the Speed Dial button and then tap the contact you want to call. 

Another way to make calls:

� From the keypad, you can tap and hold the speed dial location number 
you want to call.

� The first location in the speed dial list will automatically be set to your 
voicemail. To call your voicemail, tap the first location in the speed 
dial list, and then follow the directions for your voicemail system. 
(To set up voicemail, see page 188. To use voicemail, see “Using 
Voicemail” on page 188.)

Making a Call From Call History

The Call Log details all incoming, outgoing, and missed calls, and also 
provides a summary of total calls. The Call Log can also tell you when a 
call was initiated, and how long it lasted, and it provides easy access to 
any notes taken during the call. 

To view the call log:
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To reorganize your call log to view only the information you need:

� Tap the view list (labeled All Calls by default) and select a different 
view. For example, you can view only missed calls, incoming calls, or 
list calls by caller name. 

To respond to the call:

� Tap the Dial button located to the left of the number you want to call.

To place a call from Call History:

� See “Making a Call From Call History” on page 109.

Making a Call From 4/5 Digit Dial

4/5 Digit Dial enables you to make a call without entering a complete 
number. See “Changing the Others Settings” on page 84.

1. Make sure Prglaunch mode is set (4/5 Digit Dial is available).

2. Enter 4 or 5 digits and tap Talk.

A programmed number will be automatically added to the beginning of 
the entered number, or the Contact directory will be searched for phone 
numbers whose lower digits match the entered number.

Making a Call From Voice Dial

1. Press the Voice button on the side bar of your device.

2. Say the number or a name in Contacts you want to call.

3. Say “Yes” to confirm.

See page 127 to set Voice Dial.

Using Memo

While you are on a call, you can use the Notes application to type, write, 
draw, or record a Memo (see “Notes: Capturing Thoughts and Ideas” on 
page 122). 

1. To access the Memo function, tap .
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3. Tap ok to close Memo.



After you have finished the note, it will be saved as an attachment to the 
call in one of the Call Log lists.

� To access a note, tap  in the Call Log list.

Using Speaker Phone

Speaker Phone can be used in any situation where you would like to use 
your phone without using your hands.

� To turn Speaker Phone on, press the Speaker Phone button.

� To turn Speaker Phone off, press the Speaker Phone button again.

Note: For more information about the phone on your device, tap , and 
then tap Help.
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Section 2C

Controlling the Phone 
Function’s Settings

In This Section
� Changing the Voicemail Number
� Changing the Ringer and Key Beep Settings
� Changing the Location Setting
� Changing the Environment Mode and Volume and Ring Type/Tone 

Settings for Individual Modes
� Data
� Changing the Others Settings
� Phone Info
� TTY

his section describes how you can change the phone function settings 
for your device.T
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Changing the Voicemail Number

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Phone tab on the bottom.

2. Enter the number you wish to call to retrieve your voicemail.

3. Tap ok. The Personal tab screen is restored.

Changing the Ringer and Key Beep Settings

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Phone tab on the bottom.

2. Use the drop-down menus to select settings for Ring type, Ring tone, 
Keypad, and Other Settings.

3. Tap ok. The Personal tab screen is restored.

Note: With the Environment switch set to “Silent”, the above selections 
will result in no changes.
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Changing the Location Setting

Your phone’s Location feature allows the network to detect your position 
and is designed for use in connection with location-based services which 
may be available in the future.

To turn Location on or off:

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Location tab on the bottom.

2. Select ON or OFF for the location setting.

� ON: The user allows search user’s position from Network.

� OFF: The user does not allow search user’s position from Network.

3. Tap ok.

� After a message appears, tap ok. The Personal tab screen is restored.

Tip: The current location setting is shown on the dialer screen (and 
Today screen). For more information, see page 47.

Note: Turning Location off will hide your location from everyone except 911.

Note: Even if the Location feature is enabled, no service may use your 
location without your expressed permission.
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Changing the Environment Mode and 
Volume and Ring Type/Tone Settings for 
Individual Modes

When the Environment switch is set to “Environment,” the device is 
placed into the mode that you select, from “meeting,” “outdoor,” 
“office,” and “private.” For the individual modes, you can also make 
selections for volume and ring type/tone.

Tip: The Environment switch is used for changing the volume and ring 
type/tone settings for incoming calls. For more information, see 
“Environment Switch” on page 42.

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Environment tab on the bottom.

2. Under Select Mode, select a desired mode.

3. Under Environment, select a mode to be changed. Then select settings 
for Volume and Ringer. 

� You can customize volume and ring type/tone for each mode.

4. Tap ok. The Personal tab screen is restored.
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The defaults for the individual modes are as below:

Note: The settings made for Sounds & Notification (page 96) and Phone 
(page 80) will be effective unless the Environment switch is set to a 
different position.

Data

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Data tab on the bottom.

� Tap Camera Reset to clean up registration information of Online 
pictures. 

� Tap Update Data Profile to pull PCS Vision information such as user 
ID and password from the network.

Mode Volume Ring type Ring tone Vibrate

Environment Meeting OFF 
(Silent)

Vibrate None Pattern1

Outdoor Max 
(level 6)

Vibrate 
and ring

BellDitty Pattern1

Office Medium 
(level 3)

Ring BellDitty None

Private Max 
(level 6)

Vibrate 
and ring

BellDitty Pattern1
Section 2: Understanding Your Device
832C: Controlling the Phone Function’s Settings



84
Changing the Others Settings

You can select various settings for other phone functions using the 
Others tab. 

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Others tab on the bottom.

2. Make selections for each item.
� 4 or 5 digits dial

This function allows you to dial a number using only four or five digits, 
either by programming a number to automatically be added to the 
entered digits or by searching the Contacts directory for a phone number 
containing the entered digits.

Abbreviate: Check the box to add a programmed number to the 
beginning of an entered number. For Prefix, enter a number to be 
added.

Contact match: Check the box to search the Contact directory for 
phone numbers whose lower digits match the entered number.

� On battery power: Check the box to darken the screen during 
conversations.

Tip: The screen will be automatically darkened when conversations are 
continued for 60 seconds. When the screen is off, pressing the POWER, 
TALK buttons, or operating the jog-wheel turns the screen on.

� Answer

This function allows you to select settings for answering incoming calls.

Any key answer: When Any-key answer is checked, incoming calls 
can be answered by pressing any key other than the END, Power, Key 
Guard buttons, Environment switch and Shift, Num, Fn keys on the 
QWERTY keyboard. However, this function isn’t enabled in the Key 
Guard state.

Auto Answer: When Auto Answer is checked, incoming calls can be 
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Use Headset: Incoming calls can be answered only when Headset is 
being inserted into the device.

All: Incoming calls can be answered on external power state.

Speaker Phone ON: Speaker phone is turned on during call.

Tip: Selections for Use Headset, All, and Speaker Phone On are valid 
only when the box for Auto answer has been checked.

� Automatic: Seeks service on the Sprint Nationwide PCS Network. If 
PCS Service is unavailable, the phone searches for an alternate system.

When Display message at Roaming Area in begin call state is 
checked, the text message “Caution! This operation will be charged” 
appears in the incoming or outgoing bubble message or message 
window on the dialer.

� Sprint: Allows you to access the Sprint Nationwide PCS Network only 
and prevents roaming on other networks.

3. Tap ok. The Personal tab screen is restored.
Section 2: Understanding Your Device
852C: Controlling the Phone Function’s Settings



86
Phone Info

1. Tap , then Settings. On the Personal tab, tap Phone, then the 
Phone Info tab on the bottom.

2. Your Phone information is displayed.

3. Tap ok.

Tip: For the User ID, “PCS Vision disabled” appears with data connection 
disabled, and a user ID appears with data connection enabled.
Section 2: Understanding Your Device
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TTY

A TTY (also known as a TDD or Text Telephone), is a 
telecommunications device that allows people who are deaf or hard of 
hearing, or who have speech or language disabilities, to communicate by 
telephone.

Your phone is compatible with select TTY devices. Please check with the 
manufacturer of your TTY device to ensure that it supports digital 
wireless transmission. Your phone and TTY device will connect via a 
special cable that plugs into your phone’s headset jack. If this cable was 
not provided with your TTY device, contact your TTY device 
manufacturer to purchase the connector cable.

Use the following procedure to make a setting for TTY:

1. Tap , then Settings. On the Personal tab, tap Phone, then the TTY 
tab on the bottom.

Tip: When you enter “##889” (TTY) on the dialer, the TTY setting screen is 
opened.

2. When you select Enable, “TTY is enabled” appears. 

3. Tap ok at the top right of the screen to close the setting screen. 

4. Insert the TTY into the headset jack.
Section 2: Understanding Your Device
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Note: Malfunction may occur if you insert the TTY into the headset jack 
without doing steps 1 to 3.
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5. “TTY is available” appears. 

Note: You cannot change the TTY setting during a call. 

IMPORTANT NOTICE:  911 Emergency Calling
Sprint recommends that TTY users make emergency calls by other 
means including Telecommunications Relay Services (TRS), analog 
cellular, and landline communications. Wireless TTY calls to 911 may be 
corrupted when received by public safety answering points (PSAPs) 
rendering some communications unintelligible. The problem 
encountered appears related to TTY equipment or software used by 
PSAPs. This matter has been brought to the attention of the FCC, and the 
wireless industry and PSAP community are currently working to resolve 
this.
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Section 2D

Controlling Your Device’s 
Settings

In This Section
� Adjusting Settings
� Adding or Removing Programs
� Setting Buttons
� Setting a Password
� Selecting Sounds & Notifications Settings
� Selecting Backlight Settings
� Adjusting Memory Settings
� Setting the Microphone
� Adjusting Power Settings
� Customizing Regional Settings

his section describes the procedures for making various settings to 
customize your device.T
Section 2: Understanding Your Device
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Adjusting Settings

You can adjust device settings to suit the way you work. To see available 
options, tap , Settings, then the Personal or System tab located at 
the bottom of the screen.

You might want to adjust the following:
� Backlight: See “Selecting Backlight Settings” on page 97.

� Buttons: See “Setting Buttons” on page 94.

� Clock: To change the time or to set alarms.

� Input: To set up the input methods of your device.

� Memory: See “Adjusting Memory Settings” on page 98.

� Menus: To customize what appears on the  menu, and to enable a 
pop-up menu from the New button.

� Microphone: See “Setting the Microphone” on page 99.

� Owner Information: To enter your contact information.

� Password: To limit access to your device. See “Setting a Password” on 
page 95.

� Power: To maximize battery life. See “Adjusting Power Settings” on 
page 100.

� Regional Settings: See “Customizing Regional Settings” on page 101.

� Remove Programs: See “Adding or Removing Programs” on page 91.

� Screen: To recalibrate the screen and enable/disable the Clear Type 
feature.

� Sound & Notification: See “Selecting Sounds & Notifications 
Settings” on page 96.

� Today: To customize the look and the information that is displayed on 
the Today screen.
Section 2: Understanding Your Device
2D: Controlling Your Device’s Settings



Adding or Removing Programs

Programs installed to your device at the factory are stored in ROM (read-
only memory). You cannot remove this software, and you’ll never 
accidentally lose ROM contents. ROM programs can be updated using 
special installation programs with a *.xip extension. All other programs 
and data files added to your device after factory installation are stored in 
RAM (random access memory). 

You can install any program created for your device, as long as your 
device has enough memory. The most popular place to find software for 
your device is on the Pocket PC Website (http://www.microsoft.com/
mobile/pocketpc).

To add programs using ActiveSync:

You’ll need to install the appropriate software for your device on your 
desktop computer before installing it on your device.

Note: Determine your device and processor type so that you know which 
version of the software to install. Tap , and then Settings. On the 
System tab, tap About. In the Version tab, make a note of the 
information in Processor.

1. Download the program to your computer (or insert the CD or disk that 
contains the program into your computer). You may see a single *.xip, 
*.exe, *.zip file, a Setup.exe file, or several versions of files for different 
device types and processors. Be sure to select the program designed for 
the Pocket PC and your device processor type.

2. Read any installation instructions, Read Me files, or documentation 
that comes with the program. Many programs provide special 
installation instructions.

3. Connect your device and computer via the USB port. (See “Using the 
USB Port” on page 32.)

4. Double-click the *.exe file.
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� If the file is an installer, the installation wizard will begin. Follow the 
directions on the screen. Once the software has been installed on your 

http://www.microsoft.com/mobile/pocketpc
http://www.microsoft.com/mobile/pocketpc


92
computer, the installer will automatically transfer the software to your 
device. 

� If the file is not an installer, you will see an error message stating that 
the program is valid but it is designed for a different type of computer. 
You will need to move this file to your device. If you cannot find any 
installation instructions for the program in the Read Me file or 
documentation, use ActiveSync Explore to copy the program file to the 
Program Files folder on your device. For more information on copying 
files using ActiveSync, see ActiveSync Help. 

Once installation is complete, tap , Programs, and then the program 
icon to switch to it.

To add a program directly from the Internet:

Note: Determine your device and processor type so that you know which 
version of the software to install. Tap  and then Settings. On the 
System tab, tap About. In the Version tab, make a note of the 
information in Processor.

1. Download the program to your device straight from the Internet using 
Pocket Internet Explorer. You may see a single *.xip, *.exe, *.zip file, a 
Setup.exe file, or several versions of files for different device types and 
processors. Be sure to select the program designed for the Pocket PC 
and your device processor type.

2. Read any installation instructions, Read Me files, or documentation 
that comes with the program. Many programs provide special 
installation instructions.

3. Tap the file, such as a *.xip or *.exe file. The installation wizard will 
begin. Follow the directions on the screen.
Section 2: Understanding Your Device
2D: Controlling Your Device’s Settings



To add a program to the Start menu:

� Tap , Settings, Menus, the Start Menu tab, and then the check 
box for the program. If you do not see the program listed, you can 
either use File Explorer on the device to move the program to the Start 
Menu folder, or use ActiveSync on the computer to create a shortcut to 
the program and place the shortcut in the Start Menu folder.

� Using File Explorer on the device: Tap , Programs, 
File Explorer, and locate the program (tap the folder list, labeled 
My Documents by default, and then My Device to see a list of all 
folders on the device). Tap and hold the program and tap Cut on the 
pop-up menu. Open the Start Menu folder located in the Windows 
folder, tap and hold a blank area of the window, and tap Paste on the 
pop-up menu. The program will now appear on the  menu. 

� Using ActiveSync on the computer: Use the Explorer in ActiveSync 
to explore your device files and locate the program. Right-click the 
program, and then click Create Shortcut. Move the shortcut to the 
Start Menu folder in the Windows folder. The shortcut now appears on 
the  menu. For more information, see ActiveSync Help.

To remove programs:

� Tap  and then Settings. On the System tab, tap 
Remove Programs.

If the program does not appear in the list of installed programs, use File 
Explorer on your device to locate the program, tap and hold the program, 
and then tap Delete on the pop-up menu.
Section 2: Understanding Your Device
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Setting Buttons

To assign application programs to Application launch keys (A1–A8):

1. Tap , then Settings. On the Personal tab, tap Buttons, then the 
Program Buttons tab on the bottom.

2. Select functions to be assigned to the individual buttons.

3. Tap ok. The Personal tab screen is restored.

When you press the “Fn” key while operating the device, the following 
operation window is displayed on the screen:

Defaults:
A1 Camera
A2 Review Share
A3 ClearVue Document
A4 ClearVue WorkSheet
A5 ClearVue Presentation
A6 ClearVue PDF
A7 Data Backup
A8 World Clock
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Setting a Password

You can protect data or settings from another person by setting a 
password for access. The password is requested when turning power on.

1. Tap , then Settings. On the Personal tab, tap Password.

2. Select the type of password you would like to use.

� When a strong alphanumeric password is selected, your password must 
be at least seven characters long and contain a combination of 
uppercase letters, lowercase letters, numerals, or punctuation.

3. Select how long your device must be turned off before the password is 
required to use your device.

4. Enter a password and tap ok.

5. Tap YES on the confirmation screen. The password is saved and the 
screen returns to the Personal tab screen.

Note: Record your password in a safe place. If you wish to change your 
password, you will have to know the existing one to access the 
Password setting screen. If you forget your password, you will have to 
initialize the device, which deletes all stored data and settings.
Section 2: Understanding Your Device
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Selecting Sounds & Notifications Settings

To select preferences for Sounds and Notifications, such as alarm volume 
and duration: 

1. Tap , then Settings. On the Personal tab, tap 
Sounds & Notifications.

2. Make selections for Sounds & Notifications.

3. Tap ok. Personal tab screen is restored.

Note: With the Environment switch set to “Silent,” the above selections 
for “System volume” under Volume tab and “Select an event → Incoming 
call” under Notifications tab will result in no changes.
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Selecting Backlight Settings

To customize the backlight brightness and automatic turn-off for power 
saving purposes:

1. Tap , then Settings. On the System tab, tap Backlight.

2. Select backlight settings.

3. Tap ok. The System tab screen is restored.
Section 2: Understanding Your Device
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Adjusting Memory Settings

You can adjust the amount of memory allocated for storing data and for 
running programs. You can also confirm the amount of free space 
available on a storage card. Memory for the device is managed 
automatically.

Changing the memory allocation

1. Tap , then Settings. On the System tab, tap Memory.

2. Drag the slider in either direction to adjust the allocation of memory 
for data storage and program execution.

3. Tap ok. The System tab screen is restored.
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Setting the Microphone

When Automatic Gain Control is on, the sensitivity of the microphone is 
automatically adjusted to best pick up changing sound levels.

To specify whether to enable or disable the Auto Gain Control function:

1. Tap , then Settings. On the System tab, tap Microphone.

2. Select Enable or Disable for Auto Gain Control.

� Enable AGC: Turn on automatic gain control for the microphone.

� Disable Turn off automatic gain control for the microphone.

3. Tap ok. The System tab screen is restored.
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Adjusting Power Settings

To confirm the battery power remaining and the time that elapses until 
the power turns off after the last operation:

1. Tap , then Settings. On the System tab, tap Power.

2. Select Power settings.

3. Tap ok. The System tab screen is restored.
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Customizing Regional Settings

To customize language, number format, currency, time, and date display:

1. Tap , then Settings. On the System tab, tap Regional Settings.

2. Make selections for regional settings.

3. Tap ok. The System tab screen is restored.
Section 2: Understanding Your Device
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Section 2E

Controlling Your Roaming 
Experience

In This Section

� Understanding Roaming
� Setting Your Device’s Roam Mode
� Controlling Roaming Charges Using Call Guard

oaming is the ability to make or receive calls while you’re off the 
Sprint Nationwide PCS Network. Your new single band PCS Phone 

works anywhere on the Sprint Nationwide PCS Network and allows you to 
roam on digital networks where compatible wireless service is available.

This section explains how roaming works as well as special features that let 
you manage your roaming experience.

R
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Understanding Roaming

Recognizing Icon on the Display Screen

Your phone’s display screen always lets you know when you’re off the 
Sprint Nationwide PCS Network and start roaming by displaying the 

 icon.

Tip: Remember, when you are using your device off the Sprint 
Nationwide PCS Network, always dial numbers using 11 digits 
(1 + area code + number).

Note: You will pay a higher per-minute rate for roaming calls.

Roaming on Other Digital Networks

When you’re roaming on other digital networks, your call quality and 
security will be similar to the quality you receive when making calls 
while on the Sprint Nationwide PCS Network. You may not be able to 
access certain calling features, such as PCS Vision.

Tip: If you’re on a call when you leave the Sprint Nationwide 
PCS Network and enter an area where roaming is available, your call is 
dropped. If your call is dropped in an area where you think PCS Service 
is available, turn your phone off and on again to reconnect to the Sprint 
Nationwide PCS Network.

Setting Your Device’s Roam Mode

Your PCS Phone allows you to control your ability to roam. By using the 
Roaming menu option, you can determine which signals your device 
accepts.

Set Mode

Choose from two different settings on your device to control your 
roaming experience:
Section 2: Understanding Your Device
4 2E: Controlling Your Roaming Experience

1. From the dialer screen, tap Options on the Tools menu to display the 
Phone setting screen.

2. Tap the Others tab.



3. Check Automatic or Sprint.

� Automatic: This setting seeks PCS Service. When PCS Service is 
unavailable, the phone searches for an alternative system.

� Sprint: This setting allows you to select the Sprint Nationwide PCS 
Network only and prevents roaming on other networks.

Controlling Roaming Charges Using Call 
Guard

In addition to the roaming icon, Call Guard alerts you when roaming 
charges apply. This feature makes it easy to manage your roaming 
charges by reminding you when you make or receive roaming calls. It 
also requires you to take additional steps before placing or answering a 
roaming call. These additional steps are not required when you make or 
receive calls while on the Sprint Nationwide PCS Network.

To Turn the Call Guard Feature On or Off:

1. From the dialer screen, tap Options on the Tools menu to display the 
Phone setting screen.

2. Tap the Others tab.

3. Check Automatic.

4. Check “Display message at Roaming Area begin call state.” to 
turn the Call Guard on. To turn the Call Guard off, clear the checkbox.

To Place Roaming Calls With Call Guard On:

1. Place a call.

2. Tap Continue when the message screen appears.

To Answer Incoming Roaming Calls With Call Guard On:

� Tap Continue in the message screen.
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Section 2F

Managing Call History

In This Section

� Viewing History
� Call History Options
� Making a Call From Call History
� Saving a Phone Number From Call History
� Erasing Call History

he Call History helps you manage your time more effectively. It keeps 
track of incoming calls, calls made from your PCS Phone, and missed 

calls. This section guides you through accessing and making the most of 
your Call History.

T
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Viewing History

The Call Log screen displays a list of incoming, outgoing, and missed 
calls, including caller information and call time.

To view the Call Log screen:

� From the Dialer, tap Call Log.

To select the Call Log list you wish to view:

1. Tap the view list on the screen.

2. Select the one you wish to view.

� Lists are All Calls, Missed, Outgoing, Incoming, By Caller ....

To view details:

� Tap a log entry to display Details. Details include time, date, and call 
duration.
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Call History Options

To view Call History options:

� Tap Tools, then Options.

� You can see lifetime number of calls and total time.

� You can see and reset trip odometer number of calls and total time 
since you last emptied the call log.

� You can delete items older than a certain period of time.

Making a Call From Call History

To place a call from Call History:

� Tap the Dial button located to the left of the number you want to call.

You can also place a call as follows:

1. Tap and hold the number on the screen.

2. When the pop-up menu appears, tap Call.

Note: You cannot make calls from Call History to entries identified as 
No ID or Restricted.

Saving a Phone Number From Call History

You can keep telephone numbers in “Contacts” in Microsoft® Pocket 
Outlook®.

1.  Tap and hold the Call History to be registered, then select
New Contacts.

2. Enter necessary information on the Contacts screen to perform 
registration.

� For details about Contacts, see page 112.

Note: You cannot save phone numbers from calls identified as No ID or 
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Erasing Call History

To erase individual Call History entries:

1. Tap and hold the number on the screen.

2. When the pop-up menu appears, tap Delete.

To erase Call History:

� Tap Tools, then Delete all calls.
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Section 2G

Using Microsoft® Pocket 
Outlook®

In This Section

� Contacts: Tracking Friends and Colleagues

� Calendar: Scheduling Appointments and Meetings

� Tasks: Keeping a To Do List

� Notes: Capturing Thoughts and Ideas

f the contact data on your personal computer is in Microsoft® Outlook®, 
the Microsoft® Pocket Outlook® application on this device can read and 

import the contact data. This section explains how to use Microsoft Pocket 
Outlook.

Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and 
Notes, which can be used individually or together. For example, email 
addresses stored in Contacts can be used to address email messages in 
Inbox. ActiveSync® synchronizes information in Microsoft® Outlook® or 
Microsoft® Exchange on your computer with your device, comparing 
changes made on both and updating each with the latest information. For 
information on using ActiveSync®, see ActiveSync® Help on your computer.

I
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Contacts: Tracking Friends and Colleagues

Contacts maintains an easily accessible list of friends and colleagues. 
Your device’s infrared (IR) port allows you to quickly share Contacts 
information with other devices.

� To access Contacts, tap the Contacts Icon from the dialer screen, or tap 
, then Contacts.

� Tap All Contacts to select the category of contacts you want displayed 
in the list.

� Tap the search box and enter part of a name to quickly find it in 
the list.

� Tap a contact to display or edit details.

� Tap and hold a contact to display a pop-up menu of actions.

� Tap to the right of a contact to see additional phone number and email 
addresses for the contact.

Note: Tap Tools then Options to change the way information is displayed 
in the contact list. 

Note: When transferring the contact to another device by using infrared 
(IR), tap and hold that contact, then tap Beam Contact from the displayed 
pop-up menu. For more information, see “Sending Files Using Infrared 
Section 2: Understanding Your Device
2 2G: Using Microsoft® Pocket Outlook®

Rays” on page 166.



Creating a Contact

1. From the Contacts screen, tap New.

2. Enter a name and other contact information. Scroll down to see all 
available fields.

Tip: To enter a hard pause or time pause in the phone number entry field, 
select HardPause/TimePause from the Edit menu.

3. Scroll and tap Categories and select a category from the list to assign 
the contact to a category.

4. Tap the Notes tab to add notes. Enter text, draw, or create a recording. 
(See “Notes: Capturing Thoughts and Ideas” on page 122 for details.)

5. When finished, tap ok to return to the contact list.

Finding a Contact

There are four ways to find a contact:

� In the contact list, enter a contact name in the box under the 
navigation bar.

To show all contacts again, clear text from the box or tap the button to 
the right of the box.

� In the contact list, tap the category list (labeled All Contacts by 
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default) and select the type of contact that you want displayed.
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To view a contact not assigned to a category, select None.

� To view the names of companies your contacts work for, in the contact 
list, tap View, then By Company.

The number of contacts that work for that company will be displayed 
to the right of the company name.

� Tap , Find, enter the contact name, select Contacts for the type, 
and then tap Go. 

Using the Summary Screen

� Tap a contact in the contact list to display a summary screen. Tap Edit 
to change the contact information.

Making a Call From Contacts

See “Making a Call From the Internal Phone Book” on page 74.
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Assigning a Picture to a Contact (Picture Display Mode)

1. Tap View, then select By Picture.

� The picture display mode as shown is recalled.

Tip: For contacts with pictures assigned, “Picture” appears to the right 
of the list.

2. Select a Contact to which a picture is assigned, tap Tools, and then 
select Select Picture....

3. Select a picture to be assigned.

4.  The picture is assigned to the specified Contact.

Tip: You can trim the assigned picture to 100 × 100 pixels. To trim the 
picture, select Crop Picture from the Edit menu.

Tip: To delete the assigned picture, select Delete Picture from the Edit 
menu. 

Tip: To send a picture to another device using infrared rays, select 
Beam Picture... from the Tools menu. 

Tip: To restore a mode that does not display picture, tap View, and then 
select By Picture.
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Calendar: Scheduling Appointments and 
Meetings

Use Calendar to schedule appointments, including meetings and other 
events. You can check your appointments in one of several views 
(Agenda, Day, Week, Month, and Year) and easily switch views by tapping 
one of the five view icons at the bottom of the screen.

� To access the Calendar, tap , then Calendar.

� Tap  to go to today.

� Tap on an appointment to display or edit the details.

� Tap , , , , or  to switch between the 5 views (Agenda, Day, 
Week, Month, and Year).

Note: Tap Options on the Tools menu to customize the Calendar display.
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Creating an Appointment

If you are in Day or Week view, tap the desired date and time for the 
appointment.

1. Tap New.

� Tap ok to return to the calendar (the appointment is saved 
automatically).

� Tap  in the Subject section to choose from predefined text.

� Tap  in the Location section to choose from previously entered 
locations.

� Tap  in the Starts section to select a start time.

� Tap  in the Ends section to select an end time.

� Notes is a good place for maps and directions.

2. Enter a subject (description) and location.

3. Adjust the date and time as needed.

4. Enter other desired information. Hide the input panel to view all 
available fields, if necessary.

5. Tap the Notes tab to add notes or a drawing, or to create a recording. 
For more information see ““Notes: Capturing Thoughts and Ideas” on 
page 122”.
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Note: If you select Remind me in an appointment, your device will remind 
you according to the options set in the  menu, Settings, Personal tab, 
Sounds & Notifications.

Using the Summary Screen

� Tap an appointment to display the summary screen. To make changes, 
tap Edit.

Creating Meeting Requests

Calendar can set up meetings with other Outlook® or Pocket Outlook® 
users. The meeting request will be created automatically and sent either 
when you synchronize Inbox or when you connect to your email server. 
Indicate how you want meeting requests sent by tapping Tools, then 
Options. If you send and receive email messages through ActiveSync®, 
select ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, then tap Attendees.

3. Select the meeting attendees from your Contacts list and Tap ok.

The meeting notice is created automatically and placed in the Outbox 
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For more information on sending and receiving meeting requests, see 
Calendar Help and Inbox Help on the device.



Tasks: Keeping a To Do List
� Tasks helps you keep track of what you need to do. To access Tasks, tap 

, then Tasks.

� Tap All Tasks to select the category of tasks you want displayed in 
the list.

� Tap Priority to select the sort order of the list.

�  indicates high priority.

Tip: ↓ displays on a low priority task, while nothing displays on a 
normal task.

� Tap on a task to display or edit the task details.

� Tap and hold to display a pop-up menu of actions.

Note: Tap Tools, then Options to change the way information is displayed.
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Creating a Task

1. In the Tasks screen, tap New.

� Tap ok to return to the task list (the task is saved automatically).

� Tap  in the subject section to choose from predefined subjects.

� Notes is a good place for maps and drawings.

2. Enter a subject (description).

3. Enter a start and due date or other information by tapping the field. To 
see all available fields, hide the input panel (if necessary).

4. Tap Categories to assign the task a category. In the list, Tasks can be 
displayed by category.

5. Tap the Notes tab to add notes or a drawing, or to create a recording. 
For more information, see “Notes: Capturing Thoughts and Ideas” on 
page 122.

6. Tap ok when finished. The task is saved automatically.

Note: To quickly create a task with only a subject, tap Entry Bar on the 
Tools menu. Then, tap Tap here to add a new task and enter your task 
information.
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Using the Summary Screen

� Tap a task to display the summary screen. To make changes, tap Edit.

� Tap  to show and hide additional summary information.
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Notes: Capturing Thoughts and Ideas

The Notes feature helps you quickly capture thoughts, reminders, ideas, 
and phone numbers. You can also create a recording to include with an 
entry.

� Tap Name to change the sort order of the list.

� Tap on a note to open the note or to play an attached recording.

� Tap and hold on a note to display a pop-up menu of actions.

� Tap  to record.

� Tap  to show or hide the Recording toolbar.
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Creating a Note

1. From the Notes screen, Tap New.

2. Create your note by writing, drawing, typing, or recording. For more 
information about using the input panel, writing and drawing on the 
screen, and creating recordings, see “Entering Text Using the Input 
Panel” on page 54.

� Tap ok to return to the note list (the note is saved automatically).

� Tap  to show or hide the Recording toolbar.

� Tap the Pen button to write on the screen.
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Section 2H

Using Your Phone’s 
Voice Services

In This Section

� Using Voice-Activated Dialing
� Recording Voice

his section explains the features associated with your phone’s Voice 
Services. The easy-to-follow instructions explain how to make calls and 

record memos.

T
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Using Voice-Activated Dialing

In addition to Voice CommandSM (see page 203), you can use Voice Dial to 
dial a phone number stored in Contacts.

Calling by Name

1. Press the Voice button.

2. Say a name in Contacts.

3. Say “Yes” if recognized correctly.

Calling by Phone Number

1. Say “Dial a number.”

2. Say a number.

3. Say “Yes” if recognized correctly.

Note: Recognition may fail in the noisy places. For example, in the 
running automobile.

Tip: Voice Dial may fail recognition depending on conditions. If this is the 
case, try the following:

• Open the Recog tab on the VoiceDial Settings screen (page 127), 
and perform adjustments for Recognition performance and 
Section 2: Understanding Your Device
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Recognition rejection.
• If names in contacts are not recognized well, place a checkmark in 

Contacts only in the Contacts tab on the VoiceDial Settings (page 127). 
Or try registering your voice (nickname feature) in the Contacts tab.



Note: For the nickname feature, register your voice in a silent room. 
When making a call using a nickname, pronounce with the same 
intonation as when you registered.

Selecting Voice Dial Settings

1. Tap , then Programs, and select VoiceDialSetting to display the 
VoiceDial Settings screen.

2. Select Settings for VoiceDial.

3. Tap ok. 

Recording Voice

Your PCS Phone can record your voice. For more information, 
see“Recording a Message” on page 62.
Section 2: Understanding Your Device
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Section 2I

Using Application Programs

In This Section
� Pocket Internet Explorer
� Inbox: Sending and Receiving Email Messages
� MSN® Messenger
� Pocket Word
� Pocket Excel
� Windows Media™ Player for Pocket PC
� Microsoft® Reader
� Camera
� Review/Share
� Online Pictures
� ClearVue
� World Clock
� SaiSuke
� Installing Application Programs from the Companion CD

his section describes how to use the programs listed above that are 
installed on your device.T
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Pocket Internet Explorer

Use Microsoft® Pocket Internet Explorer to view Web or WAP pages in 
either of these ways:
� During synchronization with your computer, download your favorite 

links and mobile favorites that are stored in the Mobile Favorites 
subfolder in Internet Explorer on the computer.

� Connect to PCS Connection and browse the Web. When connected to 
PCS Connection, you can also download files and programs from the 
Internet.

� To switch to Pocket Internet Explorer, tap  then Internet Explorer.

The Mobile Favorites Folder

Only items in your computer’s Mobile Favorites folder will be 
synchronized with your device. This folder is automatically created when 
ActiveSync® is installed.

Favorite Links

During synchronization, your computer’s Mobile Favorites folder is 
synchronized with your device’s Pocket Internet Explorer. Both computers 
are updated each time you synchronize. If the link is not marked as a 
mobile favorite, you will have to connect to PCS Connection to view page 
content. For more information, see ActiveSync® Help on the computer.

Mobile Favorites

If you are using Microsoft® Internet Explorer 5.0 or later on your 
computer, you can download mobile favorites to your device. 
Synchronize the Web content of your mobile favorites downloads to your 
device so that you can view pages while you are disconnected from 
PCS Connection and computer.

Use the Internet Explorer plug-in installed with ActiveSync® to create 
mobile favorites quickly.
Section 2: Understanding Your Device
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To create a mobile favorite:

1. In Internet Explorer on your computer, click Tools then 
Create Mobile Favorite.

2. To change the link name, enter a new name in the Name box.

3. Optionally, in Update, select a desired update schedule.

4. Click OK. Internet Explorer downloads the latest version of the page to 
your computer.

5. If you want to download the pages that are linked to the mobile 
favorites you just created, right-click the mobile favorite then click 
Properties. In the Download tab, specify the number of links deep 
you want to download. To conserve device memory, go only one 
level deep.

6. Synchronize your device and computer, and the Mobile Favorites folder 
will be downloaded to your device.

Note: If a scheduled update was not specified in step 3, content will 
have to be manually downloaded to update both computers. To see the 
last time content was downloaded to the computer, click Tools then 
Synchronize from the Internet Explorer window. Manually download 
content as needed.

Note: To add a button to your computer’s Internet Explorer toolbar for 
creating mobile favorites, click View, Toolbars, then Customize.

To minimize the amount of memory used by mobile favorites:

� In the Favorites settings, select ActiveSync® options and turn off 
pictures and sounds, or stop select mobile favorites from being 
downloaded. For more information see ActiveSync® Help.

� Limit the number of downloaded linked pages. On your computer’s 
Internet Explorer, right click the mobile favorite you want changed 
and then Properties. In the Download tab, specify 0 or 1 for the 
number of linked pages you want to download.
Section 2: Understanding Your Device
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Using AvantGo Channels

AvantGo, a free interactive service that provides access to personalized 
content and popular Websites, can be subscribed to directly from your 
device. Content can be downloaded when you synchronize your device 
and computer, or directly from the Internet. Visit the AvantGo Website for 
more information.

To sign up for AvantGo:

1. In ActiveSync® options on the computer, turn on synchronization for 
the AvantGo information type.

2. In Pocket Internet Explorer on your device, tap the Favorites button to 
display your list of favorites.

3. Tap the AvantGo Channels link.

4. Follow the directions on the screen.

When synchronization is complete, tap the AvantGo Channels link in 
your list of favorites to see a few of the most popular channels. To add or 
remove channels, tap the Add or Remove link.

Using Pocket Internet Explorer

Pocket Internet Explorer can browse mobile favorites and channels that 
have been downloaded to your device without connecting to the Internet.

Or, you can connect to the Internet through PCS Connection.
Section 2: Understanding Your Device
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� Tap  to refresh the page.



� Tap  to go to the Home page.

� Tap  to go to your favorites folder.

� Tap  to hide pictures button.

Viewing mobile favorites:

1. Tap the Favorites button to display your list of favorites.

� Tap Add/Delete to add or delete a folder or favorite link.

2. Tap the page you want to view.

The version of the page that was downloaded the last time you 
synchronized will be displayed. If the page is not on your device, the 
favorite will be dimmed. Synchronize with your computer to download 
the page to your device, or connect to the Internet to view the page.

Browsing the Internet:

To connect and start browsing, do one of the following:

� Tap the Favorites button, and then tap the favorite you want to view.

� Tap View then Address Bar. Enter the destination Web address and 
tap . Tap the arrow to select from previously entered Websites.

Note: To add a favorite link, tap and hold on the page and tap 
Add to Favorites in the pop-up menu.
Section 2: Understanding Your Device
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Inbox: Sending and Receiving Email 
Messages

Use Inbox to send and receive email messages in either of these ways:
� Synchronize email messages with Microsoft® Exchange or Microsoft® 

Outlook® on your computer.

� Send and receive email messages by connecting directly to an email 
server through PCS Connection.

Synchronizing Email Messages

Email messages can be synchronized as part of the general 
synchronization process. You will need to enable Inbox synchronization 
in ActiveSync®. For information on enabling Inbox synchronization, see 
ActiveSync® Help on the computer.

During synchronization:
� Messages are copied from the mail folders of Exchange or Outlook® on 

your computer to the ActiveSync folder in Inbox on your device. By 
default, you will receive messages from the past five days only, the first 
100 lines of each message, and those not including file attachments.

� Email messages in the Outbox folder on your device are transferred to 
Exchange or Outlook®, and then sent from those programs.

� Email messages in subfolders must be selected in ActiveSync® on your 
computer in order to be transferred.

Connecting Directly to an Email Server

Your device can send and receive email messages by connecting to an 
email server. For more information about establishing this remote 
connection, see “Connecting Directly to an Email Server” on page 171.

Once connected to the email server:
� New messages are downloaded to the device Inbox folder.

�

Section 2: Understanding Your Device
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Messages in the device Outbox folder are sent.

� Deleted messages are removed from the device Inbox folder.



Messages received directly from an email server are linked to your email 
server rather than your computer. When a message is deleted from your 
device, it will also be deleted from the email server the next time you 
connect.

When working online connected to your server, you can immediately read 
and respond to messages – they are sent as soon as you tap Send, saving 
space on your device.

To work offline, download new message headers or partial messages and 
disconnect from the server. You can then mark which messages to 
completely download the next time you connect.

Using the Message List

Received messages are displayed in the message list – the most recently 
received are listed first.

� Tap Inbox to select the service and folder you want to display.

� Tap Received Date to select the sort order for messages.

� Tap on a message to open the message.

� Tap and hold to display a pop-up menu of actions.

� Tap  to connect to the selected service.

� Tap  to connect and to send and receive email.
Section 2: Understanding Your Device
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� When you receive a message, tap it to open it. Unread messages are 
displayed in bold.

� Tap ok to return to the message list.

� Tap  to delete this message.

� Tap  to reply to or forward this message.

� Tap  or  to view the previous or next message.

� To retrieve a full message during your next synchronization or email 
server connection, tap and hold the message. On the pop-up menu tap 
Mark for Download.

Specify downloading preferences when you set up the service or select 
your synchronization options.
� Inbox synchronization options can be changed using ActiveSync® 

options. See ActiveSync® Help for more information.

� To change options for email server connections, tap Tools then tap 
Options. On the Services tab, tap the service you want to change. 
To remove a service, tap and hold the service and select Delete.
Section 2: Understanding Your Device
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Composing Messages

1. Tap New.

2. In the To field, enter the email addresses of the recipients, separating 
the names with a semi-colon, or select a name from the contact list by 
tapping and holding To, or by tapping the Address Book button.

All email addresses entered in the email fields in Contacts appear in 
the Address Book.

� Tap  to show or hide the complete header.

� Tap  to show / hide the recording toolbar.

� Tap  to display the Address Book.

3. Compose your message. To enter preset or frequently used messages, 
tap My Text and select a message.

4. Tap Send when you’ve finished the message. If you are working 
offline, the message is moved to the Outbox folder and will be sent the 
next time you connect.

Managing Email Messages and Folders

Messages are displayed in one of five folders: Inbox, Deleted Items, Drafts, 
Outbox, and Sent Items. The Deleted Items folder contains messages that 
have been deleted on the device. The behavior of the Deleted and Sent 
Section 2: Understanding Your Device
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Items folders depends on the options you have chosen. In the message 
list, tap Tools then Options. On the Message tab, select your options.
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To create new folders, tap Tools then Manage Folders. For all service 
except ActiveSync®, you can access folder options by tapping Tools then 
Manage Folders. To move a message to another folder, tap and hold the 
message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an email server

The behavior of the folders you create depends on whether you are using 
ActiveSync®, POP3, or IMAP4:
� If you use ActiveSync®, email messages in the Inbox folder in Outlook® 

will automatically be synchronized with your device. You can select to 
synchronize additional folders by designating them for ActiveSync®.

The folders you create and the messages you move will then be 
mirrored on the server. For example, if you move two messages from 
the Inbox folder to a folder named Family, and you have designated 
Family for synchronization, the server creates a copy of the Family 
folder and copies the messages into that folder. You can then read the 
messages while away from your computer.

� If you use POP3 and you move email messages to a folder you created, 
the link is broken between the messages on the device and their copies 
on the mail server. The next time you connect, the mail server will see 
that the messages are missing from the device Inbox and delete them 
from the server. While this eliminates duplicate copies of messages, 
you will no longer have access to messages moved to folders created 
anywhere except the device.

� If you use IMAP4, the folders you create and the email messages you 
move are mirrored on the server. Therefore, messages are available to 
you anytime you connect to your mail server, whether it is from your 
device or computer.
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MSN® Messenger

MSN® Messenger on your mobile device is an instant messaging program 
that lets you:
� View a list of instant messaging contacts who are online.

� Send and receive instant messages.

� Have instant message conversations with groups of contacts.

To use MSN® Messenger, you must have a Microsoft Passport™ account 
or a Microsoft® Exchange email account. If you have a Hotmail® or 
MSN® account, you already have a Passport. Once you have obtained 
either a Microsoft Passport™ or a Microsoft® Exchange account, you are 
ready to set up your account.

Note: Sign up for a Microsoft Passport™ account at 
http://www.passport.com. Get a free Microsoft® Hotmail® email address 
at http://www.hotmail.com.

� To switch to MSN® Messenger, tap , Programs, then tap 
MSN Messenger.

Setting Up

Before you can connect, you must enter Passport or Exchange account 
information.

To set up an account and sign in:

1. In the Tools menu, tap Options.

2. On the Accounts tab, enter your Passport or Exchange account 
information.

3. Tap ok.

4. Tap the sign-in screen and tap Sign in.

Note: If you use MSN® Messenger on your computer, your contacts will 
automatically show up on your device.
Section 2: Understanding Your Device
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Working With Contacts

The MSN® Messenger window displays all your message contacts divided 
into Online and Not Online categories. While connected, tap and hold 
any contact and a pop-up menu appears allowing you to chat, send 
email, block the contact, or delete the contact.

Note: To see others online without being seen, in the Tools menu, tap 
My Status and select Appear Offline.

Note: If you block a contact, you will appear offline but will remain on the 
blocked contact’s list. To unblock a contact, tap and hold the contact, 
then tap Unblock on the pop-up menu.
Section 2: Understanding Your Device
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Chatting With Contacts

� Tap a contact name to open a chat window. Enter your message in the 
text entry area, or tap My Text to enter a preset message, and tap 
Send. 

� To invite another contact to a multi-user chat, in the Tools menu, tap 
Invite and tap the contact you wish to invite.

Note: To switch back to the main window without closing a chat, tap the 
Contacts button. To revert back to your chat window, tap Chats and 
select the person whom you were chatting with.

� To see if the contact you are chatting with is responding, look for the 
message under the text entry area.
Section 2: Understanding Your Device
1412I: Using Application Programs

For more information on using MSN® Messenger, tap  then Help.



14
Pocket Word

Pocket Word works with Microsoft®Word on your computer, providing 
easy access to copies of documents. You can also create new documents 
on your device or copy documents from your computer.

� To create a new file, tap , Programs, Pocket Word, and then New. 
Or, from the Today screen, tap New, then Word Document. Only one 
document can be opened at a time; when you open a second you will 
have to save the first. Documents can be saved in a variety of formats 
including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), 
and Plain Text (.txt).

Pocket Word contains a list of stored files. Tap a file to open it, and tap 
and hold to delete, make copies of, or send it from the pop-up menu.

� Tap Name to change the sort order of the list.

� Tap All Folders to select the type of folder you want displayed in 
the list.

� Tap New to create a new document.

� Tap on a document name to open the document.

� Tap and hold an item to see a pop-up menu of actions.

You can enter information in Pocket Word in one of four modes 
Section 2: Understanding Your Device
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Each mode has its own toolbar, which you can show and hide by tapping 
the Show/Hide Toolbar button on the command bar.

Tip: You can change the zoom magnification by tapping View and then 
Zoom. Then select the percentage you want. Select a higher percentage 
to enter text and a lower one to see more of your document.

Tip: If you’re opening a Word document created on a computer, select 
Wrap to Window on the View menu so that you can see the entire 
document.

Typing Mode

� Enter text using the input panel (see “Entering Text Using the Input 
Panel” on page 54 for more information).

� To format or edit text, highlight it by dragging the stylus over the text 
you wish to select. Use the Edit menu or toolbars for formatting 
changes.

� To search for text within a document, tap Edit and then 
Find/Replace.

� Tap  to change the formatting options.

� Tap  to show or hide the toolbar.
Section 2: Understanding Your Device
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Writing Mode

� In writing mode, use your stylus to write directly on the screen. Ruled 
lines are displayed as a guide, and the zoom magnification is greater 
than in typing mode to allow you to write more easily. For more 
information on writing and selecting writing, see “Entering Text Using 
the Input Panel” on page 54.

� Tap  to select the Pen tool.

� Tap  to select the Space tool. With Space tool selected, drag to insert 
a space. An arrow appears showing the space direction and size.

� Tap  to change the formatting options, such as pen weight, line/font 
color, and fill color.

Note: If you cross three ruled lines in a single stylus stroke, the writing 
becomes a drawing, and can be edited and manipulated as described in 
the following section.

Note: Written words are converted to graphics (metafiles) when a 
Pocket Word document is converted to a Word document on your 
computer.
Section 2: Understanding Your Device
4 2I: Using Application Programs



Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear 
as a guide. When you lift your stylus off the screen after the first stroke, 
you’ll see a drawing box indicating the boundaries of the drawing. Every 
subsequent stroke within or touching the drawing box becomes part of 
the drawing. For more information on drawing and selecting drawings, 
see “Entering Text Using the Input Panel” on page 54.

� Tap  to select formatting options, such as pen weight, line/font 
color, and fill color.

� Tap on the drawing to resize an object within the drawing. Drag the 
selection handles until it is the size you want.

� Tap and hold on the drawing to display pop-up menu. From the 
pop-up menu, select Shape to convert an object to the proper shape.

Recording Mode

In recording mode, you can embed a recording into your document. 
Recordings are saved as .wav files. For more information on recording, 
see “Entering Text Using the Input Panel” on page 54.

For more information on using Pocket Word, tap  and then Help.
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Pocket Excel

Pocket Excel works with Microsoft® Excel on your computer, providing 
easy access to copies of spreadsheets. You can also create new 
spreadsheets on your device or copy spreadsheets from your computer.

� To create a new file, tap , Programs, Pocket Excel, and then 
New. Or, from the Today screen, tap New, and then ExcelWorkbook. 
Only one spreadsheet can be opened at a time; when you open a 
second you will have to save the first. Spreadsheets can be saved in a 
variety of formats including Excel (.xls) and Pocket Excel (.pxl).

Pocket Excel contains a list of stored files. Tap a file to open it, and tap 
and hold to delete, make copies of, or send it from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools such as formulas, 
functions, sorting and filtering. To display toolbar, tap View and then 
Toolbar.

Note: If your spreadsheet contains sensitive information, you can 
protect it with a password. To do so, open the file, tap Edit, and then 
Password. Every time you open that file, you will need to enter the 
password.
Section 2: Understanding Your Device
6 2I: Using Application Programs



Tips for Working in Pocket Excel
� To view in full screen mode, tap View and then Full Screen. Tap 

Restore to exit mode.

� Tap View to select items you want to show or hide.

� To freeze panes, select the cell(s) you want to freeze, tap View and 
then Freeze Panes. Freeze the top and leftmost panes in a spreadsheet 
to keep row and column labels visible as you scroll through a sheet.

� To split panes to view different areas of a spreadsheet, tap View and 
then Split. Drag the split bar to the desired location. To remove, tap 
View and then Remove Split.

� To hide a row or column, select it and tap Format, Row or Column, 
then Hide. To show a hidden row or column tap Tools, and then Go 
To, then type a reference that is in the hidden row or column. Then tap 
Format, Row or Column, then Unhide.

For more information on using Pocket Excel, tap  and then Help.
Section 2: Understanding Your Device
1472I: Using Application Programs



14
Windows Media™ Player for Pocket PC

Use Microsoft® Windows Media™ Player for Pocket PC to play digital 
audio and video files that are stored on your device or on a network.

� To switch to Windows Media™ Player for Pocket PC, tap , then tap 
Windows Media.

Use Microsoft® Windows Media™ Player on your computer to copy 
digital audio and video files to your device. You can play Windows 
Media™ and MP3 files (this includes files with the extensions .asf, .wma, 
.wmv, and .mp3) on your device.

Windows Media™ player can be used even if the screen is turned off.

For more information about using Windows Media™ Player for Pocket 
PC, Tap , then tap Help.
Section 2: Understanding Your Device
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Microsoft® Reader

Microsoft® Reader enables you to read eBooks on your device. Using 
ActiveSync®, book files can be copied from your computer to your device.

Each book consists of a cover page, an optional table of contents, and the 
pages of the book. You can:
� Page through the book by using the cursor button on your device or by 

tapping the page number on each page.

� Annotate the book with highlighting, bookmarks, notes, and drawings.

� Search for text and look up definitions for words.

The Guidebook contains detailed information on using the software. To 
open, tap Help on the Reader command bar. From a book page, tap and 
hold the book title, then tap Help on the pop-up menu.

� To open Microsoft® Reader, tap , Programs then 
Microsoft Reader.

Getting Books on Your Device

Download book files from the Web by visiting your favorite eBook retailer 
and following the directions for downloading.

The Companion CD also includes sample books and a dictionary in the 
MSReader folder of the APPS folder.

The Read Me file in the EBOOKS folder of the MSReader folder provides 
directions for using ActiveSync® to download files from your computer.

Using the Library

The Library is your Reader home page. It displays a list of all books stored 
on your device or storage card.

To open the Library:

� On the Reader command bar, tap Library.

–or–
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� To open a book, tap its title in the Library list.

� Tap Sort to select a sort order.

� Tap Show to specify the books you want to display in the list.

Reading a Book

Each book consists of a cover page, an optional table of contents, and the 
pages of the book. Navigation options are listed in the bottom portion of 
the cover page.

The first time you open a book, you’ll probably want to go to the first 
page or to the table of contents, if there is one. Subsequently, whenever 
you open the book, you’ll be automatically taken to the last page read.

In addition to the text, each book page includes a page number and book 
title.
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� Tap on the title at the top of the page to select a navigation option.

� Tap on the arrows at the bottom of the page to turn the page. You can 
also tap and hold the page number to bring up the page riffle.

� Drag cursor over text to select that text and reveal the pop-up menu. 
Tap on the menu option for the action you want to perform.

You can also page through a book by using the cursor button on 
your device.

Using Reader Features

Reading an eBook gives you several options not available with 
paper books.

� Select text by dragging stylus across it and follow options outlined 
below:

� Search for Text: Find text by tapping Find on the pop-up menu. Enter 
your search word and tap the desired Find option. Results are 
highlighted on the page. Tap outside the box to close Find. To return to 
your original page, tap the title then Return on the pop-up menu.

� Copy Text: You can copy text from books into any program that accepts 
text. Select the text you want to copy, then tap Copy Text on the 
pop-up menu. Paste it into the program of your choice.

� Bookmarks: When Add Bookmark is selected from the pop-up menu, 
a color-coded bookmark appears in the right margin. Multiple 
bookmarks can be added, and they can be accessed from anywhere in 
the book by tapping the bookmark icon.

� Highlights: When text is highlighted, it appears with a colored 
background.

� Notes: Enter text in the note that appears on top of the page. To show 
or hide the note, tap the Note icon displayed in the left margin.

� Drawing: When you add a drawing, a Drawing icon appears in the 
top-right corner of the page along with tools on the bottom of the 
Section 2: Understanding Your Device
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� Tap Go to then Annotations on the book’s cover page to see a list of 
the book’s annotations, including bookmarks, highlights, text notes, 
and drawings. Tapping an entry takes you to the annotated page.

Removing a Book

� When you finish reading a book, it can be deleted (to conserve space) 
by tapping and holding the title in the Library list, and then tapping 
Delete on the pop-up menu.
Section 2: Understanding Your Device
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Camera

This application allows you to take photographs using the built-in 
camera. Photographs are saved in the JPEG format. You can adjust 
parameters such as white balance, brightness, and zoom.

� To switch to Camera, tap , Programs, Camera. Or, from the Today 
Screen, tap , Camera.

� Tap the shutter button to take a photograph. Saved photographs are 
assigned serial numbers and saved in My Documents/Review_Share.

Tip: You can also take a photograph by tapping a space key or pressing 
the jog wheel.

� To view saved photographs, tap the Review/Share start icon to start 
Review/Share.

� Selectable photograph sizes (in pixels) and zoom ratios
High (640 × 480): × 1
Middle (320 × 240): × 1, × 2
Low (160 × 120): ×1, ×2, ×4 

Tap Review to start Review/Share 
and view photographed images.

Shutter

Photograph Size: 
To change the 
photograph size, 
tap here and 
then select from 
the size menu. 

White Balance: 
To change the 
white balance 
mode, tap here and 
then select from 
the mode menu.

Image Brightness
Adjustment

Camera Image

Zoom
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� Quality
Fine (JPEG compaction ratio: 100%) and Normal (75%) are selectable 
for quality.

� White balance
The following five modes are selectable for white balance:
AUTO, SUNNY, CLOUDY, FLUORESCENT, and TUNGSTEN

Tip: To change quality, tap the Options menu, then select Quality.
Section 2: Understanding Your Device
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Review/Share

This function allows you to view JPEG images such as those 
photographed by the camera or downloaded through the Internet. It also 
permits you to edit images.

Note: Images beyond UXGA cannot be displayed because the memory 
capacity is exceeded; and the progressive JPEG is not supported.

� To switch to Review/Share, tap , Programs, Review/Share. Or, 
from the Today Screen, tap , Review/Share. 

Review/Share presents the Thumbnail View and Expand View screens. 

Thumbnail View

The Thumbnail screen can display 9 images at a time.

� To enlarge a desired image when in the Thumbnail View mode, tap the 
image to switch to the Expand View mode.

Tip: To select the Expand View mode, you can also select Expand picture 
from the Options menu or press the jog wheel or the Enter key.

Name of the currently displayed folder

Currently selected image number/ 
total number of images in the folder

Selection Icon: 
Indicates the currently selected image.

Next page button

Camera Start Icon: 
For details, see “Camera” (page 153).
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Expand View

� To switch to the Thumbnail View mode, select Thumbnail pictures 
from the Options menu. You can also press the jog wheel or the Enter 
key instead.

Share Menu

You can share pictures to your family and friends, etc via online server. 

� To share pictures, use “Local Contacts” or “Online Phone Book.”

Options Menu

The Options menu provides the following functions.
� Upload: Uploads pictures to picture server via “Online Pictures” 

application.

� Copy/Move: Copies, moves, or deletes image files.

� Delete: Deletes image files.

� Attach to Contact: Attaches a specified image to a person selected 
from the contact list.

� Beam Picture: Sends an image specified with Beam (IrDA) to another 
device.

� Add Voice Memo: Attaches a voice memo to a specified image.
Section 2: Understanding Your Device
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� Edit Caption: Attaches a caption to a specified image.

� Picture Info: Shows information about a specified image.



� Customize Picture: Allows editing (contrast/ reduce/ rotate/ color) of 
a specified image.

� Folder list: Changes a folder to be displayed.

� Expand picture: Switches to the Expand View mode.

� Thumbnail pictures: Switches to the Thumbnail View mode.

View Menu

The Tools menu provides the following functions.
� Color Mode: Allows you to select the color from “Normal,” “Black & 

White,” “Sepia", and “Negative.”

� Slide Show: Starts slide show when Start is selected. To quit slide 
show, tap the screen. Selecting Setting allows you to change the slide 
show settings.

� About: Shows the application version information.

Online Pictures

This function allows you to share pictures uploaded to the Picture MailSM 
Website and/or manage pictures and albums (folders).

� To switch to Online Pictures from the Today Screen, tap , 
Online Pictures.

Tip: When connecting to the Picture MailSM Website for the first time, the 
Enter Password screen appears and prompts you to enter a 4 to 8 
characters or digits password for your Picture Mail account. You can use 
this password to manage your Picture Mail with your PC at 
www.picturemail.sprintpcs.com.

The Online Pictures screen presents two display modes: Thumbnail View 
and Expand View.

Thumbnail View

The Thumbnail screen can display 9 images at a time.
Section 2: Understanding Your Device
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� To enlarge a desired image when in the Thumbnail View mode, select 
Expand picture from the Options menu or press the jog wheel or the 
Enter key.

Expand View

� To switch to the Thumbnail View mode, select Thumbnail pictures 
from the Options menu. You can also press the jog wheel or the Enter 

Name of the currently displayed album (folder)

Currently selected image number/ 
total number of images in the folder

Selection Icon: 
Indicates the currently selected image.

Next page button

Share Menu: For details, see “Share Menu” (page 159).
Options Menu: For details, see “Options Menu” (page 159).
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Share Menu

You can share pictures to your family and friends, etc., via the online 
server.

� To share pictures, use “Local Contacts” or “Online Phone Book.”

Options Menu

The Options menu provides the following functions.
� Copy/Move: Copies or moves image files.

� Save To Review/Share: Stores image files under the Device’s Review/
Share folder.

� Delete: Deletes image files.

� Edit Caption: Attaches a caption to a specified image.

� Picture Info: Shows information about a specified image.

� Rotate Picture: Rotates a specified image.

� Create Album: Creates a new album (folder).

� Album List: Allows you to change an album (folder) to be displayed.

� Expand picture: Switches to the Expand View mode.

� Thumbnail pictures: Switches to the Thumbnail View mode.
Section 2: Understanding Your Device
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ClearVue

This program enables the device to display Microsoft Word, Excel, and 
PowerPoint files, and Adobe Portable Document Format (PDF) files 
generated using a personal computer. It is also compatible with a 
PowerPoint slide show. 

Viewing a File

1. To switch to ClearVue, tap , Programs, ClearVueDocument/
ClearVueWorkSheet/ClearVuePresentation/ClearVuePDF (select 
a program corresponding to a file to be displayed).

2. Tap File, then Open. Select a file to be displayed.

3. The content of the file is displayed.

Note: To open a file attached to mail in the Inbox, tap the file. You can 
also start ClearVue and display a file by tapping a file on File Explorer.
Section 2: Understanding Your Device
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Viewable files

The viewable file formats are as below:
� Microsoft Word files: Word97/98/2000/2002 (.doc)

� Microsoft Excel files: Excel97/2000/2002 (.xls)

� Microsoft PowerPoint files: PowerPoint97/2000/2002 (.ppt)

� Adobe Portable Document Format files (.pdf)

Note: You cannot view a password protected file.

Note: Some files do not allow included objects such as drawings and 
graphs to be displayed.

Note: If any fonts specified in the document cannot be displayed, 
substitute fonts are used.

Note: Some files may present layout distortion.

Note: When opening a large file, quit other applications before starting 
ClearVue.
Section 2: Understanding Your Device
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World Clock

The current time of four large cities in the world is displayed. The world 
map roughly shows which regions are currently at daytime or at night.

� To switch to World Clock, tap , Programs, World Clock.

Changing Cities

1. Tap Setting, then City.

2. Tap a city from list, then tap Delete.

3. Tap Create.

4. Tap City to display, then tap ok.

5. Select Time format, then tap ok.

6. Tap ok.

Note: You can program time with Setting → System → Clock.
Section 2: Understanding Your Device
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SaiSuke

SaiSuke allows schedule and task lists to be managed. It synchronizes 
Pocket Outlook’s calendar, tasks, and data. In order to use SaiSuke, 
install the application program from the supplied Companion CD.

For the method of installing from the Companion CD, see “Installing 
Application Programs from the Companion CD” on page 164.

� To access, tap , Programs, SaiSuke.

� Tap , , , ,  or  to select from six views (Day, Week, Month, 
Year, Agenda, and Tasks).

Creating an Appointment

1. Tap Item, New, then Appointment.

2. Enter Subject and Location, then select Time.

3. Select other settings as necessary.

4. Tap ok.

Creating a Task

1. Tap Item, New, then Tasks.

2. Enter Subject and select priority.
Section 2: Understanding Your Device
1632I: Using Application Programs

3. Select other settings as necessary.

4. Tap ok.



16
Installing Application Programs from the 
Companion CD

The supplied Companion CD contains several application programs. In 
order to use these programs, install them onto the device using the 
following procedure:

1. Connect the device to a personal computer.

� For details, see “Connecting with a Personal Computer” on page 173.

2. Insert the Companion CD into the CD-ROM drive.

� The main menu screen appears.

3. Select Enhance Your Pocket PC, select an index name shown at the left 
of the screen, and then click Install for the application program to be 
installed.

� Follow the on-screen instructions to install the program.

Note: When you have installed such an application program that always 
results in entire top screen display, a popup menu may not appear or a 
ringer may not be generated.
Operations with application programs other than the supplied ones shall 
not be assured.
Section 2: Understanding Your Device
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Section 2J

Getting Connected

In This Section

� Sending Files Using Infrared Rays
� Connecting to the Internet Using PCS Connection
� Restoring the PCS Vision Connection
� Disconnecting from the Internet Using PCS Connection
� Connecting to the PCS e-Mail Server
� Connecting Directly to an Email Server
� Get Help on Connecting

his section describes how to use infrared (IR) to exchange information 
with other mobile devices, how to connect to and disconnect from the 

Internet using PCS Connection, and how to directly connect to an 
email server.

T

Section 2: Understanding Your Device
1652J: Getting Connected



16
Your device can exchange information with other mobile devices as well 
as your computer, a network, or the Internet. The connection options 
include the following:
� The device’s infrared (IR) port can send files to and receive files from 

another device. See “Sending Files Using Infrared Rays” below for 
more information.

� When connected to the Internet via PCS Connection, you can send and 
receive email by using Inbox and view Web and WAP pages using 
Pocket Internet Explorer.

� Remotely connect to your computer to synchronize information such 
as Pocket Outlook®. See ActiveSync® Help on your computer or 
Connection Help on your device for more information.

Sending Files Using Infrared Rays

This device allows data communications using infrared rays with a 
device (such as a pocket PC) having an infrared ray port.

Sending and Receiving Data

1. Position this device and the other device so that their respective 
infrared ray ports face each other.

Note: The two ports should be close together, and no obstacle should 
exist between the ports. For details, see “Using the Infrared 
Communications Port” on page 33.

2. On File Explorer on the sending device, tap and hold a file or item to 
be sent. A pop-up menu appears.

3. Tap Beam File... on the pop-up menu. “Receiving Data” appears on 
the receiving device.

4. On the receiving device, tap Yes. The data transfer is executed.

Note: In addition to using File Explorer, you can also select Beam File... 
from the pop-up menu using the program list screen.
Section 2: Understanding Your Device
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Connecting to the Internet Using 
PCS Connection

For the applications installed on the device, automatic connections can 
be performed. (If connections fail, see “Restoring the PCS Vision 
Connection” on page 168 and restore the connection settings.) 

Note: Before connecting, you activate the phone and perform 
provisioning. For more information, see page 46.

In order to perform manual connections, perform the following 
operations:

1. Tap , then Settings. On the Connections tab, tap Connections.

2. Tap  at the right end of Internet Connection, and then select 
PCS Vision from the displayed list.
Section 2: Understanding Your Device
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3. Tap Connect under PCS Vision.

After the Connecting bubble window is displayed, connection to the 
Internet is executed.

� The  icon appears during an Internet connection.

Tip: Applications that need to connect to the Internet, such as Pocket 
Internet Explorer, automatically connect to the Internet as necessary. 
When an Internet connection is started, the Connecting bubble window 
appears. On the navigation bar, the  icon appears during an Internet 
connection.

Note: The setting becomes effective after resetting is executed.

Restoring the PCS Vision Connection

If you have altered or deleted the PCS Vision Connection, you can restore 
it using the following procedure:

Tap  , then Settings. On the Connections tab, tap 
PCS Vision Recovery.
� For the subsequent steps, follow the on-screen instructions.
Section 2: Understanding Your Device
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Disconnecting from the Internet Using 
PCS Connection

1. Tap the  icon on the navigation bar.

2. Tap End on the Connecting bubble window.

� The  icon disappears and disconnection from the Internet is 
executed.

Connecting to the PCS e-Mail Server

Making PCS e-Mail Setting

1. Tap  , then Settings. On the Connections tab, tap 
PCS Mail Setting.

2. With a confirmation message displayed, tap Yes.

Note: The power of the Phone needs to be kept on.

Connecting to the PCS e-Mail Server

1. Tap  , then Inbox.
Section 2: Understanding Your Device
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2. Tap Services menu, confirm that the box beside PCS Mail has been 
checked, and then tap Connect.

3. With a password confirmation screen displayed, enter a Mail Password, 
and then tap ok.

Note: You need to set a Mail Password in advance by logging in the 
Sprint PCS’s website.

4. The PCS e-Mail server is connected and mail transfer is performed.

Tip: For more information on using the Inbox program, see “Inbox: 
Sending and Receiving Email Messages” on page 134“.
Section 2: Understanding Your Device
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Connecting Directly to an Email Server

You can set up a connection to an email server so that you can send and 
receive email messages by using a modem and Inbox on your device.

Note: The ISP or network must use a POP3 or IMAP4 email server and an 
SMTP server. You can use multiple email services to receive messages. 
For each email address you intend to use, set up and name the email 
service following the directions below.

To set up an email service:

� In Inbox on your device, tap Services, then New Service. Follow the 
directions in the New Service wizard.

For an explanation of a screen, tap  then Help. When finished, to 
connect to your email server, tap Services then Connect. For more 
information on using the Inbox program, see “Inbox: Sending and 
Receiving Email Messages” on page 134.
Section 2: Understanding Your Device
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Get Help on Connecting

Additional help and information can be found in the following locations:
� “Inbox: Sending and Receiving Email Messages” on page 134.

� Online Help on the device. Tap  then Help. Tap View, 
All Installed Help, then Inbox or Connections.

� ActiveSync® Help on the computer. In ActiveSync®, click 
Microsoft ActiveSync Help on the Help menu.

� For troubleshooting information, see the Pocket PC Website at:
http://www.microsoft.com/mobile/pocketpc.
Section 2: Understanding Your Device
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Section 2K

Connecting with a Personal 
Computer

In This Section

� Using Microsoft® ActiveSync®

his section describes the procedures for using Microsoft® ActiveSync®. 
This application allows Microsoft Outlook® data on a connected 

personal computer to be synchronized with the data on the device.

T
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Using Microsoft® ActiveSync®

Using Microsoft® ActiveSync®, you can synchronize the information on 
your computer with the information on your device. Synchronization 
compares the data on your device with your computer and updates both 
computers with the most recent information. For example:
� Keep Pocket Outlook® data up-to-date by synchronizing your device 

with Microsoft® Outlook® data on your computer. 

� Synchronize Microsoft® Word and Microsoft® Excel files between your 
device and computer. Your files are automatically converted to the 
correct format. 

Note: Use ActiveSync options to turn synchronization on and off for 
specific information types.

With ActiveSync, you can also:
� Back up and restore your device data. 

� Copy (rather than synchronize) files between your device and 
computer. 

� Control when synchronization occurs by selecting a synchronization 
mode. For example, you can synchronize continually while connected 
to your computer or only when you choose the synchronize command.

� Select which information types are synchronized and control how 
much data is synchronized. For example, you can choose how many 
weeks of past appointments you want synchronized.

Before you begin synchronization, install ActiveSync® on your computer 
from the Companion CD. ActiveSync® is already installed on your device.
Section 2: Understanding Your Device
4 2K: Connecting with a Personal Computer



Installing ActiveSync on a Personal Computer

Note: ActiveSync can run under the following environments.

Minimum Desktop Computer Requirements
• Microsoft Windows XP, Windows 2000, Windows Millennium Edition, or 

Windows 98 Second Edition
• Microsoft Outlook 98 or later required for synchronization to the desktop 

or portable computer of email, calendar, contacts, tasks, and notes. 
(Outlook 2002 recommended)

• Microsoft Internet Explorer 4.01 SP1 or later
• Hard-disk drive with 12 to 65 MB of available hard-disk space (actual 

requirements will vary based on selection of features and user’s current 
system configuration)

• USB port
• One CD-ROM drive
• VGA graphics card or compatible video graphics adapter at 256 color or 

later 
• Keyboard
• Microsoft Mouse or compatible input device

1. Insert the Companion CD into the CD-ROM drive. A setup window 
appears.

2. Click Start Here.

3. To install ActiveSync®, click Install ActiveSync 3.7, and then follow 
the subsequent on-screen instructions.

Note: When the File Download screen displays, select 
Run this program from its current location and click OK. Or when the 
message, “Would you like to open the file or save it to your computer?” 
displays on Windows XP, click Open. 

Note: When the Security Warning screen displays, click Yes.

� When the installation is completed, the Get Connected window 
appears.

ActiveSync installation has been completed.
Section 2: Understanding Your Device
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Connecting With a Personal Computer

1. Confirm that the Get Connected window is displayed on the personal 
computer.

Note: If Get Connected window is not displayed, double-click the 
Microsoft ActiveSync icon on the desktop to start ActiveSync.

2. Connect the USB cradle to the USB port on the personal computer. For 
details, see “Using the USB Port” on page 32.

Note: Do not mount the device onto the cradle yet. Connect the AC 
adapter to the USB cradle and plug the adapter into a wall outlet.

3. Mount the device onto the USB cradle. For details, see “Using the USB 
Port” on page 32.

� The connection between the device and the personal computer is 
established.

Note: When the device is detected and the “Add New Hardware 
Wizard” screen displays, follow the screen to install the driver. The driver 
exists on the Companion CD root directory. When required, specify the 
drive into which the Companion CD is inserted.

4. The Set Up a Partnership screen appears. Follow the instructions on 
the screen to finish setup.

Note: If the connection between the phone and the computer is lost, 
briefly remove the phone from the cradle then replace it.

Note: For more information on the connection to your device or other 
settings, please see the Help option in ActiveSync®.

After your first synchronization, take a look at Calendar, Contacts, and 
Tasks on your device. You’ll notice that information you’ve stored in 
Microsoft Outlook on your computer has been copied to your device, and 
you didn’t have to type a word. Disconnect your device from your 
Section 2: Understanding Your Device
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Once you have set up ActiveSync and completed the first synchronization 
process, you can initiate synchronization from your device. To switch to 
ActiveSync on your device, tap , and then tap ActiveSync. 

For information about using ActiveSync on your computer, start 
ActiveSync on your computer, and then see ActiveSync Help.

For more information about ActiveSync on your device, switch to 
ActiveSync, tap , and then tap Help.

Tap to synchronize via IR or
to change synchronization settings.

Tap to stop synchronization.
Tap to connect and synchronize.
View connection status.

View synchronization status.
Section 2: Understanding Your Device
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Section 2L

Backing Up Data

In This Section

� Backing Up Data Using a Personal Computer

� Backing Up Data Using a Memory Card

iles stored on storage memory and mail data in the Inbox will be lost if 
the built-in battery becomes empty. You therefore should regularly back 

up important data using a personal computer or a memory card.

F
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Backing Up Data Using a Personal Computer

Backup Procedure

Use the following procedure to back up data using a personal computer. 
Note that the dates, time, and passwords will not be backed up.

1. Connect the device to a personal computer. For the connection 
method, see “Using the USB Port” on page 32.

2. Start Microsoft ActiveSync on the personal computer. Then select 
Backup/Restore under the Tools menu.

3. Select Full backup.

Note: Select Incremental backup at the time of the second and 
subsequent backups. If you want backup to be automatically performed 
when the device is connected to the personal computer, select 
Automatically backup each time the device connects.

4. If you want to change the folder for backing up, click Change.

Note: A backup file is generated on the personal computer. Because this 
file needs to be specified at the time of restoration, be careful to note its 
location.

5. Click Back Up Now.

6. Click OK.

Note: Do not operate the device until the backup is completed.

Tip: To conserve battery strength, it is recommended to use the AC 
adapter when executing data backup.

Restoration Procedure

Before performing restoration, quit all open applications.

1. Initialize the device. For the initialization method, see “Initialization” 
on page 26.
Section 2: Understanding Your Device
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2. Connect the device to the personal computer. For the connection 
method, see “Using the USB Port” on page 32.



3. Start Microsoft ActiveSync on the personal computer. Then select 
Backup/Restore under the Tools menu.

4. Select the Restore tab.

5. Click Restore Now.

6. Follow the on-screen instructions to select an appropriate 
corresponding file (partnership file). 

7. Click Restore.

� The restoration progress status is indicated. Do not operate the device 
until the restoration is completed.

8. When a restoration finish message appears, click OK to reset the 
device. For the resetting method, see “Resetting” on page 25.

Note: Do not operate the device until the restoration is completed.

Tip: To conserve battery strength, it is recommended to use the AC 
adapter when executing data restoration.
Section 2: Understanding Your Device
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Backing Up Data Using a Memory Card

Backup Procedure

Use the following procedure to back up data using a memory card. Note 
that the dates, time, passwords, calibration data, and partnership data 
with a personal computer will not be backed up.

1. Quit all applications, and then insert a memory card into the device. 
See “Using SD Card / MultiMediaCard” on page 34 for details.

2. Tap , Programs, and Data Backup.

3. Select Backup, then tap Next.

4. Select a folder for backing up, then tap Start.

� You may tap Browse... to select a folder from a list.
Section 2: Understanding Your Device
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Note: When backing up data using the same medium again, specify the 
same folder name. If you select a folder not generated for backing up, all 
data in the folder will be lost.

Note: If you check the box for Use Password, backed up data cannot be 
restored unless a correct password is entered. A password can be 
composed of 1 to 8 digits. You can enter A to Z, a to z, and 0 to 9.

5. After a confirmation message appears, tap Yes to start data backup.

Note: Do not operate the device until backup is completed.

Tip: To conserve battery strength, it is recommended to use the AC 
adapter when executing data backup.

Note: Use a memory card that has about twice as much capacity as the 
in-use area size of the data storage area.

Restoration Procedure

1. Initialize the device. For the initialization method, see “Initialization” 
on page 26.

2. Insert a memory card containing backup data into the device, and 
then switch the device on. 

3. Tap , Programs, and Data Backup.

4. Select Restore, then tap Next.
Section 2: Understanding Your Device
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5. Select a folder containing backed up data, then tap Start.

� You may tap Browse... to select a folder from a list.

6. After a confirmation message appears, tap Yes.

� If a password has been programmed, enter a correct password.

Note: Do not operate the device until the restoration is completed.

Tip: To conserve battery strength, it is recommended to use the AC 
adapter when executing data restoration.

7. After a restoration finish message appears, reset the device. For the 
resetting method, see “Resetting” on page 25.

Note: When using ActiveSync after restoration using a memory card, 
make sure to select Delete Partnership under the File menu on the PC. 
Connecting a computer to the restored device causes New Partnership 
dialog box to appear. Set a new relationship in this box.
Section 2: Understanding Your Device
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Section 3A

PCS Service Features: 
The Basics

In This Section

� Using Voicemail
� Using Caller ID
� Responding to Call Waiting
� Three-Way Calling
� Using Call Forwarding

ow that you’ve mastered your phone’s fundamentals, it’s time to explore 
the calling features that enhance your PCS Service.N
Section 3: Using PCS Service Features
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Using Voicemail

Setting Up Your Voicemail

All unanswered calls to your PCS Phone are automatically transferred to 
voicemail, even if your phone is in use or turned off. Therefore, you will 
want to set up your PCS Voicemail and personal greeting as soon as your 
phone is activated.

To set up voicemail:

1. Make sure the phone is on. See “Turning the Phone ON and OFF” on 
page 72 for details.

2. If the dialer screen is not displayed, activate the dialer screen by 
pressing T on the device.

3. Tap and hold 1.

4. Follow the system prompts to create your pass code, record your 
greeting, record your name announcement and choose whether to 
activate One-Touch Message Access (a feature that lets you tap one key 
to access messages and bypasses the need for you to enter your 
pass code).

Note: The voicemail setup process may vary in certain Affiliate areas.

Voicemail Notification

There are several ways your PCS Phone alerts you to new voicemail 
messages:
� By displaying a message on the screen

� By playing the assigned ringer type

� By flashing LED

� By displaying  at the top of display screen
Section 3: Using PCS Service Features
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New Voicemail Message Alerts

� When you receive a new voicemail message, your device alerts you and 
prompts you to call your voicemail. To call your voicemail, tap 
Voice Mail.

Important: When you are roaming off the Sprint Nationwide 
PCS Network, you may not receive notification of new voicemail 
messages. It is recommended that you periodically check your voicemail 
by dialing 1 + area code + your PCS Phone number. When your voicemail 
answers, tap S and enter your pass code. You will be charged 
roaming rates when accessing voicemail while roaming off the Sprint 
Nationwide PCS Network.

Note: Your device accepts messages even when it is turned off. 
However, you are only notified of new messages when your phone is 
turned on and you are in a PCS Service Area.

Retrieving Your Voicemail Messages

You can review your messages directly from your PCS Phone or from any 
other touch-tone phone. To dial from your PCS Phone, you can either 
speed dial your voicemail or use the Menu keys.

Using One-Touch Message Access

� Tap and hold 1. Follow the system prompts.

Using the Menu on Your PCS Phone to Access Your Messages

� Tap Tools, then Voice Mail.

Tip: You are charged for airtime minutes when you are accessing your 
voicemail from your PCS Phone.

Using a Phone Other Than Your PCS Phone to Access Your 
Messages

1. Dial your PCS Phone number.
Section 3: Using PCS Service Features
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Voicemail Options

Your PCS Phone offers several options for organizing and accessing your 
voicemail.

Setting Up Group Distribution Lists

Create up to 20 separate group lists, each with up to 20 customers.

1. Tap and hold 1 to access your voicemail.

2. Following the system prompts, tap 3 to change your Personal 
Options.

3. Tap 2 for Administrative Options.

4. Tap 5 for Group Distribution Lists.

5. Follow the voice prompts to create, edit, rename or delete group lists.

PCS Callback

Return a call after listening to a message without disconnecting from 
voicemail.

1. After listening to a message, tap 8.

2. Follow the voice prompts to enter the phone number.

3. Once the call is complete, you’re returned to the voicemail main 
menu.

Voicemail-to-Voicemail Message

Record and send a voice message to other PCS Voicemail customers.

1. From the main voicemail menu, tap 2 to send a message.

2. Follow the voice prompts to enter the phone number.

3. Follow the voice prompts to record and send your voice message.

Voicemail-to-Voicemail Message Reply

Reply to a voice message received from any other PCS Voicemail 
customer.
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1. After listening to a voice message, tap 2.

2. Follow the voice prompts to record and send your reply.



Voicemail-to-Voicemail Message Forwarding

Forward a voice message, except those marked “Private,” to other 
PCS Voicemail customers.

1. After listening to a message, tap 6.

2. Follow the voice prompts to enter the phone number.

3. Follow the voice prompts to record your introduction and forward the 
voice message.

Voicemail-to-Voicemail Receipt Request

Receive confirmation that your voice message has been listened to when 
you send, forward, or reply to a message to other PCS customers.

1. After you have recorded a message, tap 1 to indicate you are 
satisfied with the message you recorded.

2. Tap 4 to mark receipt requested.

3. Tap 1 to send your voicemail message.

Continue Recording

� Before tapping 1 to indicate you are satisfied with the message 
you recorded, tap 4 to continue recording.

Extended Absence Greeting

When your phone is turned off or you are off the Sprint Nationwide 
PCS Network for an extended period, this greeting can be played instead 
of your normal personal greeting.

1. From the main voicemail menu, tap 3 for Personal Options.

2. Tap 3 for Greetings.

3. Tap 3 to record an Extended Absence Greeting.
Section 3: Using PCS Service Features
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Using Caller ID

Caller ID lets you know who’s calling by displaying the number of the 
person calling when your device rings. Similarly, if you call someone who 
has this feature, your phone number displays on their phone. If the 
caller’s name and number are already stored in your Internal Phone 
Book, the corresponding name appears with the number.

To block your phone number from being displayed for a specific 
outgoing call:

1. Tap S 6 7.

2. Enter the number you want to call.

3. Tap T.

To permanently block your number, call PCS Customer Solutions.

Responding to Call Waiting

When you’re on the phone and another call is received, the screen 
displays an incoming bubble message.

� Press T or tap Answer.

This step puts the first caller on hold and answers the second call.

To switch back to the first caller:

� Tap T again.

Tip: For those calls where you don’t want to be interrupted, you can 
temporarily disable Call Waiting by tapping before placing your call. 
Call Waiting is automatically reactivated once you end the call.
Section 3: Using PCS Service Features
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Three-Way Calling

With Three-Way Calling, you can talk to two people at the same time. 
When using this feature, the normal airtime rates will be charged for 
each of the two calls.

1. Enter a number you wish to call and tap T.

2. Once you have established the connection, tap T to put the first 
caller on hold.

3. Dial the second number you wish to call.

� You can also select a phone number from your Internal Phone Book or 
Call History.

4. Tap T.

5. When you’re connected to the second party, tap T once more to 
begin your three-way call.

If one of the people you called hangs up during your call, you and the 
remaining caller stay connected. If you initiated the call and are the first 
to hang up, all three callers are disconnected.

Note: Call Waiting and Three-Way Calling are not available while 
roaming off the Sprint Nationwide PCS Network.
Section 3: Using PCS Service Features
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Using Call Forwarding

Call Forwarding lets you forward all your incoming calls to another 
phone number – even when your phone is turned off. You can continue 
to make calls from your phone with Call Forwarding activated.

To Activate Call Forwarding:

1. Tap S 7 2.

2. Enter the area code and phone number to which your future calls 
should be forwarded.

3. Tap T. You will hear a tone to confirm the activation of Call 
Forwarding.

To Deactivate Call Forwarding:

1. Tap S 7 2 0.

2. Tap T. You will hear a tone to confirm the deactivation.

Note: You are charged a higher rate for calls you have forwarded.
Section 3: Using PCS Service Features
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Section 3B

PCS VisionSM

In This Section

� PCS Business ConnectionSM Personal Edition
� Web
� Picture MailSM

� Messaging
� PCS Vision FAQs

CS VisionSM brings you clarity you can see and hear, with enhanced, 
always-on mobile multimedia capabilities like email and pictures that 

are easy to learn and use. This rich, colorful graphic experience is visually 
comparable to your home or office computer. It’s a revolutionary way to 
look at wireless.

P
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PCS Business ConnectionSM 
Personal Edition

PCS Business ConnectionSM Personal Edition is designed to offer secure 
wireless access to both Microsoft Outlook and Lotus Notes.

PCS Business Connection Personal Edition delivers the following 
features:
� Business email access: Read, reply to, forward, delete, and compose 

your company email.

� Company directory and contacts: Search, view, call, and email 
contacts from your company’s directory. Do all this and add/edit your 
personal contacts.

� Work calendar: Accept and reject meeting and, view daily summaries 
and details, and navigate to various dates.

� Files/information on your PC: Browse folders and download and view 
documents from any device using a PC browser or Pocket Internet 
Explorer.

To use PCS Business Connection Personal Edition, install Business 
Connection Personal Edition software on your work PC. This allows data 
to be securely retrieved in real-time by your wireless device when 
connected to the Sprint Nationwide PCS Network. There is a monthly 
charge for PCS Business Connection, and usage charges will also apply.

When your work PC isn’t on, you can share connections with your 
co-workers so that you always have access to your email, calendar, and 
contacts. Your data remains secure behind the corporate firewall and, 
any changes you make on your wireless device are instantly updated on 
your corporate server without the need to synchronize.

Additional Business Connection solutions are available to your company. 
For more details, visit businessconnection.sprintpcs.com.
Section 3: Using PCS Service Features
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Web

Experience full-color graphic versions of popular Websites.

Browsing the Web

For details of the application for browsing the Web, see the following:
� Pocket Internet Explorer (page 130) – Use Microsoft Pocket Internet 

Explorer to view Web or WAP pages.

Picture MailSM

Take digital pictures with a built-in camera and send them to computers 
or other PCS Vision Phones.

Taking Pictures

1. Tap  and then Camera from the Today Screen to activate 
Camera.

2. Using the main LCD as a viewfinder, aim the camera at your subject.

3. Tap the shutter button in the screen to take the picture. The picture 
you take will be saved automatically.

4. To take another picture, tap the shutter button.

Viewing Pictures

1. To view saved pictures, tap Review in Camera. You can also access 
Review/Share from  on the Today Screen.

2. You will see the pictures you have saved.
Section 3: Using PCS Service Features
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Uploading Pictures to the Picture MailSM Website

1. Using Review/Share, specify a picture to be uploaded, and then in the 
Options menu, tap Upload then Upload this picture.

2. The Picture MailSM Website is connected and uploading of the image is 
started.
The following screen appears when uploading is completed.

Tip: When connecting to the Picture MailSM Website for the first time, the 
Enter Password screen appears and prompts you to enter a 4 to 8 
characters or digits password for your Picture Mail account. You can use 
this password to manage your Picture Mail with your PC at 
www.picturemail.sprintpcs.com.
Section 3: Using PCS Service Features
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Sharing Pictures

1. Using Review/Share, specify a picture to be shared, and then in the 
Share menu, tap Local Contacts.

Tip: To use the Online Phone Book on the Picture MailSM Website, tap 
Online Phone Book in the Share menu.

2. In the contact list, check for the recipient with whom the picture is to 
be shared, and then tap Next.

Tip: To share with a recipient not registered, tap New Entry, and register 
in the contact list, and then perform checking.
Section 3: Using PCS Service Features
1993B: PCS Vision

3. On the Enter Message screen, register text and voice messages for the 
recipient, and then tap Next.

4. Check the content on the Preview screen, and then tap Send.
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5. The Picture MailSM Website is connected and the Picture Share 
processing is started. 
The following screen appears when the Picture Share processing is 
completed.

Tip: When the Picture Share processing is completed, the recipient is 
informed through SMS or email.

For details of the Picture MailSM application, see the following:
� Camera (page 153) – This application allows you to take photographs 

using the built-in camera. Taken photographs are saved in the JPEG 
format. You can adjust parameters such as white balance, brightness, 
and zoom.

� Review/Share (page 155) – This application can display JPEG images. 
The images are taken by the built-in camera and are downloaded from 
Internet, and so on.

� Online Pictures (page 157) – This application allows you to share 
pictures uploaded to the Picture MailSM Website and/or manage 
pictures and albums (folders).
Section 3: Using PCS Service Features
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Messaging

Send and receive email and text messages or chat.

For details of the application for Messaging, see the following:
� Inbox (page 134) – Use Inbox to send and receive email messages.

� MSN Messenger (page 139) – MSN Messenger on your mobile device is 
an instant messaging program.

PCS Vision FAQs

How will I know when my device is ready for PCS Vision Service?

Your user name (for example, bsmith001@sprintpcs.com) will display 
on your device’s display screen.

How do I know when my device is connected to PCS Vision 
Services?

Your device automatically connects when PCS Vision Service is used or an 
incoming message arrives. (Connecting takes about 10-12 seconds.)

Can I make calls and use PCS Vision Services at the same time?

You cannot use voice and data services simultaneously. If you receive a 
call while the data service is active, the call will be forwarded into 
voicemail. You can place an outgoing call at any time, but it will 
interrupt any in-progress data session.

When is my data connection active?

Your connection is active when data is being transferred. Outgoing calls 
are allowed, but incoming calls go directly to voicemail.

When is my data connection dormant?

If no data is received for 10 seconds, the connection goes dormant. When 
the connection is dormant, voice calls are allowed. (The connection can 
go active again quickly.) If no data is received for a long time, the 
Section 3: Using PCS Service Features
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Section 3C

PCS Voice CommandSM

In This Section

� Getting Started With PCS Voice Command

� Creating Your Own Address Book

� Making a Call With PCS Voice Command

� Accessing Information Using PCS Voice Command

ith Sprint, the first wireless provider to offer innovative PCS Voice 
Command technology, reaching your friends, family, co-workers, and 

teammates has never been easier – especially when you’re on the go. You 
can even listen to Web-based information such as news, stock quotes, 
weather, sports, and much more. Your voice does it all with PCS Voice 
Command.

W
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Getting Started With PCS Voice Command

With PCS Voice Command:
� You can store all your contact’s phone numbers, so you can simply say 

the name of the person you want to call.

� There’s no need to punch in a lot of numbers, memorize voicemail 
passwords, or try to dial while you’re driving.

� You can call anyone in your address book – even if you don’t 
remember their phone number.

It’s Easy to Get Started

� Just dial S T from your PCS Phone to activate the service 
and listen to brief instructions directly from your device. There is a 
monthly charge for PCS Voice Command.

Creating Your Own Address Book

You can program up to 500 names into your personal address book, with 
each name having up to five phone numbers. That’s 2,500 phone 
numbers – and with the advanced technology of PCS Voice Command,  
you can have instant access to all of them. 

There are four ways to update your address book:
� Use Voice Recordings: Simply dial S T and say, “Add 

name.” You will then be asked to say the name and number you want 
to add to your personal address book. Your address book can store up to 
20 voice recorded names at once.

� On the Web: Go to www.talk.sprintpcs.com and receive a fully 
functional Web-based address book to create and update your contacts.

� Use an Existing Address Book: Automatically merge address books 
from desktop software applications with Sprint SyncSM Services for no 
additional charge. Simply click on the “Click to synchronize” button 
within your PCS Voice Command personal address book at 
Section 3: Using PCS Service Features
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� Call Directory Assistance: If you don’t have a computer or Internet 
access handy, you can have PCS Directory Assistance look up phone 
numbers for you and automatically add them to your address book. 
Just say, “Call operator,” and we’ll add two names and numbers to 
your address book for our standard directory assistance charge.

Making a Call With PCS Voice Command

1. Once you’ve signed up for PCS Voice Command and created your 
address book, all you do is tap S T. You’ll hear a tone 
followed by the prompt “Ready.”

2. After the “Ready” prompt, simply say, in a natural voice, “Call” and 
the name of the person or the number you’d like to call. For example, 
you can say, “Call Jane Smith at work,” “Call John Baker on the 
mobile phone,” “Call 555-1234,” or “Call Bob Miller.”

3. Your request will be repeated and you will be asked to verify. Say “Yes” 
to call the number or person. Say “No” if you wish to cancel.

4. The number will automatically be dialed. Keep in mind that PCS Voice 
Command recognizes not only your voice, but any voice, so that others 
can experience the same convenience if they use your device.

For more helpful hints on PCS Voice Command, including a list of 
recognized commands and an interactive tutorial, visit 
www.talk.sprintpcs.com.

Accessing Information Using PCS Voice 
Command

1. Tap S T.

2. Say “Call the Web.” (To access, listen to and respond to email, once 
email has been set up, say “Call My Email.”)

3. Choose from a listing of information categories like news, weather, 
sports, and more.
Section 3: Using PCS Service Features
2053C: PCS Voice Command

Note: PCS Voice Command is not available while roaming off the Sprint 
Nationwide PCS Network.

http://www.talk.sprintpcs.com


20
Section 3: Using PCS Service Features
6 3C: PCS Voice Command



Section 4

Safety Guidelines and 
Warranty Information
Section 4
207Safety Guidelines and Warranty Information



20
8



Section 4A

Safety

In This Section

� Getting the Most Out of Your Reception
� Maintaining Safe Use of and Access to Your Device
� Caring for the Battery
� Warning
� Caution
� Precautions for Use
� Instructions for Daily Use
� Acknowledging Special Precautions and the FCC Notice
� Consumer Information on Wireless Phones
� Hardware Specifications
� Owner’s Record
� User Guide Proprietary Notice

art of getting the most out of your PCS Phone is knowing where and 
how it works at optimum efficiency. This section outlines performance 

and safety guidelines that ensure you experience the full quality that your 
PCS Phone was designed to give you.

P
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Getting the Most Out of Your Reception

Keeping Tabs on Signal Strength

The quality of each call you make or receive depends on the signal 
strength in your area. Your device informs you of the current signal 
strength by displaying a number of bars next to the signal strength icon. 
The more bars displayed, the stronger the signal. If you’re inside a 
building, being near a window may give you better reception.

Understanding the Power Save Feature

If your phone is unable to find a signal after 15 minutes of searching, a 
Power Save feature is automatically activated. If your phone is active, it 
periodically rechecks service availability or you can check it yourself by 
pressing any key. When a signal is found, your phone returns to standby 
mode. 

Understanding How Your Phone Operates

Your phone is basically a radio transmitter and receiver. When it’s turned 
on, it receives and transmits radio frequency (RF) signals. When you use 
your phone, the system handling your call controls the power level. This 
power can range from 0.006 watts to 0.341 watts in digital mode.

Knowing Radio Frequency Safety

The design of your device complies with updated NCRP standards 
described below. To further limit RF exposure, you can limit the duration 
of your calls and operate your device in the most power-efficient manner. 
In 1991-92, the Institute of Electrical and Electronics Engineers (IEEE) 
and the American National Standards Institute (ANSI) joined in 
updating ANSI’s 1982 standard for safety levels with respect to human 
exposure to RF signals. More than 120 scientists, engineers and 
physicians from universities, government health agencies and industries 
developed this updated standard after reviewing the available body of 
research. In 1993, the Federal Communications Commission (FCC) 
adopted this updated standard in a regulation. In August 1996, the FCC 
Section 4: Safety Guidelines and Warranty Information
0 4A: Safety

adopted hybrid standard consisting of the existing ANSI/IEEE standard 
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Maintaining Your Phone’s Peak Performance

There are several simple guidelines to operating your phone properly and 
maintaining safe, satisfactory service. 
� Hold the phone over your shoulder when in use.

� Try not to hold, bend or twist the phone’s antenna.

� Don’t use the phone if the antenna is damaged.

� Speak directly into the microphone.

� Avoid exposing your device and accessories to rain or liquid spills. If 
your device does get wet, immediately turn the power off and remove 
the battery. If it’s inoperable, return it to a Sprint Store or call 
PCS Customer Solutions for service.

Note: For the best care of your device, only Sprint Authorized Personnel 
should service your device and accessories. Faulty service may void the 
warranty.

Maintaining Safe Use of and Access to Your 
Device

FAILURE TO FOLLOW THE INSTRUCTIONS OUTLINED MAY LEAD TO 
SERIOUS PERSONAL INJURY AND POSSIBLE PROPERTY DAMAGE

Using Your Device While Driving

Talking on your phone while driving (or operating the phone without a 
hands-free device) is prohibited in some jurisdictions. Laws vary as to 
specific restrictions. Remember that safety always comes first.

When using your device in the car:
� Get to know your device and its features, such as speed dial and redial.

� When available, use a hands-free device.

� Position your device within easy reach.
Section 4: Safety Guidelines and Warranty Information
2114A: Safety

� Let the person you are speaking to know you are driving; if necessary, 
suspend the call in heavy traffic or hazardous weather conditions.

� Do not take notes or look up phone numbers while driving.
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� Dial sensibly and assess the traffic; if possible, place calls when 
stationary or before pulling into traffic.

� Do not engage in stressful or emotional conversations that may divert 
your attention from the road.

� Dial 911 to report serious emergencies. It’s free from your wireless 
phone.

� Use your phone to help others in emergencies. 

� Call roadside assistance or a special non-emergency wireless number 
when necessary.

Tip: Purchase an optional Hands-Free Car Kit.

Following Safety Guidelines

To operate your device safely and efficiently, always follow any special 
regulations in a given area. Turn your device off in areas where use is 
forbidden or when it may cause interference or danger.

Using Your Device Near Other Electronic Devices

Most modern electronic equipment is shielded from radiofrequency (RF) 
signals. However, RF signals from wireless phones may affect 
inadequately shielded electronic equipment.

RF signals may affect improperly installed or inadequately shielded 
electronic operating systems and/or entertainment systems in motor 
vehicles. Check with the manufacturer or their representative to 
determine if these systems are adequately shielded from external RF 
signals. Also check with the manufacturer regarding any equipment that 
has been added to your vehicle.

Consult the manufacturer of any personal medical devices, such as 
pacemakers and hearing aids, to determine if they are adequately 
shielded from external RF signals.

Note: Always turn off the device in health care facilities and request 
Section 4: Safety Guidelines and Warranty Information
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permission before using the device near medical equipment.



Turning Off Your Phone Before Flying

Turn off your phone before boarding any aircraft. To prevent possible 
interference with aircraft systems, the U.S. Federal Aviation 
Administration (FAA) regulations require you to have permission from a 
crew member to use your device as a phone while the plane is on the 
ground. To prevent any risk of interference, FCC regulations prohibit 
using your device as a phone while the plane is in the air.

Turning Off Your Phone in Dangerous Areas

To avoid interfering with blasting operations, turn your phone off when 
in a blasting area or in other areas with signs indicating two-way radios 
should be turned off. Construction crews often use remote-control RF 
devices to set off explosives.

Turn your device off when you’re in any area that has a potentially 
explosive atmosphere. Although it’s rare, your device and accessories 
could generate sparks. Sparks can cause an explosion or fire, resulting in 
bodily injury or even death. These areas are often, but not always, clearly 
marked. They include:
� Fueling areas such as gas stations

� Below deck on boats

� Fuel or chemical transfer or storage facilities

� Areas where the air contains chemicals or particles such as grain, dust 
or metal powders

� Any other area where you would normally be advised to turn off your 
vehicle’s engine

Note: Never transport or store flammable gas, liquid, or explosives in the 
compartment of your vehicle that contains your device or accessories.

Restricting Children’s Access to Your Device

Your device is not a toy. Do not allow children to play with it as they could 
hurt themselves and others, damage the device, or make calls that 
Section 4: Safety Guidelines and Warranty Information
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Caring for the Battery

Protecting Your Battery

The guidelines listed below help you get the most out of your battery’s 
performance.
� Use only specified batteries and desktop chargers. These chargers are 

designed to maximize battery life. Using other batteries or chargers 
voids your warranty and may cause damage.

� In order to avoid damage, charge the battery only in temperatures that 
range from 32º F to 95º F (0º C to 35º C).

� Don’t use the battery charger in direct sunlight or in high humidity 
areas, such as the bathroom.

� Never dispose of the battery by incineration.

� Keep the metal contacts on top of the battery clean.

� Don’t attempt to disassemble or short-circuit the battery.

� The battery may need recharging if it has not been used for a long 
period of time.

� It’s best to replace the battery when it no longer provides acceptable 
performance. It can be recharged hundreds of times before it needs 
replacing.

� Do not store the battery in temperatures that exceed the recommended 
range (–4º F to 140º F [–20º C to 60º C]). 

Disposal of Lithium Ion (LiIon) Batteries

For safe disposal options of your LiIon batteries, contact your nearest 
Sprint-authorized service center.

Special Note: Be sure to dispose of your battery properly. In some areas, 
the disposal of batteries in household or business trash may be 
prohibited.
Section 4: Safety Guidelines and Warranty Information
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Note: For safety, do not handle a damaged or leaking LiIon battery.



Warning
� Should the device produce excessive heat, smoke, or strange odors, 

remove the battery (all data may be lost), unplug the AC adapter (if in 
use), and contact your nearest Sprint-authorized service center. Fire, 
electric shock, or explosion may result.

� Should the device produce excessive heat, change color or shape, or 
change in any way after use, charging, or storage, remove the battery 
(all data may be lost), remove the AC adapter (if in use), and contact 
your nearest Sprint-authorized service center. Fire, electric shock, or 
explosion may result.

� Should any foreign material (metal objects, water or any other liquid) 
enter the device, remove the battery (all data may be lost), remove the 
AC adapter (if in use), and contact your nearest Sprint-authorized 
service center. Fire or electric shock may result.

� Should you drop this device or break the case, remove the battery (all 
data may be lost), remove the AC adapter (if in use), and contact your 
nearest Sprint-authorized service center. Fire, electric shock, or 
explosion may result.

� Do not modify this device. Fire or electric shock may result.

� Do not disassemble this device. Electric shock may result.

� Do not use any voltage that differs from the power voltage 
recommended. In addition, do not overload outlets. Fire or electric 
shock may result.

� Do not remove the electrical plug with wet hands. Electric shock 
may result.

� Do not damage or modify the electrical cord. Do not bend, pull, or 
place heavy items on top of the electrical cord. Fire or electric shock 
may result.

� Do not use the electrical cord if the electrical plug is damaged or if it 
Section 4: Safety Guidelines and Warranty Information
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does not fit snugly into the outlet. Fire or electric shock may result 
from an electrical short.
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� Do not touch the metal contacts of the AC adapter or connector. 
Electric shock may result.

� Do not pour water on or allow this device to get damp. Fire or electric 
shock may result.

� Do not place a container filled with water or any liquid on or near this 
device, as the liquid may spill and enter the device. Fire or electric 
shock may result.

� Do not place this device in an area of high humidity or dust. 
Malfunction, fire, or electric shock may result.

� Do not use the device in any area where it can get wet, such as in a 
bathroom or shower. Fire or electric shock may result.

� Do not place in fire or heat in any way. Fire or explosion may result.

� Do not heat this device in a microwave oven or on a hot plate. Fire or 
explosion may result.

� Do not use this device/phone in areas of restricted use, such as on 
aircraft. It could disrupt the normal operation of instruments and may 
cause an accident.

� Do not use this device near other devices that produce strong magnetic 
fields. Malfunction may result.

� Do not allow children to swallow any small parts that can be removed 
from this device. Store any small parts from this device out of the reach 
of children. Should a child swallow any of parts from this device, 
immediately consult a physician. 

� Remove dust from the electrical plug prongs and the outlet area. Fire 
may result.

� Always unplug the AC adapter from the outlet if there is a 
thunderstorm warning or if there is a possibility of lightning striking 
nearby. Fire or malfunction may result.

� If charging does not complete after the specified charge time, stop 
Section 4: Safety Guidelines and Warranty Information
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� Should you get any fluid from the battery in your eyes, DO NOT rub 
them. Immediately rinse with clean water and seek medical attention. 
Blindness may result.

� Should any fluid from the battery come in contact with skin or clothes, 
immediately rinse with clean water. Skin rash may result.

� Ensure that children do not place the plastic bags from the packaging 
over their heads or in their mouths. Suffocation may result. 

Caution
� Do not drop or place foreign objects in any opening of this device. Fire, 

electric shock, or malfunction may result.

� Do not insert or connect wires or any other conductor to the terminals 
of this device. Fire, electric shock, or malfunction may result. 

� Do not place heavy objects on top of this device as the glass display or 
cover may break. Injury and malfunction may result.

� Do not place on any unsteady, unstable, or slanted surface, as the 
device may drop. Injury and malfunction may result. 

� Do not use or store for long periods of time near places of extreme such 
as inside of a car on a hot day, near fire, or next to a stove. The device 
casing may become excessively hot, deformed, or melt. The inside of 
the device may also become hot, causing fire or malfunction. 

� Do not wrap or cover a device in use or the AC adapter with a cloth. The 
inside of the device may also become hot, causing fire or malfunction. 

� Do not move the device too quickly or with exaggerated movements. 
The stylus may be dislodged from the device and injury or property 
damage may result.

� Do not place in an area of strong vibrations. Malfunction may result.

� If you feel any abnormalities on your skin, immediately stop use of 
this device and consult a dermatologist. Low temperature burns, 
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itching, or rash may occur with some users.

� Avoid rapid temperature changes. Condensation may occur, resulting 
in malfunction.
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� Do not use your fingernails to open any lids or operate any switches on 
this device. Injury to your fingertip may result.

� Insure that the plug is snugly inserted into the outlet. Fire or 
malfunction may result.

� If charging the device in a room of too hot ambient temperatures, the 
LED for charging will illuminate red and charging will stop. Resume 
charging in an ambient temperature from 32º F to 95º F (0º C to 35º C). 
If the red LED remains illuminated, remove the AC adapter, remove the 
battery (all data may be lost), and contact your nearest Sprint-
authorized service center.

� Before moving this device while it is charging, always remove the AC 
adapter from the outlet. Damage to the cord, fire, or electric shock may 
result.

� Always grip the electrical cord by its plug when pulling it out of an 
outlet. Pulling it out of an outlet by the cord can lead the inner wire to 
be exposed or broken. Fire or electric shock may result.

� When not using this device for long periods of time, always remove the 
electrical cord from the outlet for safety. Insulation wear, fire, or 
electric shock may result. Also, insure that all data is previously 
backed-up. 

� When traveling abroad, never plug the AC adapter into a power source 
that does not correspond to both the voltage and the frequency 
specified on the rating plate of the AC adapter, as device damage and 
fire will result. The supplied AC adapter cable is an AC 125 V type and 
should not be connected to a power source exceeding 125 volts. Fire 
may result. Connecting to a power source that exceeds 125 volts should 
only be done using a cable suitable for that voltage.

� Do not use AC adapters or electrical cords not specifically designed for 
this device. Do not modify or disassemble the AC adapter. Fire, 
malfunction, or bodily injury may result.

�
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Do not press strongly on or hit the touch screen. Electrical shock or 
malfunction may result.



� Do not sit on the device when it is located in your back pocket. Damage 
to the device, malfunction, or bodily injury may result.

� The tip of the stylus is sharp. Do not aim at people. Store it out of the 
reach of children. Misusing the stylus may result in injury.

� When using this device for an extended period of time, take a break 
every hour for 10 to 15 minutes to rest your eyes and your hands. 

� Do not operate this device while handling chemicals such as benzine. 
Discoloration, malfunction, or deformation may result.

� Do not wipe the screen with a damp cloth. Water may enter the device 
and cause malfunction.

Precautions for Use
� Memory contents of this device may change or be lost due to an error 

in operation or malfunction. Back-up all important data on a memory 
card or personal computer.

� When backing-up data, always connect the AC adapter.

� Reset the device if the device response time slows or the screen freezes, 
which may be caused by a lack of memory. See “Resetting” on page 
25. Periodic resetting is recommended for stable use.

� Do not roughly handle or drop this device.

� Do not connect any components to this device other than those 
specified or recommended.

� Use only the specified batteries with this device. Bodily injury, device 
malfunction, or fire may result from a battery rupture or leakage.

Instructions for Daily Use
� Ensure that connectors of the cables are straight when they are 

inserted or removed from connectors on the device. Forcing the 
connectors may cause them to break. 
Section 4: Safety Guidelines and Warranty Information
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� Do not use excessive force when inserting or removing a memory card.

� Do not insert any foreign objects into the opening of the card slot.
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� Do not place heavy objects on the device.

� Do not push with excessive force on or around the touch screen.

� Lightly wipe dust from the touch screen using a dry, soft cloth. 

� The device and the AC adapter may become hot during use. This
 is normal.

� Always use the supplied AC adapter when charging the battery.

� Do not use objects other than your finger or the accompanying stylus 
to operate the touch screen. This may cause the touch screen surface to 
become scratched or ruptured and may result in bodily injury.

� Tap lightly when using the accompanying stylus. 

� Using the touch screen without cleaning off dust can cause the surface 
to scratch.

� The softcase accompanying this device is meant for this device only. 
Do not place anything other than the device into the softcase.

� To prevent any possible leaks of your personal information when 
disposing of or surrendering this device, delete all data and return the 
device to its defaults. See “Initialization” on page 26 for information 
on Initialization.

Acknowledging Special Precautions and 
the FCC Notice

FCC Notice

This device may cause TV or radio interference if used in close proximity 
to receiving equipment. The FCC can require you to stop using the device 
if such interference cannot be eliminated. Vehicles using liquefied 
petroleum gas (propane or butane) must comply with the National Fire 
Protection Standard (NFPA-58). For a copy of this standard, contact the 
National Fire Protections Association, One Batterymarch Park, Quincy, 
MA 02269, Attn: Publication Sales Division.
Section 4: Safety Guidelines and Warranty Information
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Cautions

Any changes or modifications to your device not expressly approved by 
the party responsible for compliance could void your warranty for this 
equipment and void your authority to operate this equipment. Only use 
specified batteries, antennas and chargers. Although your device is quite 
sturdy, it is a complex piece of equipment and can be broken. Avoid 
dropping, hitting, bending, or sitting on it.

Use only the supplied antenna. Unauthorized antennas, modifications, or 
attachments could impair call quality, damage the phone, or result in 
violation of FCC regulations. Do not use the phone with a damaged 
antenna. Please contact your local dealer for replacement antenna.

Tests for SAR are conducted using standard operating positions specified 
by the FCC with the device transmitting at its highest certified power level 
in all tested frequency bands. Although the SAR is determined at the 
highest certified power level, the actual SAR level of the device while in 
operation can be well below the maximum value. This is because the 
device is designed to operate at multiple power levels so as to use only the 
power required to reach the network. In general, the closer you are to a 
wireless base station antenna, the lower the power output.

Specific Absorption Rates (SAR) for Wireless Phones

The SAR is a value that corresponds to the relative amount of RF energy 
absorbed in the head of a user of a wireless device.

The SAR value of a phone is the result of an extensive testing, measuring 
and calculation process. It does not represent how much RF the phone 
emits. All phone models are tested at their highest value in strict 
laboratory settings. But when in operation, the SAR of a phone can be 
substantially less than the level reported to the FCC. This is because of a 
variety of factors including its proximity to a base station antenna, phone 
design and other factors. What is important to remember is that each 
phone meets strict federal guidelines. Variations in SARs do not represent 
variation in safety.
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All phones must meet the federal standard, which incorporates a 
substantial margin of safety. As stated above, variations in SAR values 
between different model phones do not mean variations in safety. SAR 
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values at or below the federal standard of 1.6 W/Kg are considered safe for 
use by the public.

The highest reported SAR values of the [ABLSH-G1000] are:

PCS mode (Part 24) – Head: 1.44 W/kg; Body-worn: 1.17 W/kg

FCC Radiofrequency Emission

This phone meets the FCC Radiofrequency Emission Guidelines. FCC ID 
number: ABLSH-G1000. More information on the phone’s SAR can be 
found from the following FCC website: http://www.fcc.gov/oet/fccid.

FCC RF Exposure Information

In order to comply with FCC RF exposure guidelines for body-worn 
operation, use only supplied accessories. Use of any other accessories may 
not comply with FCC RF exposure guidelines.

Belt Worn Operation

For belt worn operation use only the supplied softcase and belt clip. Use of 
this device without the supplied softcase and belt clip may not comply 
with FCC RF exposure guidelines. 

Lap Held Operation

When using the device in the lap held position, the device must remain 
inside the supplied softcase with the front flip-cover wrapped and stowed 
along the back surface as illustrated below. This also applies to when the 
device is in speakerphone operation and is used in the lap held position. 
Use of this device in any other lap held configuration may violate FCC RF 
exposure guidelines.

Device
Softcase
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Hand Held Operation

For hand held operation the device is supplied with a thumb operated 
keyboard. For optimum performance both thumbs should be present on 
the keyboard at all times. Although the softcase is designed to allow 
operation in this mode, the softcase is not required in order to comply 
with RF Exposure guidelines in this position. 

Normal Phone Operation 

While the device is being used for normal phone operation, the softcase is 
not required in order to comply with RF Exposure guidelines. 

For more information about RF exposure, visit the FCC Website at 
www.fcc.gov.

FCC Part 15

Warning: This device complies with part 15 of the FCC Rules. Operation 
is subject to the following two conditions: (1) This device may not cause 
harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more of 
the following measures:
� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and receiver.
Section 4: Safety Guidelines and Warranty Information
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� Connect the equipment into an outlet on a circuit different from that 
to which the receiver is connected.

� Consult the dealer or an experienced radio/TV technician for help.

Caution to the user: Changes or modifications not expressly approved by 
Hitachi Ltd. void the user’s authority to operate the equipment.
Section 4: Safety Guidelines and Warranty Information
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Consumer Information on Wireless Phones

(The following information comes from a consumer information 
Website jointly sponsored by the U.S. Food and Drug Administration 
(FDA) and the Federal Communications Commission (FCC), entitled 
“Cell Phone Facts: Consumer Information on Wireless Phones.” The 
information reproduced herein is dated April 3, 2002. For further 
updates, please visit the Website: http://www.fda.gov/cellphones/.)

1. What is radiofrequency energy (RF)?

Radiofrequency (RF) energy is another name for radio waves. It is one 
form of electromagnetic energy that makes up the electromagnetic 
spectrum. Some of the other forms of energy in the electromagnetic 
spectrum are gamma rays, x-rays and light. Electromagnetic energy (or 
electromagnetic radiation) consists of waves of electric and magnetic 
energy moving together (radiating) through space. The area where these 
waves are found is called an electromagnetic field.

Radio waves are created due to the movement of electrical charges in 
antennas. As they are created, these waves radiate away from the 
antenna. All electromagnetic waves travel at the speed of light. The major 
differences between the different types of waves are the distances covered 
by one cycle of the wave and the number of waves that pass a certain 
point during a set time period. The wavelength is the distance covered by 
one cycle of a wave. The frequency is the number of waves passing a 
given point in one second. For any electromagnetic wave, the wavelength 
multiplied by the frequency equals the speed of light. The frequency of an 
RF signal is usually expressed in units called hertz (Hz). One Hz equals 
one wave per second. One kilohertz (kHz) equals one thousand waves per 
second, one megahertz (MHz) equals one million waves per second, and 
one gigahertz (GHz) equals one billion waves per second.

RF energy includes waves with frequencies ranging from about 3000 
waves per second (3 kHz) to 300 billion waves per second (300 GHz). 
Microwaves are a subset of radio waves that have frequencies ranging 
from around 300 million waves per second (300 MHz) to three billion 
Section 4: Safety Guidelines and Warranty Information
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2. How is radiofrequency energy used?

Probably the most important use of RF energy is for telecommunications. 
Radio and TV broadcasting, wireless phones, pagers, cordless phones, 
police and fire department radios, point-to-point links and satellite 
communications all rely on RF energy. 

Other uses of RF energy include microwave ovens, radar, industrial 
heaters and sealers, and medical treatments. RF energy, especially at 
microwave frequencies, can heat water. Since most food has a high water 
content, microwaves can cook food quickly. Radar relies on RF energy to 
track cars and airplanes as well as for military applications. Industrial 
heaters and sealers use RF energy to mold plastic materials, glue wood 
products, seal leather items such as shoes and pocketbooks, and process 
food. Medical uses of RF energy include pacemaker monitoring and 
programming.

3. How is radiofrequency radiation measured?

RF waves and RF fields have both electrical and magnetic components. It 
is often convenient to express the strength of the RF field in terms of each 
component. For example, the unit “volts per meter” (V/m) is used to 
measure the electric field strength, and the unit “amperes per meter” 
(A/m) is used to express the magnetic field strength. Another common 
way to characterize an RF field is by means of the power density. Power 
density is defined as power per unit area. For example, power density can 
be expressed in terms of milliwatts (one thousandth of a watt) per square 
centimeter (mW/cm2) or microwatts (one millionth of a watt) per square 
centimeter (µW/cm2).

The quantity used to measure how much RF energy is actually absorbed 
by the body is called the Specific Absorption Rate or SAR. The SAR is a 
measure of the rate of absorption of RF energy. It is usually expressed in 
units of watts per kilogram (W/kg) or milliwatts per gram (mW/g). 

4. What biological effects can be caused by RF energy?

The biological effects of radiofrequency energy should not be confused 
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with the effects from other types of electromagnetic energy.

Very high levels of electromagnetic energy, such as is found in X-rays and 
gamma rays can ionize biological tissues. Ionization is a process where 



electrons are stripped away from their normal locations in atoms and 
molecules. It can permanently damage biological tissues including DNA, 
the genetic material. Ionization only occurs with very high levels of 
electromagnetic energy such as X-rays and gamma rays. Often the term 
radiation is used when discussing ionizing radiation (such as that 
associated with nuclear power plants). 

The energy levels associated with radiofrequency energy, including both 
radio waves and microwaves, are not great enough to cause the 
ionization of atoms and molecules. Therefore, RF energy is a type of non-
ionizing radiation. Other types of non-ionizing radiation include visible 
light, infrared radiation (heat) and other forms of electromagnetic 
radiation with relatively low frequencies. 

Large amounts of RF energy can heat tissue. This can damage tissues 
and increase body temperatures. Two areas of the body, the eyes and the 
testes, are particularly vulnerable to RF heating because there is relatively 
little blood flow in them to carry away excess heat.

The amount of RF radiation routinely encountered by the general public 
is too low to produce significant heating or increased body temperature. 
Still, some people have questions about the possible health effects of low 
levels of RF energy. It is generally agreed that further research is needed 
to determine what effects actually occur and whether they are dangerous 
to people. In the meantime, standards-setting organizations and 
government agencies are continuing to monitor the latest scientific 
findings to determine whether changes in safety limits are needed to 
protect human health.

FDA, EPA and other US government agencies responsible for public 
health and safety have worked together and in connection with WHO to 
monitor developments and identify research needs related to RF 
biological effects. 

5. What levels of RF energy are considered safe?

Various organizations and countries have developed standards for 
exposure to radiofrequency energy. These standards recommend safe 
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levels of exposure for both the general public and for workers. In the 
United States, the FCC has used safety guidelines for RF environmental 
exposure since 1985. 
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The FCC guidelines for human exposure to RF electromagnetic fields are 
derived from the recommendations of two expert organizations, the 
National Council on Radiation Protection and Measurements (NCRP) 
and the Institute of Electrical and Electronics Engineers (IEEE). In both 
cases, the recommendations were developed by scientific and engineering 
experts drawn from industry, government, and academia after extensive 
reviews of the scientific literature related to the biological effects of RF 
energy. 

Many countries in Europe and elsewhere use exposure guidelines 
developed by the International Commission on Non-Ionizing Radiation 
Protection (ICNIRP). The ICNIRP safety limits are generally similar to 
those of the NCRP and IEEE, with a few exceptions. For example, ICNIRP 
recommends different exposure levels in the lower and upper frequency 
ranges and for localized exposure from certain products such as hand-
held wireless telephones. Currently, the World Health Organization is 
working to provide a framework for international harmonization of RF 
safety standards.

The NCRP, IEEE, and ICNIRP all have identified a whole-body Specific 
Absorption Rate (SAR) value of 4 watts per kilogram (4 W/kg) as a 
threshold level of exposure at which harmful biological effects may 
occur. Exposure guidelines in terms of field strength, power density and 
localized SAR were then derived from this threshold value. In addition, 
the NCRP, IEEE, and ICNIRP guidelines vary depending on the frequency 
of the RF exposure. This is due to the finding that whole-body human 
absorption of RF energy varies with the frequency of the RF signal. The 
most restrictive limits on whole-body exposure are in the frequency range 
of 30-300 MHz where the human body absorbs RF energy most efficiently. 
For products that only expose part of the body, such as wireless phones, 
exposure limits in terms of SAR only are specified.

The exposure limits used by the FCC are expressed in terms of SAR, 
electric and magnetic field strength, and power density for transmitters 
operating at frequencies from 300 kHz to 100 GHz. The specific values 
can be found in two FCC bulletins, OET Bulletins 56 and 65: 
Section 4: Safety Guidelines and Warranty Information
8 4A: Safety

http://www.fcc.gov/oet/info/documents/bulletins/#56; 
http://www.fcc.gov/oet/info/documents/bulletins/#65

http://www.fcc.gov/oet/info/documents/bulletins/#56
http://www.fcc.gov/oet/info/documents/bulletins/#65


6. Why has the FCC adopted guidelines for RF exposure?

The FCC authorizes and licenses products, transmitters, and facilities that 
generate RF and microwave radiation. It has jurisdiction over all 
transmitting services in the U.S. except those specifically operated by the 
Federal Government. While the FCC does not have the expertise to 
determine radiation exposure guidelines on its own, it does have the 
expertise and authority to recognize and adopt technically sound 
standards promulgated by other expert agencies and organizations, and 
has done so. (Our joint efforts with the FDA in developing this website is 
illustrative of the kind of inter-agency efforts and consultation we engage 
in regarding this health and safety issue.)

Under the National Environmental Policy Act of 1969 (NEPA), the FCC 
has certain responsibilities to consider whether its actions will 
significantly affect the quality of the human environment. Therefore, 
FCC approval and licensing of transmitters and facilities must be 
evaluated for significant impact on the environment. Human exposure to 
RF radiation emitted by FCC-regulated transmitters is one of several 
factors that must be considered in such environmental evaluations. In 
1996, the FCC revised its guidelines for RF exposure as a result of a multi-
year proceeding and as required by the Telecommunications Act of 1996.

Radio and television broadcast stations, satellite-earth stations, 
experimental radio stations and certain wireless communication 
facilities are required to undergo routine evaluation for RF compliance 
when they submit an application to the FCC for construction or 
modification of a transmitting facility or renewal of a license. Failure to 
comply with the FCC’s RF exposure guidelines could lead to the 
preparation of a formal Environmental Assessment, possible 
Environmental Impact Statement and eventual rejection of an 
application. Technical guidelines for evaluating compliance with the 
FCC RF safety requirements can be found in the FCC’s OET Bulletin 65. 
http://www.fcc.gov/oet/info/documents/bulletins/#65

Low-powered, intermittent, or inaccessible RF transmitters and facilities 
are normally excluded from the requirement for routine evaluation for 
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RF exposure. These exclusions are based on standard calculations and 
measurement data indicating that a transmitting station or equipment 
operating under the conditions prescribed is unlikely to cause exposures 
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in excess of the guidelines under normal conditions of use. Such 
exclusions are not exclusions from compliance, but, rather, exclusions 
from routine evaluation. The FCC’s policies on RF exposure and 
categorical exclusion can be found in Section 1.1307(b) of the FCC’s 
Rules and Regulations [(47 CFR 1.1307(b)].

7. How can I obtain the Specific Absorption Rate (SAR) value for my 
wireless phone?

The FCC requires that wireless phones sold in the United States 
demonstrate compliance with human exposure limits adopted by the FCC 
in 1996. The relative amount of RF energy absorbed in the head of a 
wireless telephone-user is given by the Specific Absorption Rate (SAR), as 
explained above. The FCC requires wireless phones to comply with a 
safety limit of 1.6 watts per kilogram (1.6 W/kg) in terms of SAR.

Information on SAR for a specific phone model can be obtained for many 
recently manufactured phones using the FCC identification (ID) number 
for that model. The FCC ID number is usually printed somewhere on the 
case of the phone. Sometimes it may be necessary to remove the battery 
pack to find the number. Once you have the ID number, go to the 
following Web address: www.fcc.gov/oet/fccid. On this page, you will see 
instructions for entering the FCC ID number. Type the FCC ID number 
exactly as requested (the Grantee Code is the first three characters, the 
Equipment Product Code is the rest of the FCC ID number). Then click 
on “Start Search.” The “Grant of Equipment Authorization” for your 
telephone should appear. Read through the grant for the section on “SAR 
Compliance,” “Certification of Compliance with FCC Rules for RF 
Exposure” or similar language. This section should contain the value(s) 
for typical or maximum SAR for your phone.

Phones and other products authorized since June 2, 2000, should have 
the maximum SAR levels noted directly on the “Grant of Equipment 
Authorization.” For phones and products authorized between about mid-
1998 and June 2000, detailed information on SAR levels is typically found 
in the exhibits associated with the grant. Once a grant is accessed, the 
exhibits can be viewed by clicking on “View Exhibit.” Grants authorized 
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prior to 1998 are not part of the electronic database but, rather, have been 
documented in the form of paper records. 
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The FCC database does not list phones by model number. However, 
consumers may find SAR information from other sources as well. Some 
wireless phone manufacturers make SAR information available on their 
own Websites. In addition, some non-government Websites provide SARs 
for specific models of wireless phones. However, the FCC has not reviewed 
these sites and makes no guarantees of their accuracy. Finally, phones 
certified by the Cellular Telecommunications and Internet Association 
(CTIA) are required to provide SAR information to consumers in the 
instructional materials that come with the phones. 

8. Do hands-free kits for wireless phones reduce risks from 
exposure to RF emissions?

Since there are no known risks from exposure to RF emissions from 
wireless phones, there is no reason to believe that hands-free kits reduce 
risks. Hands-free kits can be used with wireless phones for convenience 
and comfort. These systems reduce the absorption of RF energy in the 
head because the phone, which is the source of the RF emissions, will not 
be placed against the head. On the other hand, if the phone is mounted 
against the waist or other part of the body during use, then that part of 
the body will absorb more RF energy. Wireless phones marketed in the 
U.S. are required to meet safety requirements regardless of whether they 
are used against the head or against the body. Either configuration 
should result in compliance with the safety limit.

9. Do wireless phone accessories that claim to shield the head 
from RF radiation work?

Since there are no known risks from exposure to RF emissions from 
wireless phones, there is no reason to believe that accessories that claim 
to shield the head from those emissions reduce risks. Some products that 
claim to shield the user from RF absorption use special phone cases, 
while others involve nothing more than a metallic accessory attached to 
the phone. Studies have shown that these products generally do not work 
as advertised. Unlike “hand-free” kits, these so-called “shields” may 
interfere with proper operation of the phone. The phone may be forced to 
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boost its power to compensate, leading to an increase in RF absorption. 
In February 2002, the Federal trade Commission (FTC) charged two 
companies that sold devices that claimed to protect wireless phone 
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users from radiation with making false and unsubstantiated claims. 
According to FTC, these defendants lacked a reasonable basis to 
substantiate their claim.

10. What are wireless telephone base stations?

Fixed antennas used for wireless telecommunications are referred to as 
cellular base stations, cell stations, PCS (“Personal Communications 
Service”) stations or telephone transmission towers. These base stations 
consist of antennas and electronic equipment. Because the antennas 
need to be high in the air, they are often located on towers, poles, water 
tanks, or rooftops. Typical heights for freestanding base station towers are 
50-200 feet. 

Some base stations use antennas that look like poles, 10 to 15 feet in 
length, that are referred to as “omni-directional” antennas. These types 
of antennas are usually found in rural areas. In urban and suburban 
areas, wireless providers now more commonly use panel or sector 
antennas for their base stations. These antennas consist of rectangular 
panels, about 1 by 4 feet in dimension. The antennas are usually 
arranged in three groups of three antennas each. One antenna in each 
group is used to transmit signals to wireless phones, and the other two 
antennas in each group are used to receive signals from wireless phones.

At any base station site, the amount of RF energy produced depends on 
the number of radio channels (transmitters) per antenna and the power 
of each transmitter. Typically, 21 channels per antenna sector are 
available. For a typical cell site using sector antennas, each of the three 
transmitting antennas could be connected to up to 21 transmitters for a 
total of 63 transmitters. However, it is unlikely that all of the transmitters 
would be transmitting at the same time. When omni-directional 
antennas are used, a cellular base station could theoretically use up to 96 
transmitters, but this would be very unusual, and, once again, it is 
unlikely that all transmitters would be in operation simultaneously. Base 
stations used for PCS communications generally require fewer 
transmitters than those used for cellular radio transmissions, since PCS 
carriers usually have a higher density of base station antenna sites.
Section 4: Safety Guidelines and Warranty Information
2 4A: Safety



11. Are wireless telephone base stations safe?

The electromagnetic RF signals transmitted from base station antennas 
stations travel toward the horizon in relatively narrow paths. For 
example, the radiation pattern for an antenna array mounted on a tower 
can be likened to a thin pancake centered around the antenna system. 
The individual pattern for a single array of sector antennas is wedge-
shaped, like a piece of pie. As with all forms of electromagnetic energy, 
the power decreases rapidly as one moves away from the antenna. 
Therefore, RF exposure on the ground is much less than exposure very 
close to the antenna and in the path of the transmitted radio signal. In 
fact, ground-level exposure from such antennas is typically thousands of 
times less than the exposure levels recommended as safe by expert 
organizations. So exposure to nearby residents would be well within 
safety margins. 

Cellular and PCS base stations in the United States are required to 
comply with limits for exposure recommended by expert organizations 
and endorsed by government agencies responsible for health and safety. 
Measurements made near cellular and PCS base station antennas 
mounted on towers have confirmed that ground-level exposures are 
typically thousands of times less than the exposure limits adopted by the 
FCC. In fact, in order to be exposed to levels at or near the FCC limits for 
cellular or PCS frequencies an individual would essentially have to 
remain in the main transmitted radio signal (at the height of the 
antenna) and within a few feet from the antenna. This is, of course, very 
unlikely to occur.

When cellular and PCS antennas are mounted on rooftops, RF levels on 
that roof or on others near by would probably be greater than those 
typically encountered on the ground. However, exposure levels 
approaching or exceeding safety guidelines should be encountered only 
very close to or directly in front of the antennas. In addition, for sector-
type antennas, typically used for such rooftop base stations, RF levels to 
the side and in back of these antennas are insignificant. General 
guidelines on antenna installations and circumstances that might give 
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rise to a concern about an facility’s conformance with FCC regulations 
can be found in A Local Government Official’s Guide to Transmitting 
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Antenna RF Emission Safety: Rules, Procedures, and Practical Guidance. 
This Guide can be accessed at: http://www.fcc.gov/oet/rfsafety.

12. Who regulates exposure to radiation from microwave ovens, 
television sets and computer monitors?

The Food and Drug Administration is responsible for protecting the 
public from harmful radiation emissions from these consumer products.

13. Does the FCC routinely monitor radiofrequency radiation from 
antennas?

The FCC does not have the resources or the personnel to routinely 
monitor the emissions for all the thousands of transmitters that are 
subject to FCC jurisdiction. However, the FCC does have measurement 
instrumentation for evaluating RF levels in areas that may be accessible 
to the public or to workers. If there is evidence for potential non-
compliance with FCC exposure guidelines for a FCC-regulated facility, 
staff from the FCC’s Office of Engineering and Technology or the FCC 
Enforcement Bureau can conduct and investigation, and, if appropriate, 
perform actual measurements. Circumstances that could give rise to a 
concern about an facility’s conformance with FCC regulations can be 
found in A Local Government Official’s Guide to Transmitting Antenna 
RF Emission Safety: Rules, Procedures, and Practical Guidance. This 
Guide can be accessed at: http://www.fcc.gov/oet/rfsafety. Potential 
exposure problems should be brought to the FCC’s attention by 
contacting the FCC RF Safety Program at: 202-418-2464 or by email: 
rfsafety@fcc.gov. 

14. Does the FCC maintain a database that includes information on 
the location and technical parameters of all the transmitting 
towers it regulates?

Each of the FCC Bureaus maintains its own licensing database system for 
the service(s) it regulates (e.g., television, cellular service, satellite earth 
stations.) The FCC issues two types of licenses: site specific and market 
based. In the case of site specific licensed facilities, technical operating 
information is collected from the licensee as part of the licensing process. 
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However, in the case of market based licensing (e.g., PCS, cellular), the 
licensee is granted the authority to operate a radio communications 
system in a geographic area using as many facilities as are required, and 
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the licensee is not required to provide the FCC with specific location and 
operating parameters of these facilities.

Information on site specific licensed facilities can be found the “General 
Menu Reports” (GenMen) at 
http://gullfoss2.fcc.gov/cgi-bin/ws.exe/genmen/index.hts.

The various FCC Bureaus also publish on at least a weekly basis, bulk 
extracts of their licensing databases. Each licensing database has its own 
unique file structure. These extracts consist of multiple, very large files. 
The FCC’s Office of Engineering and Technology (OET) maintains an 
index to these databases at 
http://www.fcc.gov/oet/info/database/fadb.html. Entry points into the 
various databases include frequency, state/county, latitude/longitude, 
call-sign and licensee name. For further information on the 
Commission’s existing databases, you can contact Donald Campbell at 
dcampbel@fcc.gov or 202-418-2405.

15. Can local and state governmental bodies establish limits for RF 
exposure?

Although some local and state governments have enacted rules and 
regulations about human exposure to RF energy in the past, the 
Telecommunications Act of 1996 requires the Federal Government to 
control human exposure to RF emissions. In particular, Section 704 of 
the Act states that, “No State or local government or instrumentality 
thereof may regulate the placement, construction, and modification of 
personal wireless service facilities on the basis of the environmental 
effects of radio frequency emissions to the extent that such facilities 
comply with the Commission’s regulations concerning such emissions.” 
Further information on federal authority and FCC policy is available in a 
fact sheet from the FCC’s Wireless Telecommunications Bureau at 
www.fcc.gov/wtb. 

16. Do wireless phones pose a health hazard?

The available scientific evidence does not show that any health problems 
are associated with using wireless phones. There is no proof, however, 
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that wireless phones are absolutely safe. Wireless phones emit low levels 
of radiofrequency energy (RF) in the microwave range while being used. 
They also emit very low levels of RF when in the stand-by mode. Whereas 
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high levels of RF can produce health effects (by heating tissue), exposure 
to low level RF that does not produce heating effects causes no known 
adverse health effects. Many studies of low level RF exposures have not 
found any biological effects. Some studies have suggested that some 
biological effects may occur, but such findings have not been confirmed 
by additional research. In some cases, other researchers have had 
difficulty in reproducing those studies, or in determining the reasons for 
inconsistent results.

17. What is FDA’s role concerning the safety of wireless phones?

Under the law, FDA does not review the safety of radiation-emitting 
consumer products such as wireless phones before they can be sold, as it 
does with new drugs or medical devices. However, the agency has 
authority to take action if wireless phones are shown to emit 
radiofrequency energy (RF) at a level that is hazardous to the user. In 
such a case, FDA could require the manufacturers of wireless phones to 
notify users of the health hazard and to repair, replace or recall the 
phones so that the hazard no longer exists.

Although the existing scientific data do not justify FDA regulatory 
actions, FDA has urged the wireless phone industry to take a number of 
steps, including the following:
� Support needed research into possible biological effects of RF of the 

type emitted by wireless phones; 

� Design wireless phones in a way that minimizes any RF exposure to 
the user that is not necessary for device function; and 

� Cooperate in providing users of wireless phones with the best possible 
information on possible effects of wireless phone use on human health 

FDA belongs to an interagency working group of the federal agencies that 
have responsibility for different aspects of RF safety to ensure coordinated 
efforts at the federal level. The following agencies belong to this working 
group:
� National Institute for Occupational Safety and Health 
Section 4: Safety Guidelines and Warranty Information
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� Environmental Protection Agency 

� Federal Communications Commission 



� Occupational Safety and Health Administration 

� National Telecommunications and Information Administration 

The National Institutes of Health participates in some interagency 
working group activities, as well.

FDA shares regulatory responsibilities for wireless phones with the Federal 
Communications Commission (FCC). All phones that are sold in the 
United States must comply with FCC safety guidelines that limit RF 
exposure. FCC relies on FDA and other health agencies for safety 
questions about wireless phones.

FCC also regulates the base stations that the wireless phone networks rely 
upon. While these base stations operate at higher power than do the 
wireless phones themselves, the RF exposures that people get from these 
base stations are typically thousands of times lower than those they can 
get from wireless phones. Base stations are thus not the primary subject 
of the safety questions discussed in this document.

18. What kinds of phones are the subject of this update?

The term “wireless phone” refers here to hand-held wireless phones with 
built-in antennas, often called “cell,” “mobile,” or “PCS” phones. These 
types of wireless phones can expose the user to measurable 
radiofrequency energy (RF) because of the short distance between the 
phone and the user’s head. These RF exposures are limited by Federal 
Communications Commission safety guidelines that were developed with 
the advice of FDA and other federal health and safety agencies. When the 
phone is located at greater distances from the user, the exposure to RF is 
drastically lower because a person’s RF exposure decreases rapidly with 
increasing distance from the source. The so-called “cordless phones,” 
which have a base unit connected to the telephone wiring in a house, 
typically operate at far lower power levels, and thus produce RF exposures 
well within the FCC’s compliance limits.

19. What are the results of the research done already?

The research done thus far has produced conflicting results, and many 
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studies have suffered from flaws in their research methods. Animal 
experiments investigating the effects of radiofrequency energy (RF) 
exposures characteristic of wireless phones have yielded conflicting 
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results that often cannot be repeated in other laboratories. A few animal 
studies, however, have suggested that low levels of RF could accelerate the 
development of cancer in laboratory animals. However, many of the 
studies that showed increased tumor development used animals that had 
been genetically engineered or treated with cancer-causing chemicals so 
as to be pre-disposed to develop cancer in the absence of RF exposure. 
Other studies exposed the animals to RF for up to 22 hours per day. These 
conditions are not similar to the conditions under which people use 
wireless phones, so we don’t know with certainty what the results of such 
studies mean for human health.

Three large epidemiology studies have been published since December 
2000. Between them, the studies investigated any possible association 
between the use of wireless phones and primary brain cancer, glioma, 
meningioma, or acoustic neuroma, tumors of the brain or salivary 
gland, leukemia, or other cancers. None of the studies demonstrated the 
existence of any harmful health effects from wireless phone RF 
exposures. However, none of the studies can answer questions about long-
term exposures, since the average period of phone use in these studies 
was around three years.

20. What research is needed to decide whether RF exposure from 
wireless phones poses a health risk?

A combination of laboratory studies and epidemiological studies of 
people actually using wireless phones would provide some of the data 
that are needed. Lifetime animal exposure studies could be completed in 
a few years. However, very large numbers of animals would be needed to 
provide reliable proof of a cancer promoting effect if one exists. 
Epidemiological studies can provide data that is directly applicable to 
human populations, but 10 or more years’ follow-up may be needed to 
provide answers about some health effects, such as cancer. This is 
because the interval between the time of exposure to a cancer-causing 
agent and the time tumors develop - if they do - may be many, many 
years. The interpretation of epidemiological studies is hampered by 
difficulties in measuring actual RF exposure during day-to-day use of 
Section 4: Safety Guidelines and Warranty Information
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wireless phones. Many factors affect this measurement, such as the angle 
at which the phone is held, or which model of phone is used.



21. What is FDA doing to find out more about the possible health 
effects of wireless phone RF?

FDA is working with the U.S. National Toxicology Program and with 
groups of investigators around the world to ensure that high priority 
animal studies are conducted to address important questions about the 
effects of exposure to radiofrequency energy (RF).

FDA has been a leading participant in the World Health Organization 
International Electromagnetic Fields (EMF) Project since its inception in 
1996. An influential result of this work has been the development of a 
detailed agenda of research needs that has driven the establishment of 
new research programs around the world. The Project has also helped 
develop a series of public information documents on EMF issues.

FDA and the Cellular Telecommunications & Internet Association (CTIA) 
have a formal Cooperative Research and Development Agreement 
(CRADA) to do research on wireless phone safety. FDA provides the 
scientific oversight, obtaining input from experts in government, 
industry, and academic organizations. CTIA-funded research is 
conducted through contracts to independent investigators. The initial 
research will include both laboratory studies and studies of wireless 
phone users. The CRADA will also include a broad assessment of 
additional research needs in the context of the latest research 
developments around the world.

22. What steps can I take to reduce my exposure to radiofrequency 
energy from my wireless phone?

If there is a risk from these products—and at this point we do not know 
that there is—it is probably very small. But if you are concerned about 
avoiding even potential risks, you can take a few simple steps to 
minimize your exposure to radiofrequency energy (RF). Since time is a 
key factor in how much exposure a person receives, reducing the amount 
of time spent using a wireless phone will reduce RF exposure.

If you must conduct extended conversations by wireless phone every day, 
you could place more distance between your body and the source of the 
Section 4: Safety Guidelines and Warranty Information
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RF, since the exposure level drops off dramatically with distance. For 
example, you could use a headset and carry the wireless phone away 
from your body or use a wireless phone connected to a remote antenna.
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Again, the scientific data do not demonstrate that wireless phones are 
harmful. But if you are concerned about the RF exposure from these 
products, you can use measures like those described above to reduce your 
RF exposure from wireless phone use.

23. What about children using wireless phones?

The scientific evidence does not show a danger to users of wireless 
phones, including children and teenagers. If you want to take steps to 
lower exposure to radiofrequency energy (RF), the measures described 
above would apply to children and teenagers using wireless phones. 
Reducing the time of wireless phone use and increasing the distance 
between the user and the RF source will reduce RF exposure.

Some groups sponsored by other national governments have advised that 
children be discouraged from using wireless phones at all. For example, 
the government in the United Kingdom distributed leaflets containing 
such a recommendation in December 2000. They noted that no evidence 
exists that using a wireless phone causes brain tumors or other ill effects. 
Their recommendation to limit wireless phone use by children was 
strictly precautionary; it was not based on scientific evidence that any 
health hazard exists.

24. What about wireless phone interference with medical 
equipment?

Radiofrequency energy (RF) from wireless phones can interact with some 
electronic devices. For this reason, FDA helped develop a detailed test 
method to measure electromagnetic interference (EMI) of implanted 
cardiac pacemakers and defibrillators from wireless telephones. This test 
method is now part of a standard sponsored by the Association for the 
Advancement of Medical instrumentation (AAMI). The final draft, a joint 
effort by FDA, medical device manufacturers, and many other groups, 
was completed in late 2000. This standard will allow manufacturers to 
ensure that cardiac pacemakers and defibrillators are safe from wireless 
phone EMI.

FDA has tested hearing aids for interference from handheld wireless 
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phones and helped develop a voluntary standard sponsored by the 
Institute of Electrical and Electronic Engineers (IEEE). This standard 
specifies test methods and performance requirements for hearing aids 



and wireless phones so that no interference occurs when a person uses a 
“compatible” phone and a “compatible” hearing aid at the same time. 
This standard was approved by the IEEE in 2000.

FDA continues to monitor the use of wireless phones for possible 
interactions with other medical devices. Should harmful interference be 
found to occur, FDA will conduct testing to assess the interference and 
work to resolve the problem.

25. Which other federal agencies have responsibilities related to 
potential RF health effects?

Certain agencies in the Federal Government have been involved in 
monitoring, researching or regulating issues related to human exposure 
to RF radiation. These agencies include the Food and Drug 
Administration (FDA), the Environmental Protection Agency (EPA), the 
Occupational Safety and Health Administration (OSHA), the National 
Institute for Occupational Safety and Health (NIOSH), the National 
Telecommunications and Information Administration (NTIA) and the 
Department of Defense (DOD).

By authority of the Radiation Control for Health and Safety Act of 1968, 
the Center for Devices and Radiological Health (CDRH) of the FDA 
develops performance standards for the emission of radiation from 
electronic products including X-ray equipment, other medical devices, 
television sets, microwave ovens, laser products and sunlamps. The 
CDRH established a product performance standard for microwave ovens 
in 1971 limiting the amount of RF leakage from ovens. However, the 
CDRH has not adopted performance standards for other RF-emitting 
products. The FDA is, however, the lead federal health agency in 
monitoring the latest research developments and advising other agencies 
with respect to the safety of RF-emitting products used by the public, such 
as cellular and PCS phones.

The FDA’s microwave oven standard is an emission standard (as opposed 
to an exposure standard) that allows specific levels of microwave leakage 
(measured at five centimeters from the oven surface). The standard also 
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requires ovens to have two independent interlock systems that prevent the 
oven from generating microwaves the moment that the latch is released 
or the door of the oven is opened. The FDA has stated that ovens that meet 
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its standards and are used according to the manufacturer’s 
recommendations are safe for consumer and industrial use. More 
information is available from: www.fda.gov/cdrh.

The EPA has, in the past, considered developing federal guidelines for 
public exposure to RF radiation. However, EPA activities related to RF 
safety and health are presently limited to advisory functions. For 
example, the EPA now chairs an Inter-agency Radiofrequency Working 
Group, which coordinates RF health-related activities among the various 
federal agencies with health or regulatory responsibilities in this area.

OSHA is responsible for protecting workers from exposure to hazardous 
chemical and physical agents. In 1971, OSHA issued a protection guide 
for exposure of workers to RF radiation [29 CFR 1910.97]. However, this 
guide was later ruled to be only advisory and not mandatory. Moreover, it 
was based on an earlier RF exposure standard that has now been revised. 
At the present time, OSHA uses the IEEE and/or FCC exposure guidelines 
for enforcement purposes under OSHA’s “general duty clause” (for more 
information see: 
http://www.osha-slc.gov/SLTC/radiofrequencyradiation/index.html).

NIOSH is part of the U.S. Department of Health and Human Services. It 
conducts research and investigations into issues related to occupational 
exposure to chemical and physical agents. NIOSH has, in the past, 
undertaken to develop RF exposure guidelines for workers, but final 
guidelines were never adopted by the agency. NIOSH conducts safety-
related RF studies through its Physical Agents Effects Branch in 
Cincinnati, Ohio.

The NTIA is an agency of the U.S. Department of Commerce and is 
responsible for authorizing Federal Government use of the RF 
electromagnetic spectrum. Like the FCC, the NTIA also has NEPA 
responsibilities and has considered adopting guidelines for evaluating RF 
exposure from U.S. Government transmitters such as radar and military 
facilities.

The Department of Defense (DOD) has conducted research on the 
biological effects of RF energy for a number of years. This research is now 
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conducted primarily at the U.S. Air Force Research Laboratory located at 
Brooks Air Force Base, Texas. The DOD Website for RF biological effects 
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information is listed with other sites in conjunction with a question on 
other sources of information, below.

26. Who funds and carries out research on the biological effects of 
RF energy?

Research into possible biological effects of RF energy is carried out in 
laboratories in the United States and around the world. In the U.S., most 
research has been funded by the Department of Defense, due to the 
extensive military use of RF equipment such as radar and high-powered 
radio transmitters. In addition, some federal agencies responsible for 
health and safety, such as the Environmental Protection Agency (EPA) 
and the U.S. Food and Drug Administration (FDA), have sponsored and 
conducted research in this area. At the present time, most of the non-
military research on biological effects of RF energy in the U.S. is being 
funded by industry organizations. More research is being carried out 
overseas, particularly in Europe.

In 1996, the World Health Organization (WHO) established the 
International EMF Project to review the scientific literature and work 
towards resolution of health concerns over the use of RF technology. 
WHO maintains a Website that provides extensive information on this 
project and about RF biological effects and research 
(www.who.ch/peh-emf).

FDA, EPA and other US government agencies responsible for public 
health and safety have worked together and in connection with WHO to 
monitor developments and identify research needs related to RF 
biological effects.
Section 4: Safety Guidelines and Warranty Information
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Hardware Specifications

1. The total capacity of memory for data storage and program execution is 32 MB.
2. Even though the display is produced with very high technologies, some pixels may

always appear blight and some pixels may always appear dark. This does not
designate malfunction.

3. When using 3.5 mm (1/8 inch) stereo headphones, use the supplied stereo mini plug
adapter.

Processor Intel® PXA255 Processor with Intel® 
XScale™ Technology, 400MHz

Memory RAM 32MB SDRAM*1

ROM 32MB Flash EEPROM

Antenna 1.9GHz (PCS), 1.5GHz (GPS)

Screen Display*2 3.5-inch semi-transparent color TFT LCD

Resolution 240 × 320 dots

Display 65,536 colors

Illumination Backlight method

Input Keyboard, Touch panel, Jog-wheel

Interface Audio Microphone, Speaker, Receiver, 
Headset jack (ø2.5 mm)*3

Notification LED × 3 (Charging, Reminder, Phone 
power), Vibrating device

Camera Rotary VGA camera

IrDA port IrDA Version 1.3 compatible (115 kbps)

SD card slot SD card*4/ MultiMediaCard*5 available

USB function 
port

USB Mini-B type

Cradle 
connector

AC adapter 
jack
Section 4: Safety Guidelines and Warranty Information
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4. SD card standard conformed. The SD card security function is not available. Such
data cannot be used that has been decoded using a device which supports the SD card
security function.

5. This device supports a Secure MultiMediaCard.



6. The operating time is provided just as a reference; and this time varies depending on
storage status and operating temperatures.

7. With the LCD backlight switched off. This time varies depending on radio wave
conditions and function settings.

8. When 30% continuous operation and 70% display are repeated in phone call waiting
status with the LCD backlight switched off.

9. When the device is left at an ambient temperature of 25ºC (77ºF) after switching the
device on has been disabled.

10. Confirm that the backup battery power warning has not been displayed on the Power

Power Main battery Detachable Lithium Ion battery
Voltage: 3.7 V DC, capacity: 1500 mAh
Operating 
time*6 (25ºC / 
77ºF)

Talk time: Approx. 2.5 
hours*7

Standby time: Approx. 7 
days*7

PDA operation time: Approx. 
12 hours*8

Charging time Approx. 3 hours
Data holding 
period

Approx. 5 days*9

Backup 
battery

Built-in battery (For backing up data when 
the main battery is replaced*10)

AC adapter*11 Input: 100-240 V AC, 50-60 Hz
Output: 5.0 V DC, 2.0 A

External 
dimensions

Main body 83 (W) × 146.5 (H) × 22.5 (D) mm*12

USB Cradle 88 (W) × 76 (H) × 90 (D) mm
Weight Main body 238 g

USB Cradle 235 g
Operating temperature 0ºC to 40ºC (32ºF to 104ºF) (for charging, 0ºC 

to 35ºC (32ºF to 95ºF))
Operating humidity 30% to 80% (There should be no 

condensation.)
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screen under Settings.
11. The supplied AC adapter cable is designed for 125 V AC. When the power source

supplies more than 125 V AC, use a different cable that is appropriate for the voltage. 
12. Projections excluded.
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Owner’s Record

The model number, regulatory number and serial number are located on 
a nameplate inside the battery compartment. Record the serial number 
in the space provided below. This will be helpful if you need to contact us 
about your phone in the future.

Model: SH-G1000

Serial No.:

User Guide Proprietary Notice

CDMA Technology is licensed by QUALCOMM Incorporated under one or 
more of the following patents:

4,901,307 5,056,109 5,101,501 5,109,390 5,228,054
5,267,261 5,267,262 5,337,338 5,414,796 5,416,797
5,490,165 5,504,773 5,506,865 5,511,073 5,535,239
5,544,196 5,568,483 5,600,754 5,657,420 5,659,569
5,710,784 5,778,338

T9 Text Input is licensed by Tegic Communications and is covered by U.S. 
Pat. 5,818,437, U.S. Pat. 5,953,541, U.S. Pat. 6,011,554 and other patents 
pending.
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Section 4B

Customer Limited Warranty

In This Section

� Customer Limited Warranty

his section contains the Customer Limited Warranty for your 
PCS Phone.

For information about the Terms and Conditions of your PCS Service, please 
see the Start Here guide included with your device. For the most recent 
version of the Terms and Conditions, please visit www.sprintpcs.com.

T
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Customer Limited Warranty

SPRINT SPECTRUM, L.P., (Sprint) offers you a limited warranty that the 
enclosed subscriber unit (Product), including accessories in the product 
package, will be free from defects in material or workmanship as follows:

SUBSCRIBER UNIT:

A. SPRINT ONE (1) YEAR LIMITED WARRANTY: For a period of one (1) 
year from the date of purchase, Sprint will, at its option, either pay the 
parts and labor charges to any authorized PCS Phone service facility to 
repair or replace a defective product (with new or rebuilt parts/
replacements). After this one (1) year period, you must pay all parts, 
shipping and labor charges.

B. REPAIRS: For a period equal to the remainder of the original limited 
warranty period on an original Product or for the 180 days after the date 
of repair/replacement, whichever is longer, Sprint will repair or replace 
(with new or rebuilt replacement) defective parts or Product used in the 
repair of replacement of the original Product under this Limited 
Warranty.

Proof of purchase in the from of a bill of sales or receipted invoice 
warranty repair document which is evidence that the Product is within 
the warranty period must be presented to obtain warranty service. This 
limited warranty is not transferable to any third party, including but not 
limited to any subsequent purchaser or owner of the Products.

Transfer or resale of a Product will automatically terminate warranty 
coverage with respect to the Products.

This limited warranty dose not cover and is void with respect to the 
following: (i) Products which have been improperly installed, repaired, 
maintained or modified (including the antenna); (ii) Products which 
have been subjected to misuse (including Products used in conjunction 
with hardware electrically or mechanically incompatible or used with 
accessories not supplied by Sprint), abuse accident, physical damage, 
abnormal operation, improper handling and storage, neglect, exposure 
Section 4: Safety Guidelines and Warranty Information
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to fire, water or excessive moisture or dampness or extreme changes in 
climate or temperature, (iii) Products operated outside published 
maximum ratings; (iv) cosmetic damage (including the LCD touch 



screen); (v) Products on which warranty stickers or Product serial 
numbers have been removed, altered, or rendered illegible; (vi) customer 
instruction; (vii) cost of installation, removal or reinstallation; (viii) 
signal reception problems (unless caused by defect in material and 
workmanship); (ix) damage the result of fire, flood, acts of God or other 
acts which are not the fault of Sprint and which the Product is not 
specified to tolerate, including damage caused by mishandling and 
blown fuses; (x) consumables (such as fuses); or (xi) any Products 
which have been opened, repaired, modified or altered by anyone other 
than Sprint or a Sprint authorized service center.

This warranty dose not cover customer education, instruction, 
installation, set up adjustments, or signal reception problems.

This warranty is valid only in the United States.

USE WITH ACCESSORIES NOT SUPPLIED BY SPRINT OR OTHERWISE 
NOT EXPRESSLY AUTHORIZED BY SPRINT MAY BE DANGEROUS.

SPRINT SPECIFICALLY DISCLAIMS LIABILITY, AND SHALL HAVE NO 
OBLIGATION TO PROVIDE TO BUYER ANY OTHER REMEDY, FOR ANY 
AND ALL DIRECT, INDIRECT, SPECIAL, GENERAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO LOSS 
OF PROFITS, LOST SALES, LOSS OF USE OF THE PRODUCT, OR 
ANTICIPATED PROFITS ARISING OUT OF USE OF OR INABILITY TO 
USE ANY PRODUCT (FOR EXAMPLE, WASTED AIRTIME CHARGES DUE 
TO THE MALFUNCTION OF A PRODUCT), DAMAGE DUE TO IMPROPER 
OPERATION OR MAINTENANCE, INSTALLATION, CONNECTION TO 
IMPROPER VOLTAGE SUPPLY. OR ATTEMPTED REPAIR OF THE 
PRODUCT BY ANYONE OTHER THAN A FACILITY AUTHORISED BY 
SPRINT. THIS WARRANTY DOSE NOT COVER PRODUCTS SOLD AS IS OR 
WITH ALL FAULTS, OR CONSUMABLES, (SUCH AS FUSES). THIS 
WARRANTY DOES NOT APPLY WHEN THE MALFUNCTION RESULTS 
FROM USE OF THE PRODUCT IN CONJUNCTION WITH ACCESSORIES, 
PRODUCTS OR ANCILLARY OR PERIPHERAL EQUIPMENT NOT 
SUPPLIED BY OR EXPRESSLY AUTHORIZED FOR USE BY SPRINT, AND 
WHERE IT IS DETERMINED BY SPRINT THAT THERE IS NO FAULT 
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WITH THE PRODUCT ITSELF.

REPAIR OR REPLACEMENT, AS PROVIDED UNDER THE WARRANTY, IS 
YOUR SOLE AND EXCLUSIVE REMEDY FOR BREACH OF THE LIMITED 
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WARRANTY. TO THE EXTENT PERMITTED BY APPLICABLE LAW, 
SPRINT MAKES NO OTHER WARRANTIES OF ANY KIND, EXPRESS OR 
IMPLIED, WITH RESPECT TO THE PRODUCTS FOR A PARTICULAR 
PURPOSE OR AGAINST INFRINGEMENT WITHIN THE TIME PERIOD 
SPECIFIED IN THE LIMITED WARRANTY OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE ON THIS PRODUCT IS 
LIMITED IN DURATION TO THE DURATION OF THIS WARRANTY.

Some States do not allow the exclusion or limitation of incidental or 
consequential damages, or allow limitations on how long an implied 
warranty last, so the above limitations or exclusions may not apply to 
you.

This limited warranty gives you specific legal rights, and you may have 
other rights which vary from the State to State.

For other Warranty Service Information, please call PCS CUSTOMER 
SOLUTIONS at 1-888-211-4727.
Section 4: Safety Guidelines and Warranty Information
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